# Contents

## I Overview of the SAS Forecast Server

Chapter 1. Overview of the SAS Forecast Server Administrator's Guide ............................................. 3
Chapter 2. The SAS Forecast Server Architecture and the SAS Intelligence Platform .................. 15

## II System Requirements for the SAS Forecast Server

Chapter 3. System Requirements for the SAS Forecast Server ....................................................... 23

## III Installation and Configuration of SAS Forecast Server

Chapter 4. Upgrading from SAS Forecast Server 2.1 to SAS Forecast Server 3.1 ....................... 35
Chapter 5. Installation and Configuration of the SAS Forecast Server ........................................ 49
Chapter 6. Post-Installation Tasks ................................................................................................. 61
Chapter 7. Verify the SAS Forecast Server Installation .............................................................. 75
Chapter 8. Start SAS Forecast Studio ........................................................................................... 81

## IV Administration and Troubleshooting

Chapter 9. Security Administration Tasks ..................................................................................... 89
Chapter 10. Report Administration Tasks ....................................................................................... 103
Chapter 11. Miscellaneous Administration Tasks ......................................................................... 131
Chapter 12. The SAS Forecast Server Administrative Macros ..................................................... 137
Chapter 13. Troubleshooting SAS Forecast Server ..................................................................... 191
Part I

Overview of the SAS Forecast Server
Chapter 1
Overview of the SAS Forecast Server
Administrator’s Guide

Contents

Why Is the SAS Forecast Server Important? ............................ 3
What Is the SAS Forecast Server? ........................................ 4
  Introduction to the SAS Forecast Server .......................... 4
  SAS High-Performance Forecasting Procedures Used by the SAS Forecast Server ............................................. 6
How Does the SAS Forecast Server Help You? ....................... 8
Accessibility and Compatibility Features .............................. 8
Using This Documentation ..................................................... 9
  Purpose ................................................................. 9
  Intended Audience .................................................... 9
  Required Skill Sets .................................................. 9
  Organization .......................................................... 10
Where to Go for More Information ...................................... 11
  Most Current Documentation ...................................... 11
  SAS Notes ............................................................ 11
  SAS Technical Support Services .................................. 11
  Online Help .......................................................... 11
  Other Related SAS Publications .................................. 12
Related SAS Software ......................................................... 12
  For More Features and Functionality .............................. 12
  SAS High-Performance Forecasting ............................... 13
  SAS/ETS ............................................................. 13
  SAS Enterprise Data Integration Server ......................... 13
  Base SAS ........................................................... 13
  SAS/GRAPH ......................................................... 13

Why Is the SAS Forecast Server Important?

Businesses must understand the markets that they serve. To understand their markets, businesses must be able to analyze, model, and forecast the demand for their products and services. These
products and services can be driven by many sales drivers, which might include input time series and calendar events. Business leaders must be able to interpret the results of these analyses and make decisions based on these results.

When the various products and services, categories, and geographies are considered, the number of time series, sales drivers, models, forecasts, and decisions can be tremendous. It is not uncommon that millions of time series must be modeled and forecast, and millions of decisions must be made based on these models and forecasts. Given the scale of the problem, customizing a time series model for each time series might not be feasible. An automated system that selects appropriate models and chooses influential sales drivers is required. The automated system must manage the time series data, time series models, calendar events, and results of the forecasting process in a scalable way. The results of the automated system must allow for “what-if” analysis, stochastic optimization, and goal-seeking support for making decisions.

Often businesses want to generate a large number of forecasts based on time-stamped data stored in their transactional or time series databases. Transactional databases contain data from sources such as Web sites, point-of-sale (POS) systems, call centers, and inventory systems. A skilled analyst can forecast a single time series from such data by applying good judgment based on his or her knowledge and experience, by using various time series analysis techniques, and by utilizing good software based on proven statistical theory. Generating frequent forecasts or large numbers of forecasts, however, requires some degree of automation. Common forecasting problems that businesses face include the following:

- No skilled analyst is available.
- Many forecasts must be generated.
- Frequent forecast updates are required.
- Time-stamped data must be converted to time series data.
- Several sales drivers might, or might not, influence the time series.
- Several calendar events might, or might not, influence the time series.
- The forecasting model is not known for each time series.

---

What Is the SAS Forecast Server?

---

Introduction to the SAS Forecast Server

The SAS Forecast Server is a client-server application that provides market-driven planning through accurate, dynamic demand forecasting and decision making. SAS Forecast Studio is the client component that provides a graphical interface to the high-performance forecasting procedures developed for the SAS High-Performance Forecasting software. This software provides a large-scale,
automatic, dynamic forecasting system for time-stamped data. For more information about these procedures and about the models underlying these procedures, see the \textit{SAS High-Performance Forecasting User's Guide}.

By using the SAS Forecast Server, you can:

- generate models automatically to fit your time-stamped data
- create your own forecasting models
- view and create additional models to determine the model that best fits your data
- perform hierarchical forecasting and reconciliation
- analyze and diagnose your time series data
- override forecasts
- include and manage calendar events
- export projects as SAS code for processing in a batch environment

Given a time-stamped data set, the software provides the following automatic forecasting process:

1. accumulates the time-stamped data to form a fixed-interval time series
2. diagnoses the time series using time series analysis techniques
3. creates a list of candidate model specifications based on the diagnostics
4. fits each candidate model specification to the time series
5. generates forecasts for each candidate fitted model
6. selects the most appropriate model specification based on either in-sample or holdout-sample evaluation using a model selection criterion
7. refits the selected model specification to the entire range of the time series
8. creates a forecast score from the selected fitted model
9. generates forecasts from the forecast score
10. evaluates the forecast using in-sample analysis, and/or provides for out-of-sample analysis of forecast performance
The SAS Forecast Server uses the following SAS High-Performance Forecasting procedures that form the basis for the automatic forecasting capabilities:

HPFARIMASPEC

The HPFARIMASPEC procedure is used to create an Autoregressive Integrated Moving Average (ARIMA) model specification file. The output of the procedure is an XML file that stores the intended ARIMA model specification. This XML specification file can be used to populate the model repository used by the HPFENGINE procedure. Likewise, you can also use the XML files generated by the other model specification procedures in this section to populate the model repository used by PROC HPFENGINE.

HPFDIAGNOSE

The HPFDIAGNOSE procedure is an automatic modeling procedure to find the best model among ARIMA Models, Exponential Smoothing Models, and Unobserved Component Models.

The HPFDIAGNOSE procedure has the following functionality:

- intermittency test
- functional transformation test
- simple differencing and seasonal differencing test
- tentative simple Autoregressive Moving Average (ARMA) order identification
- tentative seasonal ARMA order identification
- outlier detection
- significance test of events
- transfer functions identification
- intermittent demand model
- exponential smoothing model
- unobserved component model

HPFENGINE

The HPFENGINE procedure provides large-scale automatic forecasting of transactional or time series data. The HPFENGINE procedure extends the foundation built by PROC HPF, enabling the user to determine the list of models over which automatic selection is performed.

The use of many forecast model families is supported when HPFENGINE is used in conjunction with new experimental procedures that generate generic model specifications. Among these models are

- ARIMA
- Unobserved Component Models (UCM)
- Exponential Smoothing Models (ESM)
- Intermittent Demand Models (IDM)
- External Models (EXM)

Furthermore, users may completely customize the operation by defining their own code to generate forecasts.

For models with inputs, the STOCHASTIC statement is especially helpful for automatically forecasting those inputs that have no future values.

Also supported is the generation of a portable forecast score. The output of the SCORE statement is a file or catalog entry that you can use to efficiently generate forecasts outside of the HPFENGINE procedure when used with the HPFSCSUB function.

The new HPFDIAGNOSE procedure produces output that is compatible with HPFENGINE. As a result, you can entirely automate the task of candidate model specification.

HPFESMSPEC

The HPFESMSPEC procedure is used to create an Exponential Smoothing Model (ESM) specification file. The output of the procedure is an XML file that stores the intended ESM model specification.

HPFEVENTS

The HPFEVENTS procedure provides a way to create and manage events associated with time series. The procedure can create events, read events from an events data set, write events to an events data set, and create dummies based on those events, if date information is provided.

A SAS event is used to model any incident that disrupts the normal flow of the process that generated the time series. Examples of commonly used events include natural disasters, retail promotions, strikes, advertising campaigns, policy changes, and data recording errors.

An event has a reference name, a date or dates associated with the event, and a set of qualifiers. The event exists separately from any time series; however, the event may be applied to one or more time series. When the event is applied to a time series, a dummy variable is generated that you can use to analyze the impact of the event on the time series.

HPFEXMSPEC

The HPFEXMSPEC procedure is used to create an External Model (EXM) specification file. The output of the procedure is an XML file that stores the intended EXM model specification.

HPFIDMSPEC

The HPFIDMSPEC procedure is used to create an Intermittent Demand Model (IDM) specification file. The output of the procedure is an XML file that stores the intended IDM model specification.

HPFRECONCILE

The HPFRECONCILE procedure reconciles forecasts of time series data at two different levels of aggregation. The procedure enables the user to specify the direction and the method of reconciliation, equality constraints and bounds on the reconciled values at each point in time.
**Chapter 1: Overview of the SAS Forecast Server Administrator’s Guide**

The HPFSELECT procedure is used to create model selections lists. A model selection list contains references to candidate model specifications stored in the model repository. The output of the procedure is an XML file that stores the intended model selection list.

The HPFUCMSPEC procedure is used to create an Unobserved Component Model (UCM) specification file. The output of the procedure is an XML file that stores the intended UCM model specification.

---

**How Does the SAS Forecast Server Help You?**

The SAS Forecast Server provides a tool for a wide variety of applications in business, government, and academia. Major uses of the SAS Forecast Server include the following:

- perform forecasting
- provide input to market response modeling applications
- provide input to time series data mining applications

The SAS Forecast Server provides automation and analytical sophistication to the forecasting process. By using the SAS Forecast Server, which employs SAS High-Performance Forecasting, you can generate millions of forecasts in the turnaround time that is necessary to run your business. You can also uncover previously undetected trends, and you can predict future seasonal fluctuations. These capabilities create ample opportunities for you to reduce costs and increase revenues. The solution enables you to do the following:

- produce trustworthy forecasts that reflect realities of your business
- focus your attention on the most critical forecasts by providing automatic, reliable forecasts on a large scale
- significantly reduce forecasting error
- improve inventory management
- improve forecasts for items that rarely sell

---

**Accessibility and Compatibility Features**

The SAS Forecast Server includes accessibility and compatibility features that improve the usability of the product for users with disabilities, with some exceptions. These features are related to
accessibility standards for electronic information technology that were adopted by the U.S. Gover-
ment under Section 508 of the U.S. Rehabilitation Act of 1973. For more information about the
accessibility of the SAS Forecast Server, see the online Help for SAS Forecast Studio or the SAS
Forecast Studio User’s Guide.

If you have questions or concerns about the accessibility of SAS products, send e-mail to accessibility@sas.com.

Using This Documentation

Purpose

This administrator’s guide describes the processes for installation, configuration, and system ad-
ministration for the SAS Forecast Server solution as follows:

- understanding system architecture and requirements
- performing installation and post-installation tasks
- performing system administration
- running SAS administrative macros
- troubleshooting

Intended Audience

The SAS Forecast Server Administrator’s Guide is for administrators who need to install, configure,
and optimize a SAS solution. SAS and other programming expertise is not required.

Required Skill Sets

To install, configure, administer, and use the SAS Intelligence Platform and solutions, the following
individuals with the necessary skill sets are required for each administrative activity and use.

- System Administrator
  The SAS Forecast Server uses the SAS Intelligence Platform. The system administra-
tor should be familiar with the SAS Intelligence Platform. For more information, see http://support.sas.com/documentation/onlinedoc.
The system administrator should have the skills to perform the following types of installation, configuration, and administration tasks:

- installation and configuration of the SAS Intelligence Platform and solution
  The system administrator should install and configure the required SAS Intelligence Platform software on the required operating system. To install the SAS Intelligence Platform on the Microsoft Windows operating system, the administrator should meet the following prerequisites:
  * be an administrator of the machine
  * be familiar with Windows concepts
  * know how to create folders
  * know how to run DOS BAT files
  * be familiar with Windows domain concepts in order to create user accounts and groups

- administration of the solution metadata
  The system administrator must use SAS Management Console to maintain the metadata for servers, users, and other global resources that are required by the solution.

- administration of the SAS Data Integration Studio metadata
  The system administrator must use SAS Management Console to maintain the metadata for servers, users, and other global resources that are required by SAS Data Integration Studio if your solution uses ETL processes.

- Solution Administrator
  The solution administrator should have the skills to perform the following types of administration:

  - administration of the solution metadata (optional)
    The solution administrator, or the system administrator, must maintain the metadata for servers, users, and other global resources that are required by the solution.

  - administration of the solution
    The solution administrator must maintain the solution’s data, and perform other solution administration to enable users to analyze data.

- Solution User
  The solution user should understand the data to be analyzed, the requirements for analysis, and the results of the data analyses.

---

**Organization**

This Administrator’s Guide is organized as follows:

**Overview**

introduces you to your SAS solution, explains how the guide is organized and presented, and provides additional resources for you to explore if you need more information about your SAS solution software. It also provides a quick overview of the SAS Intelligence Platform and how your SAS solution integrates into the SAS Intelligence Platform.
**System Requirements**

describes the environment, hardware, software, data, and network requirements for implementing your SAS solution.

**Installation and Configuration**

provides an overview of the planned and software index installations. It also provides post-installation tasks and a process for verifying a successful installation and configuration of your SAS solution.

**Administration**

discusses the necessary system administration tasks, such as administration security that your SAS solution requires.

**Glossary**

contains terminology related to the SAS Forecast Server.

---

**Where to Go for More Information**

**Most Current Documentation**

For the most current installation and configuration information for the SAS Forecast Server, see [http://support.sas.com/documentation/onlinedoc](http://support.sas.com/documentation/onlinedoc).

**SAS Notes**

For additional information and support fixes, it is recommended that you check the SAS Notes that are available on the SAS Technical Support Web site. You can search for available SAS Notes for the SAS Forecast Server or SAS Forecast Studio at [http://support.sas.com/kb](http://support.sas.com/kb).

**SAS Technical Support Services**

The SAS Technical Support staff is available to respond to problems and answer technical questions.

**Online Help**

For information about how to operate your software, select Help→ Topics from within SAS Forecast Studio.
For information about the version of the software that you are running, select Help→About from within SAS Forecast Studio.

**Other Related SAS Publications**

- The *SAS High-Performance Forecasting User’s Guide* provides reference information for a large-scale automatic forecasting system. The software provides for the automatic selection of time series models that are used in forecasting time-stamped data. To access the *SAS High-Performance Forecasting User’s Guide*, see [http://support.sas.com/documentation/onlinedoc](http://support.sas.com/documentation/onlinedoc).

- **SAS System for Forecasting Time Series** provides information about how you can use SAS to forecast time series.


SAS also publishes the following books, which are companions to the *SAS/ETS User’s Guide*:


**Related SAS Software**

**For More Features and Functionality**

Many features not found in this solution software are available in other SAS solutions or in SAS products that are used with this SAS solution. If you do not find a feature that you need in this software, you might find it in one of the following SAS solutions or products.
SAS High-Performance Forecasting

SAS High-Performance Forecasting software provides a large-scale automatic forecasting system. The software provides for the automatic selection of time series models for use in forecasting time-stamped data. For more information about SAS High-Performance Forecasting, see the SAS High-Performance Forecasting User’s Guide.

SAS/ETS

SAS/ETS software provides SAS procedures that perform econometric and time series analysis and forecasting, as well as financial analysis and reporting. The software also provides an interactive environment for time series forecast and investment analysis. For more information about SAS/ETS software, refer to the SAS/ETS User’s Guide.

SAS Enterprise Data Integration Server

SAS Enterprise Data Integration Server is an application that enables you to manage extract, transform, and load (ETL) process flows, which are sequences of steps for the extraction, transformation, and loading of data. SAS Enterprise Data Integration Server enables you to do the following:

- specify metadata for sources, such as tables in an operational system
- specify metadata for targets, such as tables and other data stores in a data warehouse
- create jobs that specify how data is extracted, transformed, and loaded from a source to a target

Base SAS

Base SAS delivers a highly flexible and extensible fourth-generation programming language that is specially designed for data access, transformation, and reporting. It includes a rich library of encapsulated programming procedures for data manipulation, information storage and retrieval, descriptive statistics, and report writing.

SAS/GRAPH

SAS/GRAPH software provides high-impact visuals for all levels of your organization, enabling customers to readily understand complex information and empowering them to make informed,
timely decisions. SAS/GRAPH software extends the power of SAS data management, business intelligence and analytic tools, enabling customers to turn data into full-color graphs and charts.
Chapter 2

The SAS Forecast Server Architecture and the SAS Intelligence Platform

Table of Contents

<table>
<thead>
<tr>
<th>Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of the SAS Forecast Server Architecture</td>
<td>15</td>
</tr>
<tr>
<td>Architecture Diagram</td>
<td>15</td>
</tr>
<tr>
<td>The SAS Intelligence Platform Components</td>
<td>16</td>
</tr>
<tr>
<td>The SAS Forecast Server Components</td>
<td>17</td>
</tr>
<tr>
<td>The SAS Forecast Server Integration</td>
<td>18</td>
</tr>
</tbody>
</table>

Overview of the SAS Forecast Server Architecture

Architecture Diagram

Figure 2.1 shows how SAS Forecast Studio and the SAS Forecast Server middle tier pieces fit with the SAS Analytics Platform server and the SAS Intelligence Platform.
The SAS Forecast Server uses the following components of the SAS Intelligence Platform:

**SAS Metadata Server**

The SAS Metadata Server provides an enterprise-level repository for SAS server configurations and application management metadata. Products such as the SAS Forecast Server store metadata concerning users and other resources. Administrators use SAS Management Console to administer the SAS Metadata Server, including SAS server configurations. The SAS Forecast Server uses the SAS Metadata Server to obtain metadata about SAS libraries and the SAS Workspace Server and SAS Object Spawner, and to authenticate users. The SAS Forecast Server accesses the SAS Metadata Server through the SAS Analytics Platform server. A SAS System installation is required.
The SAS Forecast Server Components

The SAS Workspace Server and SAS Object Spawner
The SAS Workspace Server provides all computation and intermediate data storage services. A SAS System installation is required.

The SAS Forecast Server uses the SAS Workspace Server to execute SAS High-Performance Forecasting procedures and to save data to SAS data sets. The SAS Forecast Server accesses the SAS Workspace Server and the SAS Object Spawner through the SAS Analytics Platform server.

The SAS Analytics Platform server
The SAS Analytics Platform server is a middle tier application that enables clients to share access to the server tier of the SAS Intelligence Platform. While the SAS Analytics Platform server is considered a middle tier application, it does not need to be installed on the Web tier machine. Furthermore, the SAS Analytics Platform server does not require a local SAS System installation.

SAS Forecast Studio calls the SAS Forecast Server middle tier, which uses the SAS Analytics Platform server to access the SAS Metadata Server and the SAS Workspace Server. Shared access enables you to do the following:

- share the same SAS Forecast Server projects
- run long processes in a server application instead of the client application which enables you to terminate client sessions while the server process runs.

The SAS Forecast Server uses the SAS Analytics Platform server to access servers to obtain metadata (SAS Metadata Server), execute SAS High-Performance Forecasting procedures, and save data to SAS data sets (SAS Workspace Server.)

The SAS Forecast Server middle tier is configured with the SAS Analytics Platform server. Therefore, the SAS Forecast Server middle tier does not run unless the SAS Analytics Platform server is started first. For information about configuring the SAS Analytics Platform server as a Windows service, see the Administrator's Guide for the SAS Analytics Platform server at http://support.sas.com/documentation.

SAS Data Integration Studio (optional)
Administrators can use SAS Data Integration Studio to create an input data set and library for the solution. For more information, see the SAS Data Integration Studio User's Guide at http://support.sas.com/documentation/onlinedoc.

The SAS Forecast Server Components

The SAS Forecast Server consists of the following components:

The SAS Forecast Server middle tier
The SAS Forecast Server middle tier is installed as an application within the SAS Analytics Platform server. If you have SAS applications that use the SAS Analytics Platform server and its Web server, then you must install the SAS Analytics Platform server on the middle tier. You must install the SAS Forecast Server middle tier on the same machine as the SAS Analytics Platform server.
SAS Forecast Studio

The SAS Forecast Server has a thin client component (SAS Forecast Studio) that is the graphical user interface for the user. A SAS System installation is not required for a client configuration. The SAS Forecast Studio installation includes only the Java files needed for display. All other files are installed on the middle tier server with the SAS Forecast Server middle tier and the SAS Analytics Platform server.

SAS Forecast Studio calls the SAS Forecast Server middle tier, which uses the SAS Analytics Platform server to access the SAS Metadata Server and the SAS Workspace Server.

SAS Forecast Server Plug-in for SAS Management Console

The SAS Forecast Server Plug-in for SAS Management Console is a Java application that provides a single point of control for managing resources that are used in SAS Forecast Studio. You can use the SAS Forecast Server Plug-in for SAS Management Console to perform the administrative tasks required to create and maintain an integrated environment.

The SAS Forecast Server Batch Interface

The SAS Foundation component that contains SAS macros, templates, and stored processes that are used in the SAS Forecast Server for both batch and interactive use.

The SAS Forecast Server Integration

Figure 2.2 shows the access points for SAS Forecast Studio and the SAS Analytics Platform server, which includes the SAS Forecast Server middle tier, and SAS High-Performance Forecasting components.
The SAS Forecast Server application uses the following libraries and data sets:

- A SAS library, which is provided by SAS and contains sample SAS data sets, stores information and data about input SAS data sets that you can use for the SAS Forecast Server application.

- A user-defined library, which you create at your site, stores information and data about input SAS data sets for the SAS Forecast Server.

The following conditions must be true for the SAS Forecast Server to run:

- The SAS Metadata Server is running. You use SAS Management Console to administer metadata on the SAS Metadata Server.

- The SAS Object Spawner is running.
- The SAS Analytics Platform server is running.

- A SAS input data set is defined in a SAS library or a user-defined SAS library by using SAS Management Console. The input data set contains the appropriate SAS Forecast Server data, and is used within the SAS Forecast Server to generate forecasts.

SAS Forecast Studio accesses the SAS Forecast Server middle tier when it needs to access the SAS Metadata Server or the SAS Workspace Server. The SAS Forecast Server middle tier then accesses the SAS Analytics Platform server which uses the SAS Intelligence Platform (SAS Metadata Server and SAS Workspace Server) for the following purposes:

- access and return SAS library metadata from the SAS Metadata Server
- execute SAS High-Performance Forecasting procedures and return results
- authenticate users on the SAS Metadata Server

For more information about the SAS Intelligence Platform, see the SAS Intelligence Platform documentation set at [http://support.sas.com/documentation/onlinedoc](http://support.sas.com/documentation/onlinedoc).
Part II

System Requirements for the SAS Forecast Server
Chapter 3

System Requirements for the SAS Forecast Server

Contents

<table>
<thead>
<tr>
<th>Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Requirements Overview</td>
<td>23</td>
</tr>
<tr>
<td>Hardware Requirements</td>
<td>23</td>
</tr>
<tr>
<td>Hard Disk</td>
<td>23</td>
</tr>
<tr>
<td>RAM</td>
<td>24</td>
</tr>
<tr>
<td>Operating System Requirements</td>
<td>24</td>
</tr>
<tr>
<td>Software Requirements for the SAS Forecast Server</td>
<td>25</td>
</tr>
<tr>
<td>SAS Software Requirements</td>
<td>25</td>
</tr>
<tr>
<td>Third-Party Software Requirements</td>
<td>25</td>
</tr>
<tr>
<td>Data Requirements</td>
<td>26</td>
</tr>
<tr>
<td>Overview of the SAS Forecast Server Data Flow</td>
<td>26</td>
</tr>
<tr>
<td>Input Data Set Requirements</td>
<td>27</td>
</tr>
<tr>
<td>National Language Support</td>
<td>31</td>
</tr>
<tr>
<td>Best Practices for System Performance</td>
<td>31</td>
</tr>
</tbody>
</table>

System Requirements Overview

The following system requirements are specific to the SAS Forecast Server and SAS Forecast Studio. For a list of the SAS base system requirements, see http://support.sas.com/resources/sysreq.

Hardware Requirements

Hard Disk

- The SAS Forecast Studio installation requires 3 GB of hard disk space.
The SAS Forecast Server middle tier and the SAS Analytics Platform server, SAS servers (the SAS Metadata Server and the SAS Workspace Server), and the SAS Forecast Studio installation require 10 GB of hard disk space.

**RAM**

- The SAS Forecast Studio installation requires a minimum of 256 MB RAM.
- The SAS Forecast Server middle tier and the SAS Analytics Platform server require a minimum of 1 GB RAM.

**Note:** If your system performance is too slow, then you can increase the amount of RAM. It is suggested that you have more than 2 GB of RAM.

**Operating System Requirements**

The SAS Forecast Server middle tier is a Java-based, middle tier component that enables automatic forecasting of time series data. The SAS Forecast Server middle tier is installed as an application within the SAS Analytics Platform server. You can install it on the following operating systems:

- Windows XP (32-bit)
- Windows Server 2003 (Standard Edition)
- Windows Server 2003 (Enterprise Edition)
- Windows (64-bit) for IPF
- Windows for x64
- UNIX AIX (64-bit), Release 5.1 or later
- HP-UX (64-bit)
- HP-Itanium
- Linux (32-bit)
- Solaris (64-bit)
- Solaris for x64

SAS Forecast Studio is a Java-based, client tier application that is based on SAS High-Performance Forecasting procedures. You can install SAS Forecast Studio on Windows 32-bit workstations and Windows for x64 workstations.
Software Requirements for the SAS Forecast Server

SAS Software Requirements

Required SAS Software

Your software bundle includes the SAS Forecast Server bundle.

**Note:** You must have a licence for SAS/OR to access its full functionality. The SAS Forecast Server has internal access to limited SAS/OR functionality, but it does not offer a direct interface to SAS/OR.

**Caution:** You must use version 3.1 of both the SAS Forecast Server and SAS High-Performance Forecasting. 3.1 is the version available in your software bundle. If you use version 3.1 of the SAS Forecast Server with any earlier versions of SAS High-Performance Forecasting, then you might get unexpected results.

Optional SAS Software

The following SAS products and components are often used with the SAS Forecast Server, but are not required:

- SAS Data Integration Studio
- The SAS BI Server
- SAS Enterprise Miner

Third-Party Software Requirements

In addition to the licensed SAS products required to support the SAS Forecast Server, some third-party software is required. For information about third-party software and to access downloads of the software, see: [http://supportexp.unx.sas.com/resources/thirdpartysupport/v92](http://supportexp.unx.sas.com/resources/thirdpartysupport/v92).
Data Requirements

Overview of the SAS Forecast Server Data Flow

Figure 3.1 shows the general flow of data in the SAS Forecast Server.

Figure 3.1  Data Flow in the SAS Forecast Server

When using the SAS Forecast Server, you create or update forecasts by using the following general data flow:

1. Create or generate an input SAS data set, which you store in a preassigned SAS library. For information about preassigning a SAS library, see “Preassign Libraries in SAS Management Console” on page 69.

2. Open SAS Forecast Studio.

   a) Create a project.
   b) Select your input library and SAS data set.
   c) Assign variables to roles.
   d) (Optional) configure the hierarchy.
   e) Set forecasting options.
Input Data Set Requirements

Overview

For the SAS Forecast Server to generate a forecast, the input SAS data set must contain one variable for each time series. The SAS Forecast Server requires a date or datetime variable in the data set to generate forecasts. The SAS Forecast Server generates forecasts from timestamped data that consists of unique and equally spaced data over time. If the data are not equally spaced with regard to time, then the SAS Forecast Server uses the date or datetime variable to accumulate the data into a time series before forecasting. The input data set must be a single SAS data set that you define in a SAS library. For information about preassigning libraries, see “Preassign Libraries in SAS Management Console” on page 69.

You can use transactional data to generate a forecast. You can use the accumulation options in SAS Forecast Studio to prepare the time series data.

Data Set Variables

You can have the following variables in the input data set:

- The time ID variable must contain the date or datetime value of each observation.
- BY variables enable you to group observations into a hierarchy.
- Dependent variables are the variables used to model and forecast.
- Independent variables are the explanatory or input variables that are used to model and forecast the dependent variable.
- Adjustment variables are used to adjust for deterministics and systematic variation.
Chapter 3: System Requirements for the SAS Forecast Server

- Reporting variables are not used for analysis but for reports only.
- Indicator variables are used to signify any unusual event in the model, such as holidays and promotions.

The names of the variables cannot match any of the reserved variable names that are used in the output data set. The variable names in your input data set cannot start with an underscore and cannot match any of the variable names in the output data sets that the SAS Forecast Server creates. The following table lists the variables that are created by the output data sets. For more information about the output data sets that are created, see the SAS High-Performance Forecasting User's Guide.

If your input data set contains one of the variables listed in Table 3.1 and you try to assign this variable to a role in SAS Forecast Studio, then an error message appears.

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>_VariableName</td>
<td>Any variable name that begins with an underscore</td>
</tr>
<tr>
<td>AADJRSQ</td>
<td>Amemiya’s adjusted R-square</td>
</tr>
<tr>
<td>ACTUAL</td>
<td>Dependent series value</td>
</tr>
<tr>
<td>ADJRSQ</td>
<td>Adjusted R-square</td>
</tr>
<tr>
<td>AGGCHILDPREDICT</td>
<td>Aggregated prediction of the children nodes</td>
</tr>
<tr>
<td>AIC</td>
<td>Akaike information criterion</td>
</tr>
<tr>
<td>AICC</td>
<td>Finite sample-corrected Akaike information criterion</td>
</tr>
<tr>
<td>APC</td>
<td>Amemiya’s prediction criterion</td>
</tr>
<tr>
<td>DFE</td>
<td>Degrees of freedom error</td>
</tr>
<tr>
<td>END</td>
<td>Ending time ID value</td>
</tr>
<tr>
<td>ENDOBS</td>
<td>Ending observation number</td>
</tr>
<tr>
<td>EQUALITY</td>
<td>Equality constraint on the forecast</td>
</tr>
<tr>
<td>ERROR</td>
<td>Prediction errors</td>
</tr>
<tr>
<td>FINALPREDICT</td>
<td>Predicted value for the parent node</td>
</tr>
<tr>
<td>GMAPE</td>
<td>Geometric mean of the absolute percent error</td>
</tr>
<tr>
<td>GMAPES</td>
<td>Geometric mean of the absolute percent error as a percentage of the standard deviation</td>
</tr>
<tr>
<td>GMAPPE</td>
<td>Geometric mean of the absolute predicted percent error</td>
</tr>
<tr>
<td>GMASPE</td>
<td>Geometric mean of the absolute symmetric percent error</td>
</tr>
<tr>
<td>GMRAE</td>
<td>Geometric mean of the relative absolute error</td>
</tr>
<tr>
<td>ISRECONCILED</td>
<td>Takes a value of 1 when the node is reconciled and a value of 0 when it is not</td>
</tr>
<tr>
<td>LEAF</td>
<td>Name of a hierarchy level created for the project</td>
</tr>
<tr>
<td>LLOCK</td>
<td>Lock level for lower bound on the forecast</td>
</tr>
<tr>
<td>LOWBFBOVR</td>
<td>Lower confidence limits before override reconciliation</td>
</tr>
<tr>
<td>LOWER</td>
<td>Lower confidence limits</td>
</tr>
<tr>
<td>LOWERBD</td>
<td>Lower bound on the forecast</td>
</tr>
<tr>
<td>MAE</td>
<td>Mean absolute error</td>
</tr>
<tr>
<td>MAPE</td>
<td>Mean absolute percent error</td>
</tr>
<tr>
<td>MAPES</td>
<td>Mean of the absolute percent error as a percentage of the standard deviation</td>
</tr>
<tr>
<td>MAPPE</td>
<td>Mean of the absolute predicted percent error</td>
</tr>
<tr>
<td>Variable Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>MASE</td>
<td>Mean of the absolute scaled errors</td>
</tr>
<tr>
<td>MAX</td>
<td>Maximum value</td>
</tr>
<tr>
<td>MAXAPES</td>
<td>Maximum of the absolute error as a percentage of the standard deviation</td>
</tr>
<tr>
<td>MAXERR</td>
<td>Maximum error</td>
</tr>
<tr>
<td>MAXPE</td>
<td>Maximum percent error</td>
</tr>
<tr>
<td>MAXPPE</td>
<td>Maximum predictive percent error</td>
</tr>
<tr>
<td>MAXRE</td>
<td>Maximum relative error</td>
</tr>
<tr>
<td>MAXSPE</td>
<td>Maximum symmetric percent error</td>
</tr>
<tr>
<td>MDAPE</td>
<td>Median of the absolute percent error</td>
</tr>
<tr>
<td>MDAPES</td>
<td>Median of the absolute percent error as a percentage of the standard deviation</td>
</tr>
<tr>
<td>ME</td>
<td>Mean error</td>
</tr>
<tr>
<td>MEAN</td>
<td>Mean value</td>
</tr>
<tr>
<td>MIN</td>
<td>Minimum value</td>
</tr>
<tr>
<td>MINAPES</td>
<td>Minimum of the absolute percent error as a percentage of the standard deviation</td>
</tr>
<tr>
<td>MINERR</td>
<td>Minimum error</td>
</tr>
<tr>
<td>MINPE</td>
<td>Minimum percent error</td>
</tr>
<tr>
<td>MINPPE</td>
<td>Minimum predictive percent error</td>
</tr>
<tr>
<td>MINRE</td>
<td>Minimum relative error</td>
</tr>
<tr>
<td>MINSPE</td>
<td>Minimum symmetric percent error</td>
</tr>
<tr>
<td>MPE</td>
<td>Mean percent error</td>
</tr>
<tr>
<td>MPPE</td>
<td>Mean predictive percent error</td>
</tr>
<tr>
<td>MRAE</td>
<td>Mean of the relative absolute error</td>
</tr>
<tr>
<td>MRE</td>
<td>Mean relative error</td>
</tr>
<tr>
<td>MSE</td>
<td>Mean square error</td>
</tr>
<tr>
<td>MSPE</td>
<td>Mean symmetric percent error</td>
</tr>
<tr>
<td>N</td>
<td>Number of nonmissing observations or number of variance products</td>
</tr>
<tr>
<td>NAME</td>
<td>Variable name</td>
</tr>
<tr>
<td>NMISS</td>
<td>Number of missing observations</td>
</tr>
<tr>
<td>NMISSA</td>
<td>Number of missing actual values</td>
</tr>
<tr>
<td>NMISSP</td>
<td>Number of missing predicted values</td>
</tr>
<tr>
<td>NOBS</td>
<td>Number of observations</td>
</tr>
<tr>
<td>NONMISSCHLD</td>
<td>Number of nonmissing children of the current AGGBY group</td>
</tr>
<tr>
<td>NOTE</td>
<td>User note for a series</td>
</tr>
<tr>
<td>NPARMS</td>
<td>Number of model parameters</td>
</tr>
<tr>
<td>OLOCK</td>
<td>Lock level for equality constraint</td>
</tr>
<tr>
<td>OVERRIDE</td>
<td>Equality constraint on the forecast</td>
</tr>
<tr>
<td>PREBFOVR</td>
<td>Predicted values before override reconciliation</td>
</tr>
<tr>
<td>PREDICT</td>
<td>Predicted values</td>
</tr>
<tr>
<td>RECDIFF</td>
<td>Reconciliation difference</td>
</tr>
<tr>
<td>RMSE</td>
<td>Root mean square error</td>
</tr>
</tbody>
</table>
Table 3.1 (continued)

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RSQUARE</td>
<td>R-square</td>
</tr>
<tr>
<td>RWRSQ</td>
<td>Random walk R-square</td>
</tr>
<tr>
<td>SBC</td>
<td>Schwarz’s Bayesian information criterion</td>
</tr>
<tr>
<td>SMAPE</td>
<td>Mean absolute symmetric percent error</td>
</tr>
<tr>
<td>SSE</td>
<td>Sum of squares error</td>
</tr>
<tr>
<td>SST</td>
<td>Corrected total sum of squares</td>
</tr>
<tr>
<td>START</td>
<td>Starting time ID value</td>
</tr>
<tr>
<td>STARTOBS</td>
<td>Starting observation number</td>
</tr>
<tr>
<td>STD</td>
<td>Prediction standard errors</td>
</tr>
<tr>
<td>STDBFOVR</td>
<td>Standard deviation before override reconciliation</td>
</tr>
<tr>
<td>STDDEV</td>
<td>Standard deviation</td>
</tr>
<tr>
<td>SUM</td>
<td>Summation value</td>
</tr>
<tr>
<td>TOP</td>
<td>Name of a hierarchy level created for the project</td>
</tr>
<tr>
<td>TSS</td>
<td>Total sum of squares</td>
</tr>
<tr>
<td>ULOCK</td>
<td>Lock level for upper bound on the forecast</td>
</tr>
<tr>
<td>UMSE</td>
<td>Unbiased mean square error</td>
</tr>
<tr>
<td>UNLOCK</td>
<td>Takes a value of 0 when the equality constraint is locked and a value of 1 when it is not</td>
</tr>
<tr>
<td>UPPBFOVR</td>
<td>Upper confidence limits before override reconciliation</td>
</tr>
<tr>
<td>UPPER</td>
<td>Upper confidence limits</td>
</tr>
<tr>
<td>UPPERBD</td>
<td>Upper bound on the forecast</td>
</tr>
<tr>
<td>URMSE</td>
<td>Unbiased root mean square error</td>
</tr>
<tr>
<td>XML</td>
<td>User preferences for a series in XML format</td>
</tr>
</tbody>
</table>

Additional Information

Often your data are not in the appropriate format for the SAS Forecast Server. To avoid misleading or incorrect analyses from your time series data, you should preprocess your data.

- For general information about working with time series data, see the SAS/ETS User’s Guide.

- For more information about creating time series data from transactional data, see the "TIME-SERIES Procedure" and the "EXPAND Procedure" documentation in the SAS/ETS User’s Guide.

- For more information about creating SAS data sets from Excel files, see the “IMPORT Procedure” documentation in the Base SAS Procedures Guide.

- For more information about transposing data for statistical analysis, see the “TRANSPOSE Procedure” documentation in the Base SAS Procedures Guide.
National Language Support

SAS Forecast Server is available in the following languages:

- Chinese (Simplified)
- Chinese (Traditional)
- English
- French
- Italian
- Japanese
- Korean

Best Practices for System Performance

For information about changing your system settings to improve system performance, see the section about best practices for configuring the middle tier in the Web Application Administration Guide of the SAS Intelligence Platform documentation set at http://support.sas.com/documentation.
Part III

Installation and Configuration of SAS Forecast Server
Chapter 4
Upgrading from SAS Forecast Server 2.1 to SAS Forecast Server 3.1

Contents

Overview of the Upgrading Process ............................................. 35
When Should You Perform the Upgrading Process? ....................... 36
About Project Organization ...................................................... 36
Migration Considerations ....................................................... 37
What Happens During Migration? ............................................ 37
About Migrating Archives ....................................................... 38
Option 1: Migrating with the SAS Migration Utility ....................... 38
  About Migration Using the SAS Migration Utility ...................... 38
  About Project Description and Version Information ................... 39
  How to Migrate with the SAS Migration Utility ....................... 39
Option 2: Migrating Using Automatic Registration ......................... 40
  About Migration Using Automatic Registration ....................... 40
  How to Migrate Using Automatic Registration ....................... 40
Option 3: Migrating Using Archives .......................................... 41
  About Migration Using Archives .......................................... 41
  How to Migrate Using Archives .......................................... 42
Migrating Reports .............................................................. 42
  Overview of Report Migration ............................................ 42
  Directories Specified in the Source File Field ......................... 43
  Report Migration Considerations ........................................ 43
  Export Reports from SAS Forecast Server 2.1 ......................... 44
  Import Reports to SAS Forecast Server 3.1 ............................ 46
  Post-Migration Tasks for Reports ....................................... 46

Overview of the Upgrading Process

These upgrade instructions explain the options that you have to migrate your SAS Forecast Server 2.1 content when you upgrade to SAS Forecast Server 3.1.
NOTE: If you have projects created with SAS Forecast Server 1.4, you must upgrade them to version 2.1 before upgrading to SAS Forecast Server 3.1.

These instructions explain the correct order of all upgrade tasks and point you to instructions in additional documents as necessary. It is recommended that you read this complete chapter before you begin the upgrade process.

For best results, it is recommended that you do not install both SAS Forecast Server 2.1 and SAS Forecast Server 3.1 on the same server.

The physical server where you install SAS Forecast Server 3.1 is the server where you will run the migration jobs because the migration jobs (other than those of the SAS Migration Utility) require the macro catalog that is included in SAS Forecast Server 3.1.

**When Should You Perform the Upgrading Process?**

Evaluate the forecast plans and choose the time to migrate that best fits your business cycle.

**About Project Organization**

In previous releases, you did not have the ability to group projects together into workspaces. This release supports environments to address this issue. An environment is defined by the following basic attributes:

- logical name
- host workspace server
- content path on server

An environment defines each of the following:

- a container for projects
- a workspace for users
- a partition of a workspace server

In this release, environments replace workspace servers in the user interfaces of the product. However, the concept of environments also existed in the previous release in a more primitive form. In previous product releases, the product provided a single configurable “default location” value, which was effectively a globally shared “content path on server” value used for all workspace
servers. This sharing had the effect of constraining all new projects to be stored at the same location in a workspace server file system (that is, the location referenced by the current “default location” value). In this release, you can use environments to identify multiple project locations for each workspace server, allowing for significantly more flexibility and control for site administrators. Additionally, you can use metadata permissions to control access to each environment. Therefore, you can use environments to define private workspaces for groups of users, while still allowing sharing among group members.

**Migration Considerations**

You must consider the following issues during migration:

- In the previous release, the default location value was customizable. Since projects were not moved to the new location when the default location value was changed, this capability could result in a server having multiple areas for projects on the file system, even though new projects were only created in the current location. Review your existing projects carefully to determine the appropriate directories to migrate.

  **Note:** The SAS Migration Utility provides an analyze mode that you can use to automatically detect existing project locations. For more information, see “Option 1: Migrate with the SAS Migration Utility.”

- Because environments support restricted access through the use of metadata permissions, you must determine appropriate access settings for each existing location prior to migration. For more information about security, see “Security Administration Tasks.” Additionally, support for project sharing provides another way for changing the access settings of a project within its environment. For more information about sharing projects, see “Group Sharing Options for Projects.”

- The user_locations.properties file is deprecated in this release. The purpose of this file was to define a project area that was accessible to only a subset of the product users. This scenario is now supported by creating an environment definition and using the metadata permissions to make the environment accessible to only the specified subset of users.

**What Happens During Migration?**

Since the relative path to a project is consistent and known, the implied location of the environment in the file system can be derived from the full path to the project files. This path is recorded in the project metadata, allowing for automated migration. However, due to the potential size of the file system content, most migration strategies discussed here focus on moving only the metadata to the destination system. You must manually move the file system content to complete the migration when using these strategies.
When manual content movement is necessary, the files on the destination machine must have the same file paths as they had on the source machine to ensure project integrity. For example, you must place content located at C:\Forecasting at the same location on the destination system. Neither the drive letter nor the directory names can change. This is required because the file path is stored at several locations within the project content.

---

**About Migrating Archives**

As with all file content, you must manually migrate project archives. Since no search is performed for these files, no reminders or warnings will be generated for them during the migration process.

---

**Option 1: Migrating with the SAS Migration Utility**

**About Migration Using the SAS Migration Utility**

The standard migration mechanism for all SAS products is the SAS Migration Utility. This application generates a package of migrated content and settings that the SAS Deployment Wizard uses to configure the new system. This option focuses on migration of the entire system. As described in "Migration Considerations," the SAS Migration Utility does not package the file system content due to the expected size. Instead, you are required to manually move the content to the corresponding locations on the new system. However, the application does analyze and migrate the metadata for the content, and in its analysis report, it automatically identifies all of the file system content that you should move. The application also issues warnings to draw your attention to special concerns, such as finding an existing user_locations.properties file.

**NOTE:** Due to its ability to assess the state of your source system, it is recommended that you use the analyze mode provided by the SAS Migration Utility even if you do not intend to use this utility to migrate your data. The report that it generates identifies all projects and environments that you should migrate. Using this report reduces the chance of losing content during migration. For more information, see “Create a Migration Analysis Report” in the SAS Intelligence Platform: 9.1.3 to 9.2 Migration Guide, at [http://support.sas.com/92administration](http://support.sas.com/92administration).

For more information about preparing and planning for migration from SAS 9.1.3 to SAS 9.2, see [http://support.sas.com/migration/](http://support.sas.com/migration/).
About Project Description and Version Information

The SAS Migration Utility does not have access to the project description and version information. During migration, default values are provided in the metadata. The SAS Migration Utility assigns &lt;3.1 for the version information, and the project description is blank. However, after you use the migrated project, the description for it is automatically restored in the metadata.

Additionally, you can unregister an environment and reregister it in the SAS Forecast Server Plug-in for SAS Management Console to recreate the metadata. For more information about using these commands, see the Help for the SAS Forecast Server Plug-in available in SAS Management Console.

How to Migrate with the SAS Migration Utility

To perform a migration with the SAS Migration Utility:

1. If you are migrating from SAS 9.1.3, you must prepare your software for migration. Follow the instructions in the SAS Intelligence Platform: 9.1.3 to 9.2 Migration Guide, located at http://support.sas.com/92administration, to prepare your SAS 9.1.3 deployment for migration to SAS 9.2.

2. Follow the instructions in the SAS Intelligence Platform: 9.1.3 to 9.2 Migration Guide to run the SAS Migration Utility executable.

3. Review the analysis report generated by the SAS Migration Utility.

4. As instructed in the analysis report generated by the SAS Migration Utility, copy your content files from the source machines to the corresponding locations on the new destination machines.

   **NOTE:** You must create a directory structure on your new system that mirrors the directory structure of your original system. For example, if the content was located in the C:\Forecasting directory, then you must also create a C:\Forecasting directory on the destination machine to store those files in the new system.

5. Start the SAS Deployment Wizard executable from your SAS Software Depot.

6. When prompted, choose to Perform migration, and then click Browse to specify the SAS Migration Utility Package Directory.

7. Complete the remaining steps in the SAS Deployment Wizard. For more information, see “Installation and Configuration of the SAS Forecast Server.”

8. Assign appropriate user permissions to the environment directories on the new system. For more information, see “Environment Permissions.”
**NOTE:** You can use the update batch operation to update multiple projects to use the current version. In the SAS Forecast Server Plug-in for SAS Management Console, right-click on the environment node, and select **Batch Operations → Update**. You can also perform an update for single projects. For more information about the update operations, see the Help for the SAS Forecast Server Plug-in for SAS Management Console.

---

**Option 2: Migrating Using Automatic Registration**

**About Migration Using Automatic Registration**

The SAS Forecast Server Plug-in for SAS Management Console includes several environment-level operations that you can use for migration. The automatic registration feature provided in the SAS Forecast Server Plug-in for SAS Management Console searches a newly registered environment for any unregistered projects and automatically registers them. Using this feature, you can manually create a new environment definition (using the **Register Environment** command) that points to a directory structure copied from an old installation of the SAS Forecast Server, and select the automatic registration option to re-create the metadata registrations for all content in the structure.

**NOTE:** Using this method, you must still copy the file system content to the same location in the new system to ensure project integrity.

**How to Migrate Using Automatic Registration**

To migrate using automatic registration:

1. As instructed in the analysis report generated by the SAS Migration Utility, copy your content files from the source machines to the corresponding locations on the new destination machines.

   **NOTE:** You must create a directory structure on your new system that mirrors the directory structure of your original system. For example, if the content was located in the **C:\Forecasting** directory, then you must also create a **C:\Forecasting** directory on the destination machine to store those files in the new system.

2. Assign appropriate user permissions to the environment directories on the new system. For more information, see “**Environment Permissions**.”

3. After you have installed and configured the product, open SAS Management Console, and log on as the SAS Administrator (for example, sasadm@saspw).

4. Select the **Forecast Server** node in the **Plug-ins** tab.
5. If you are not already logged on to the SAS Analytics Platform server, the Log On dialog box opens. Log on to the SAS Analytics Platform server using a product administrator account.

6. Right-click on the *Forecast Server* node, and select **Register Environment**. The Register Environment dialog box opens.

7. In the resulting dialog box, do the following:
   a) Type the name that you would like to assign to the environment.
   b) (Optional) Type a description for the environment.
   c) Select the **Host name** of the SAS Workspace Server. The first available workspace server is selected by default. You can select a different server using the drop-down list.
   d) Type the location or click **Browse** to specify the location of the file system content.
   e) Specify the metadata location of the **Reports folder**.
   f) (Optional) Select **Automatically register all projects within this environment** to execute project registration. By default, this value is not selected.
   g) Click **OK**.

**NOTE:** If you have an existing environment or if you opted to not automatically register all of the projects in the environment using the Register Environment dialog box, you can use the register batch operation to register multiple projects at any time. Right-click on the environment node, and select **Batch Operations → Register**. You can also use the update batch operation to update multiple projects to use the current version. In the SAS Forecast Server Plug-in for SAS Management Console, right-click on the environment node, and select **Batch Operations → Update**. You can also perform an update for single projects. For more information about the update or batch operations, see the Help for the SAS Forecast Server Plug-in for SAS Management Console.

---

**Option 3: Migrating Using Archives**

**About Migration Using Archives**

As in previous releases, you can archive individual projects into a portable format and then unarchive them to working projects in a separate installation. This capability is still supported through the macro interfaces, including the bulk archiving operations, and now also through the SAS Forecast Server Plug-in for SAS Management Console. While slower, the use of archives supports considerably more cases than the previous two options. For example, cross-architecture migration, cross-environment migration, selective migration, and so on. Unlike the previous options, this option also moves the file system content within the archive files.
How to Migrate Using Archives

To migrate using archives:

1. Export the project created with the previous version of the SAS Forecast Server. You can use the FSEXPORT macro to do this. For more information, see “FSEXPORT Macro: Archive a Single Project.”

2. After you have installed and configured the product, open SAS Management Console, and log on as the SAS Administrator (for example, sasadm@saspw).

3. Select the Forecast Server node in the Plug-ins tab.

4. If you are not already logged on to the SAS Analytics Platform server, the Log On dialog box opens. Log on to the SAS Analytics Platform server using a product administrator account.

5. Right-click on the environment node where you want to add the project, and then select Unarchive Project. The Unarchive dialog box opens.

6. Type the location for the archive file, or click Browse to specify the location of the archive file. Click OK.

**NOTE:** You can use the unarchive batch operation to import multiple projects when the archive files are all in the same directory. Right-click on the environment node, and select Batch Operations → Unarchive. You can also use the update batch operation to update multiple projects to use the current version. In the SAS Forecast Server Plug-in for SAS Management Console, right-click on the environment node, and select Batch Operations → Update. You can also perform an update for single projects. For more information about the update or batch operations, see the Help for the SAS Forecast Server Plug-in for SAS Management Console.

Migrating Reports

Overview of Report Migration

Reports from the 2.1 release are not automatically migrated. If you have custom reports, you can migrate them manually using a SAS package (.SPK) file to transfer the stored process objects to the new system.
Directories Specified in the Source File Field

An incompatibility was identified in the 2.1 release between the configuration of the sample report objects and the SPK files. Specifically, the **Source file** field for a stored process metadata object is intended to store only a simple file name (that is, it should not include a directory name). The sample reports available in this release correct this issue, but it might be present in any custom reports that you migrate from the 2.1 release. When importing an SPK file that contains stored process objects in this state, the attempt to write the source file to the file system will fail unless you manually create the directories included in the **Source file** field of the stored process metadata object beforehand.

To successfully migrate stored process metadata objects in this state, you should do one of the following:

- Correct the value of the **Source file** field in the old system before generating the SPK file.
- Manually create the directories in the target system before importing the contents of the SPK file. If you use this option, it is recommended that you also correct the field values in the target system to avoid future problems.

Report Migration Considerations

Before migrating your reports, you must consider how you would like to organize them in the new system. Under the 2.1 release, reports for all projects were stored together in a single global tree in metadata, which was shown without filtering in the SAS Forecast Studio Reports and Stored Processes dialog box. It was the user’s responsibility to ensure that the stored process was indeed a report and that it was configured to execute on the workspace server hosting the project files. In this release, you can have a separate reports area within metadata for each environment, and the location of this area is now configurable (using the SAS Forecast Server Plug-in for SAS Management Console). Also in this release, the reports that display in the Reports and Stored Processes dialog box are filtered to avoid showing any reports that are not appropriate for the current user and project.

To display in the SAS Forecast Studio Reports and Stored Processes dialog box, your report must meet the following conditions:

- The reports area for the project’s environment must be configured. For more information, see “Configure the Report Metadata Folder for the Environment.”
- The report object must be located in the configured reports area. For more information, see “Registering Custom Reports.”
- The user must have the ReadMetadata permission for the report object. For more information, see “Configure Additional User Permissions on the Report Metadata Folder.”
- The report metadata object must have the special keyword `FS_REPORT`, which identifies it as a SAS Forecast Server report. For more information, see “Keywords Used in Reports.”
The report metadata object must be configured to execute on the same server that hosts the project (that is, the host server of the project’s environment). For more information, see “Register the Report with SAS Management Console.”

**NOTE:** To simplify the task of migration, the SAS Forecast Server Plug-in for SAS Management Console provides a **Search** command. This command automatically adds the **FS_REPORT** keyword to any stored process found in the configured reports area. It is recommended that you use this command when importing a large collection of reports.

Due to the above considerations, your report migration might require that you package the set of reports in multiple SPK files so that you can import them into separate report areas. For more information about configuring reports, see “Report Administration Tasks.” For more information about the SAS Forecast Server Plug-in for SAS Management Console, see the Help in SAS Management Console.

---

**Export Reports from SAS Forecast Server 2.1**

To export reports from the SAS Forecast Server 2.1:

1. Open SAS Management Console, and log on as the SAS Administrator (for example, sasadm@saspw).
2. Expand the **Environment Manager > BI Manager** folder.
3. Expand the **Forecast Studio** node.
4. Right-click the **Stored Processes** node, and then select **Export**. The Export Wizard opens.
5. Select the location to create the file, and then click **Next**.
6. Select the reports that you would like to store in the SPK file. **Figure 4.1** shows an example. Click **Next**.
Figure 4.1 Export Wizard - Select the Reports to Export

7. Click Export.

NOTE: You do not need to migrate the sample reports from version 2.1 since updated versions are provided in this release. You can deploy sample reports using the SAS Forecast Server Plug-in for SAS Management Console. However, if you have modified any of the sample reports from version 2.1, you should treat those as custom reports.
Import Reports to SAS Forecast Server 3.1

To import reports to SAS Forecast Server 3.1:

1. Open SAS Management Console, and log on as the SAS Administrator (for example, sasadm@saspw).
2. Select the Folders tab.
3. Right-click on your root report folder, and select Import SAS Package. The Import SAS Package Wizard opens.
4. Type the location to the SPK file, or click Browse. Click Next.
5. Select the stored process objects to import, and then click Next.
7. Review the summary information, and then click Next.
8. After the import process completes, click Finish.

Post-Migration Tasks for Reports

After you have migrated the reports to this release, you might also need to make code modifications. Assess such modifications on a case-by-case basis based on the following factors:

- changes to the macros provided for reports, including some new macros
- a change to the manner in which multiple-value parameters are passed to the code
- enhanced support for libraries
- enhanced support for dynamically populated parameters (for example, parameters with options that are generated by the application at run time)
- enhanced output format and style support

**NOTE:** For more information about making code modifications based on the above factors, see “Creating Custom Reports.”

In most cases, to make your reports usable with this release of the SAS Forecast Server, you can update the preamble code in the source code file to use the same code that is used by the sample reports. The preamble code used by the sample reports is shown below.
Post-Migration Tasks for Reports

*ProcessBody;

/*---------------------------------------------------------*/
/*- initialize the HPF stored process support -*/
/*---------------------------------------------------------*/
%hpfstp();

/*---------------------------------------------------------*/
/*- initialize the ODS output -*/
/*---------------------------------------------------------*/
%HPF_InitODSOutput();

%stpbeg;

/*---------------------------------------------------------*/
/*- convert any list parameters to space-delimited lists -*/
/*---------------------------------------------------------*/
%HPF_MergePromptListParameters();

/*---------------------------------------------------------*/
/*- include the LIBNAME statements for the project -*/
/*---------------------------------------------------------*/
%include "&HPF_INCLUDE";
Chapter 5
Installation and Configuration of the SAS Forecast Server

Contents

Overview of Installation ................................................. 49
Deployment Outline ..................................................... 49
Documentation for the SAS Intelligence Platform .......... 50
Documentation and Configuration for the SAS Analytics Platform Server ... 50
Default File Locations .................................................. 51
Installation and Configuration of the SAS Forecast Server ........ 52
Upgrade and Migration Information ................................. 52
Pre-Installation Tasks ................................................... 52
How to Install and Configure the SAS Forecast Server ........ 54
Validate the SAS Forecast Server Installation .................. 57
Perform an Individual Installation of SAS Forecast Studio .... 58
Overview ................................................................. 58
Install SAS Forecast Studio on Windows ......................... 58
Start SAS Forecast Studio ........................................... 59

Overview of Installation

Deployment Outline

To install and deploy the SAS Forecast Server:

1. Work with your SAS representative to develop a plan and designate the host machines for your deployment of the SAS Forecast Server.

2. If you are upgrading from a previous release, read the Upgrade and Migration Information.

3. Read the SAS Intelligence Platform documentation, and complete the pre-installation tasks.

4. Read the SAS Analytics Platform server documentation.
5. Review the information about the Configuration of the Discovery Feature for the SAS Analytics Platform Server.

6. Complete the pre-installation tasks for the SAS Forecast Server.

7. Install the SAS Intelligence Platform, the SAS Analytics Platform server, and the SAS Forecast Server on each host machine as outlined in your plan.xml file that you developed with your SAS representative.

8. Complete the post-installation tasks for the SAS Forecast Server.

---

**Documentation for the SAS Intelligence Platform**

Because the SAS Forecast Server is designed to work with the SAS Intelligence Platform, it is recommended that you read the SAS Intelligence Platform documentation, which is located at [http://support.sas.com/documentation](http://support.sas.com/documentation), before you install the SAS Forecast Server. That documentation provides pre-installation tasks and instructions to guide you through a typical installation of the SAS Intelligence Platform.

---

**Documentation and Configuration for the SAS Analytics Platform Server**

**Documentation for the SAS Analytics Platform Server**

The SAS Forecast Server is also designed to work with the SAS Analytics Platform server. It is recommended that you read the SAS Analytics Platform server documentation, which is located at [http://support.sas.com/documentation](http://support.sas.com/documentation), before you install the SAS Forecast Server. The documentation for the SAS Analytics Platform server provides additional information about its installation and configuration.

---

**Configuration of the Discovery Feature for the SAS Analytics Platform Server**

The SAS Analytics Platform server provides a feature that enables SAS Forecast Studio and the SAS Forecast Server Plug-in for SAS Management Console to discover SAS Forecast Server installations without needing to know their network locations in advance. By default, this feature is not enabled during configuration of the SAS Analytics Platform server. If you want to use this feature, check **Enable automatic discovery of the server via multicasting** in the SAS Deployment Wizard when configuring the SAS Analytics Platform server. If you have already configured the SAS Analytics Platform server without activating this feature, you will need to reconfigure it to enable this feature. For more information, see the Administrator’s Guide for the SAS Analytics Platform at [http://support.sas.com/documentation](http://support.sas.com/documentation).
By default, the discovery feature searches for the SAS Analytics Platform servers that use the multicast settings for a level-1 deployment. To simplify deployment, it is recommended that you install all SAS Analytics Platform servers at this level to avoid the need for customization. If you must use a different configuration level or customize the multicast port setting, then you must also modify the client applications to use the different port value. For more information about how to perform this customization, see “Configure the SAS Forecast Server Clients to Use a Customized Port for Multicast.”

**NOTE:** Some sites might place restrictions on this feature due to security concerns. Before enabling the discovery feature, consult your site’s local security staff.

---

### Default File Locations

The SAS Deployment Wizard installs and configures your SAS software. The application installation files are installed in a default location referred to as SAS_HOME. For example, on a Windows system SAS_HOME is `C:\Program Files\SAS`.

The configuration files are stored in a default location referred to as the `<config-dir>`. For example, on a Windows system the `<config-dir>` is `C:\SAS\Config\Lev<number>`.

**NOTE:** You can deploy up to 10 configurations of the SAS products. The SAS Deployment Wizard specifies each configuration under a `Lev<number>` folder. For example, if you deploy a level-2 configuration, then the default configuration directory is `C:\SAS\Config\Lev2`.

Table 5.1 shows the default location of the installation and configuration files for the SAS Forecast Server.

#### Table 5.1 Default Location of Installation and Configuration Files

<table>
<thead>
<tr>
<th>File</th>
<th>Windows Location</th>
<th>UNIX Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAS_HOME</td>
<td><code>C:\Program Files\SAS</code></td>
<td><code>../SAS</code></td>
</tr>
<tr>
<td>SASROOT</td>
<td><code>C:\Program Files\SAS\SAS Foundation\9.2</code></td>
<td><code>../SAS/SAS Foundation/9.2</code></td>
</tr>
<tr>
<td><code>&lt;config-dir&gt;</code></td>
<td><code>C:\SAS\Config\Lev&lt;number&gt;</code></td>
<td><code>../SAS/Config/Lev&lt;number&gt;</code></td>
</tr>
<tr>
<td>The SAS Analytics Platform server</td>
<td><code>SAS_HOME\SASAnalytics Platform\1.5</code></td>
<td><code>SAS_HOME/SASAnalytics Platform/1.5</code></td>
</tr>
<tr>
<td>The SAS Forecast Server middle tier</td>
<td><code>SAS_HOME\SASForecastServer MidTier\3.1</code></td>
<td><code>SAS_HOME/SASForecastServer MidTier/3.1</code></td>
</tr>
<tr>
<td>SAS Forecast Studio</td>
<td><code>SAS_HOME\SASForecastStudio\3.1</code></td>
<td>Not supported on UNIX</td>
</tr>
<tr>
<td>The SAS Forecast Server configuration file</td>
<td><code>SAS_HOME\SASForecastServer MidTier\3.1\Config\apps\Forecasting\app.config</code></td>
<td><code>SAS_HOME/SASForecastServer MidTier/3.1/Config/apps/Forecasting/app.config</code></td>
</tr>
</tbody>
</table>
Chapter 5: Installation and Configuration of the SAS Forecast Server

Upgrade and Migration Information

If you are upgrading from a previous release, do not continue with the following installation and configuration steps until you review the upgrade information for the SAS Intelligence Platform, the SAS Analytics Platform server, and the SAS Forecast Server. For more information, see the following documents:

*SAS Intelligence Platform: 9.1.3 to 9.2 Migration Guide*
This document contains migration information that is specific to the SAS Intelligence Platform. It covers topics ranging from how to plan for a migration to how to validate the migrated SAS deployment of the SAS Intelligence Platform. To access this guide, see [http://support.sas.com/documentation/cdl/en/bimig/61696/HTML/default/titlepage.htm](http://support.sas.com/documentation/cdl/en/bimig/61696/HTML/default/titlepage.htm).

*Administrator’s Guide for SAS Analytics Platform 1.5*
This document contains migration information that is specific to the SAS Analytics Platform server. It provides information about how to migrate configuration properties from a SAS Analytics Platform 1.4 image to configure SAS Analytics Platform 1.5. To access this guide, see [http://support.sas.com/documentation](http://support.sas.com/documentation).

*Upgrading from SAS Forecast Server 2.1 to SAS Forecast Server 3.1*
This document is provided within the *SAS Forecast Server 3.1: Administrator’s Guide*, and it contains migration information that is specific to the SAS Forecast Server. It provides instructions about how to migrate your SAS Forecast Server 2.1 content when you upgrade to SAS Forecast Server 3.1. For more information, see “Upgrading from SAS Forecast Server 2.1 to SAS Forecast Server 3.1.”

Pre-Installation Tasks

Pre-Installation Tasks for the SAS Intelligence Platform

Before you begin your installation, you must complete a set of pre-installation tasks for the SAS Intelligence Platform. The documentation for the SAS Intelligence Platform provides detailed information about these tasks.
Pre-Installation Tasks

Pre-Installation Tasks for the SAS Forecast Server

Create the SAS Forecast Server Product Administrative User Account

As a pre-installation task, you must create an operating system account to use for the SAS Forecast Server product administrative user. Create an operating system account for this user on each of the SAS Workspace Servers that host the SAS Forecast Server project files. A SAS Forecast Server administrative user is specific to the SAS Forecast Server. These users must have a valid host operating system account, and as a post-installation task, you must associate that account with a metadata user. Product administrators have access to modify any project or environment setting in the product. Additionally, product administrators can use the SAS Forecast Server Plug-in for SAS Management Console and restricted parts of the batch API macros to perform administrative actions that are not available in SAS Forecast Studio. These users must have access to the project areas on each SAS Workspace Server.

Note that a product administrator account is not the same as a general administrator account, such as the SAS Administrator (sasadm@saspw).

NOTE: The SAS Forecast Server uses both regular user accounts and product administrative user accounts. You can create regular user accounts for the SAS Forecast Server as a post-installation task. For more information, see “Creating the SAS Forecast Server Operating System User Accounts” and “Define Additional Users.”

Recommendations for the Product Administrator’s Windows User Account

NOTE: The following steps apply only if you are creating the operating system account on the local machine where the SAS Workspace Server is running. It is also possible to have a user defined on the Active Directory server (for example <domain>\username) and to use this user account.

When you create the operating system account for the product administrator on Windows, it is recommended that you do the following:

- Clear the User must change password at next logon check box.
- Select the User cannot change password check box.
- Select the Password never expires check box.
- Grant the user permission Log on as a Batch Job.

NOTE: In the Windows user manager, you cannot enter <domain>\username (you enter the user name only), but you must enter <domain>\username in the SAS Configuration Wizard and SAS Management Console.

Create the SAS Forecast Server UNIX User Group

As an option, you can choose to create the SAS Forecast Server UNIX user group as a pre-installation task. For more information, see “Creating the SAS Forecast Server UNIX User Group.”
How to Install and Configure the SAS Forecast Server

When you deploy the SAS Forecast Server, you also deploy all of its required components, such as the following:

- SAS Forecast Studio
- SAS Forecast Server Plug-in for SAS Management Console
- SAS Forecast Server batch macros and stored processes

**NOTE:** The SAS Forecast Server works with the SAS Analytics Platform server and the SAS Intelligence Platform. These components are also installed and configured when you deploy the SAS Forecast Server.


To install and configure the SAS Forecast Server:

1. For each machine on which you need to install software, log on to your computer, and then start the SAS Deployment Wizard executable file from your SAS Software Depot. For example, on a Windows system, double-click the `setup.exe` file located in the SAS Software Depot folder.

2. Select the preferred language for the SAS Deployment Wizard screens.

3. After the SAS Deployment Wizard opens, enter the following information on each screen:

   a) **Select Deployment Task.** Select *Install SAS software*, and then click *Next*.

   b) **Select Deployment Type.** Select *Perform a Planned Deployment*, and then select *Install SAS Software and Configure SAS Software*. Click *Next*.

   c) **Specify Deployment Plan.** Select *Specify the full path to a customized deployment plan*. This is the `plan.xml` file. Typically, the deployment plan is stored in the `plan_files` folder of the SAS Software Depot. If necessary, click *Browse* to navigate to your `plan.xml` file. Click *Next*.

   d) **Select Products to Install.** The deployment plan determines which products to install. Click *Next*.

   e) **Specify SAS Installation Data File.** This is the path to your SID file. By default, the SID file is located in the SAS Software Depot under the `sid_files` folder. If necessary, click *Browse* to navigate to it. Click *Next*.

   f) **Select Language Support.** Select the languages you would like to install for the products listed. Only those languages that work with your locale are installed. Click *Next*.

4. Enter the following information needed to configure the software:
How to Install and Configure the SAS Forecast Server

a) **Select Configuration Prompting Level.** Select **Typical** to display the basic set of configuration settings. For fewer options, select **Express.** For more granular configuration options, select **Custom.** To configure the SAS Forecast Server, the **Typical** setting is recommended. Click **Next.**

b) **Specify Configuration Information.** This step creates your software’s configuration directory. The SAS Deployment Wizard allocates up to 10 configuration levels. The default settings create a level-1 configuration. For example, on a Windows system, this is C:\SAS\Config\Lev1. If you create a level-2 configuration, then the default Windows location for it is C:\SAS\Config\Lev2. Click **Next.**

c) **Local Machine Name.** Type the **Fully-qualified Local Host Name** and the **Short Local Host Name.** Click **Next.**

d) Select a migration option. Do one of the following:

- If you are not upgrading from the previous release, then do not select **Perform migration.** Click **Next.**
- If you are upgrading from the previous release, do not continue with the remaining installation and configuration steps until you review the information in the **Upgrading from SAS Forecast Server 2.1 to SAS Forecast Server 3.1** chapter.

**NOTE:** Information about the configuration settings for the SAS Intelligence Platform and the SAS Analytics Platform server are beyond the scope of this guide. For more information about these settings, click **Help** in the SAS Deployment Wizard, or see the following:

- For information about entering SAS Deployment Wizard information for the SAS Intelligence Platform or the SAS Analytics Platform server, see [http://support.sas.com/documentation](http://support.sas.com/documentation).
- For information about entering SAS Deployment Wizard information for other solutions, see the solution documentation.

5. Enter the information needed to configure the SAS Forecast Server:

**NOTE:** The Environment Setup options in steps b through d are not available when performing a migration. The environments are created based on the migrated content. For more information about migration, see “**Upgrading from SAS Forecast Server 2.1 to SAS Forecast Server 3.1.**”

a) **SAS Forecast Server: HTTP Server Configuration.** Select **Grant access to SAS Forecast Studio tasks** to allow access to these tasks by SAS Add-In for Microsoft Office and SAS Enterprise Guide. Click **Next.**

b) **SAS Forecast Server: Environment Setup.** As an option, you can select to **Create an environment during configuration.** This step lets you avoid manually creating an initial environment before using SAS Forecast Studio. An environment is required as a container for the SAS Forecast Server projects. If you choose to skip this step, you must manually create an environment using the SAS Forecast Server Plug-in for SAS Management Console before using SAS Forecast Studio. For more information about creating environments, see “**Create an Environment.**” Click **Next.**

c) **SAS Forecast Server: Environment Dependencies.** Select a configured instance of the SAS Workspace Server that will host the environment. The workspace server that you select must be one other than SASMeta. The SAS Forecast Server depends on a
configured instance of the SAS Workspace Server to successfully complete its configuration of the environment. Click Next.

**NOTE:** If there is a single workspace server configured in the system, then that server will be assumed as the host for the environment and this window does not display.

d) If you chose to create an environment, the **SAS Forecast Server: Environment Setup** screen opens. Complete the following:

- Type a name for the environment, or use the default name provided.
- Type a description for the environment, or use the default description provided.
- Type the file system location to the root path of the SAS Forecast Server project directory (also referred to as the content location), or use the default location provided. This project directory must exist on the workspace server. Even if you accept the default path, you must manually create the project directory on the workspace server. The SAS Forecast Studio users must have full access to this location. For more information about specifying permissions for environments, see **Security Administration Tasks**.

  **NOTE:** This field is populated with a default value that configures the environment’s path under the SAS Config directory. For example, on a Windows system, the default content location might be `C:\SAS\Config\Lev1\AppData\ForecastServer\3.1`. If you intend to keep your projects in a different location, you should change this value.

e) Click Next.

6. **Deployment Summary.** After you have navigated through the SAS Deployment Wizard screens, the **Deployment Summary** window displays. Review the list of products that you are about to install, and click **Start**. The SAS Deployment Wizard switches from its information gathering mode to its installation and configuration mode. It performs the following tasks:

- Verification of system requirements on Windows systems. Note that the System Requirements Wizard requires user interaction.
- Installation of your software. After you complete the System Requirements Wizard, the SAS Deployment Wizard does not require any user interaction. The SAS Deployment Wizard installs each product that is shown in the list in the order shown. The installations are chained, so you do not need to initiate the installation programs. After installing the first product, the SAS Deployment Wizard automatically proceeds with the installation of the next product. On a Windows system, the default location for the installation files is in the `C:\Program Files\SAS` folder.
- Configuration of your software. The SAS Deployment Wizard attempts to configure all the software you installed.

7. The SAS Deployment Wizard indicates that the installation and configuration of your SAS software is complete in the **Deployment Complete** screen. Each software component should have a check mark next to it in the list. Click **Next**.

8. **Additional Resources.** Review the manual configuration instructions in the Instructions.html file. This file is saved to your configuration folder during deployment (for example, `C:\SAS\Config\Lev1\Documents\Instructions.html`). You can also view the list
Validate the SAS Forecast Server Installation

To validate your SAS Forecast Server installation, do the following:

1. For environments that were created during configuration or migration, ensure that:
   - The content location (also referred to as the project directory) of each environment exists on the workspace server that the environment has been configured to use.
   - SAS Forecast Studio users have full access to the content location of the environment.

2. Configure your environment. For more information, see “Security Administration Tasks.”

3. If you did not do so as a pre-installation task, create the SAS Forecast Server user accounts. For more information, see “Create the SAS Forecast Server Operating System User Accounts.”

4. If you configured the SAS Analytics Platform server at the same time as the SAS Forecast Server, then there is no need to restart the SAS Analytics Platform server. If it was previously configured and started, restart the SAS Analytics Platform server. For more information, see “Start the SAS Analytics Platform Server.”

5. Verify that you can access SAS Forecast Studio from:
   http://<server>:<port>/Forecasting/main.jnlp

6. Verify that you can successfully log in.

   **NOTE:** For any validation errors, see the SAS Analytics Platform server log files located in the `<config-dir>AnalyticsPlatform/Logs` directory.
Perform an Individual Installation of SAS Forecast Studio

Overview

You can use an index provided in the SAS Deployment Wizard to install additional non-configurable SAS software.

**NOTE:** Because this installation method does not perform software configuration, it is recommended that you use it only when you want to add non-configurable SAS software to an existing deployment. If you are installing the SAS Forecast Server middle tier, the SAS Forecast Server Plug-in for SAS Management Console, the SAS Analytics Platform server, or the SAS Intelligence Platform, you must both install and configure these components during deployment. Do not install these products individually or without a deployment plan (plan.xml file).

Install SAS Forecast Studio on Windows

**Java Runtime Environment (JRE)**

The SAS Deployment Wizard silently installs SAS Forecast Studio. In addition, the SAS Deployment Wizard verifies whether you have the required Java Runtime Environment (JRE) installed on your system. If it is not installed, the SAS Deployment Wizard installs it for you before it installs SAS Forecast Studio.

For information about the required JRE version, see [http://support.sas.com/resources/thirdpartysupport/v92/jres.html](http://support.sas.com/resources/thirdpartysupport/v92/jres.html).

**Install SAS Forecast Studio**

**NOTE:** You can install SAS Forecast Studio only on the Windows platform.

To install SAS Forecast Studio:

1. Start the SAS Deployment Wizard from your SAS Software Depot. For example, on a Windows system, double-click the `setup.exe` file located in the SAS Software Depot folder.

2. Select the preferred language for the SAS Deployment Wizard screens.

3. After the SAS Deployment Wizard opens, enter the following information on each screen:
   a) **Select Deployment Task.** Select **Install SAS software**, and then click **Next**.
   b) **Select Deployment Type.** Select **Install Additional Software**, and then click **Next**.
   c) **Select Products to Install.** Select SAS Forecast Studio, and then click **Next**.
d) **Specify SAS Installation Data File.** This is the file path to your SID file. By default, the SID file is located in the SAS Software Depot under the `sid_files` folder. If you have relocated this file, click **Browse** to navigate to it. Click **Next**.

e) After you navigate through the SAS Deployment Wizard screens, the Deployment Summary window displays. Review the information about the products that you are about to install, and click **Start**. The SAS Deployment Wizard switches from its information gathering mode to its installation mode.

f) When the installation completes, click **Finish**.

---

**Start SAS Forecast Studio**

For information about how to start SAS Forecast Studio, see Chapter 8, “Start SAS Forecast Studio.”
# Chapter 6

## Post-Installation Tasks

### Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Post-Installation Tasks</td>
<td>61</td>
</tr>
<tr>
<td>Most Current Documentation</td>
<td>61</td>
</tr>
<tr>
<td>How to Receive Problem Alert Notices</td>
<td>62</td>
</tr>
<tr>
<td>Server Tier Post-Installation Tasks</td>
<td>62</td>
</tr>
<tr>
<td>Install Current Hot Fixes</td>
<td>62</td>
</tr>
<tr>
<td>Create the SAS Forecast Server Operating System User Accounts</td>
<td>63</td>
</tr>
<tr>
<td>Create the SAS Forecast Server Users in SAS Management Console</td>
<td>66</td>
</tr>
<tr>
<td>Create an Environment</td>
<td>67</td>
</tr>
<tr>
<td>Configure the Root Reports Folder for an Environment</td>
<td>68</td>
</tr>
<tr>
<td>Set File System Permissions on Windows</td>
<td>68</td>
</tr>
<tr>
<td>Preassign Libraries in SAS Management Console</td>
<td>69</td>
</tr>
<tr>
<td>Configure the SAS Forecast Server and SAS Add-In for Microsoft Office</td>
<td>71</td>
</tr>
<tr>
<td>Middle Tier Post-Installation Tasks</td>
<td>73</td>
</tr>
<tr>
<td>Post-Installation Tasks for the SAS Analytics Platform Server</td>
<td>73</td>
</tr>
</tbody>
</table>

### About Post-Installation Tasks

This chapter provides the tasks that you must manually perform after you successfully deploy the SAS Forecast Server.

### Most Current Documentation

For the most current SAS Forecast Server installation and configuration information, see [http://support.sas.com/documentation](http://support.sas.com/documentation).
How to Receive Problem Alert Notices

To receive Problem Alert Notices or Problem Correction Notices (hot fix notifications) when they are made available, you can subscribe to the TSNEWS-L mailing list.

To subscribe to the mailing list:

1. Send an e-mail to LISTSERV@VM.SAS.COM.
2. The body of the e-mail should read SUBSCRIBE TSNEWS-L.

Server Tier Post-Installation Tasks

Install Current Hot Fixes

Locate Hot Fixes for SAS Forecast Server

Before starting any of the SAS Forecast Server post-installation tasks, you must install a required hot fix on any client that has SAS Management Console 9.2 and the SAS Forecast Server Plug-in for SAS Management Console. This hot fix addresses specific issues related to the SAS Forecast Server.

To locate the hot fixes for SAS Forecast Server 3.1:

2. Scroll to Forecast Server. Install the hot fixes that are available for SAS Forecast Server 3.1. Do not install any previous versions of the SAS Forecast Server hot fixes (for example from version 2.1). These hot fixes already exist in the SAS Forecast Server 3.1 software.

Locate Hot Fixes for Other SAS Products

To locate hot fixes for other SAS products:

2. Select Sorted by SAS Product.
Create the SAS Forecast Server Operating System User Accounts

About the SAS Forecast Server User Accounts

The SAS Forecast Server uses two types of user accounts:

- **Product administrative user**: A SAS Forecast Server administrative user is specific to the SAS Forecast Server. These users must have a valid host operating system account, and you must associate that account with a metadata user. Product administrators have access to modify any project or environment setting in the product. Additionally, product administrators can use the SAS Forecast Server Plug-in for SAS Management Console and restricted parts of the batch API macros to perform administrative actions that are not available in SAS Forecast Studio. These users must also have access to the project areas on each SAS Workspace Server.

  **NOTE**: A product administrator account is not the same as a general administrator account, such as the SAS Administrator (sasadm@saspw).

- **User accounts**: Regular users that access SAS Forecast Studio. These users must have a valid host operating system account, and you must associate that account with a metadata user using SAS Management Console. In addition, these users must have full access to the appropriate project areas on each SAS Workspace Server.

Recommendations for the Product Administrator’s Windows User Account

**NOTE**: The following steps apply only if you are creating the operating system account on the local machine where the SAS Workspace Server is running. It is also possible to have a user defined on the Active Directory server (for example `<domain>\username`) and to use this user account.

When you create the operating system account for the product administrator on Windows, it is recommended that you do the following:

- Clear the **User must change password at next logon** check box.
- Select the **User cannot change password** check box.
- Select the **Password never expires** check box.
- Grant the user permission **Log on as a Batch Job**.

**NOTE**: In the Windows user manager, you cannot enter `<domain>\username` (you enter the user name only), but you must enter `<domain>\username` in the SAS Configuration Wizard and SAS Management Console.

Creating the SAS Forecast Server UNIX User Group
**About the SAS Forecast Server UNIX User Group**

Different users have different operating-system privileges when using the SAS Workspace Server. By defining operating system user groups, you can grant host permissions to all of the SAS Forecast Server users as members of the same group.

You must grant the SAS Forecast Server users Read, Write, and Execute access on the project directory that contains the content files. The exact details of how to do this varies according to which operating system groups are defined and your site’s security policies.

For a more secure deployment, you can create a SAS Forecast Server user group and ensure that the group contains all of the SAS Forecast Server users. In the UNIX operating environment, the directory where the content files are stored must have Write permissions for all of the SAS Forecast Server users. Therefore, the SAS Forecast Server users’ UNIX log ons must be in the same UNIX OS group. UNIX users can be members of multiple groups, but one of the groups is primary. In this case, the SAS Forecast Server group must be the primary group. In the UNIX operating environment, the following conditions must be met:

- The UNIX OS group of forecasting users is created.
- The UNIX forecasting user IDs are members of the OS group and it becomes the primary group.
- The SAS scripts are updated to specify the umask options when the SAS Workspace Server and SAS Stored Process Server are running under the forecasting group user identities.
- The `forecast-studio-project-directory` has the correct ownership and group Write permissions applied on behalf of the forecasting group.

**NOTE:** You must include any user who might run code that is created from a SAS Forecast Server project in a SAS session as part of the group.

**Example UNIX Configuration**

**Set the umask Option**

You can grant permissions to the SAS Forecast Server users by specifying the umask option on a conditional basis if the user is part of the SAS Forecast Server user group.

**NOTE:** This example might require changes to fit your server configuration. In particular, this example could result in changed permissions on other SAS files, such as OLAP cubes. If you are working with multiple UNIX groups and have a SAS OLAP Server, you must ensure that the account under which the SAS OLAP Server runs has read and execute permissions to OLAP files.

To set the umask option:

1. Set the umask option in the `appservercontext_env.sh` shell script (located in the `<config-dir>/Lev1/SASApp` path) only if the user is a member of the SAS Forecast Server user group.

   **NOTE:** If additional workspace servers are configured, you must set the umask option in the `appservercontext_env.sh` file associated with the individual workspace definitions.
2. A umask setting of 002 is recommended.

**Update Configuration Information**

On a UNIX operating system, you need to update the configuration information shown below based on your machine-specific information.

**NOTE:** The following code uses grave accents and not quotation marks.

```bash
CMD=<your-operating-system-path>
CURR_GID='eval $CMD -g'
GID=<solution-group-id>
if [ $CURR_GID -eq $GID ]; then umask 002 fi
```

1. **CMD=<your-operating-system-path>**
   Replace the CMD= command with the full path on your server where the ID command is stored. You can get this information by typing a `which id` or `whence id` command on your console.

2. **GID=<solution-group-id>**
   Replace the GID= variable setting with your group ID. You can type `id` on your console to get the GID and UID information.

By using the preceding example values, the resulting command lines look like the following for each of the platforms that you can install the SAS Forecast Server on:

- **AIX:**
  ```bash
  CMD=/usr/bin/id
  CURR_GID='eval $CMD -g'
  GID=201
  if [ $CURR_GID -eq $GID ]; then umask 002 fi
  ```

- **H64 (HP-Risc):**
  ```bash
  CMD=/usr/bin/id
  CURR_GID='eval $CMD -g'
  GID=201
  if [ $CURR_GID -eq $GID ]; then umask 002 fi
  ```

- **H64I (HP-Itanium):**
  ```bash
  CMD=/usr/bin/id
  CURR_GID='eval $CMD -g'
  GID=201
  if [ $CURR_GID -eq $GID ]; then umask 002 fi
  ```
• S64 (Solaris):
  CMD=/usr/xpg4/bin/id
  CURR_GID='eval $CMD -g'
  GID=201
  if [ $CURR_GID -eq $GID ] ; then umask 002
  fi

• SAX (Solaris for X64):
  CMD=/usr/xpg4/bin/id
  CURR_GID='eval $CMD -g'
  GID=201
  if [ $CURR_GID -eq $GID ] ; then umask 002
  fi

• LNX (Linux):
  #!/bin/bash
  CMD=/usr/bin/id
  CURR_GID='eval $CMD -g'
  GID=500
  if [ "$CURR_GID" -eq "$GID" ] ; then umask 002
  fi

Create the SAS Forecast Server Users in SAS Management Console

Configure the SAS Forecast Server Product Administrator

NOTE: A pre-installation task required you to create an operating system account for this user on each of the SAS Workspace Servers that host the SAS Forecast Server project files.

To configure a SAS Forecast Server administrator account:

1. Start SAS Management Console, and connect as a SAS administrator (for example, sasadm@saspw).

2. Create a metadata account for the user in SAS Management Console and associate that account with the operating system account. For more information, see “Define Additional Users.”

3. In the SAS Management Console User Manager plug-in, right-click on the user and then select Properties. The Properties dialog box opens.
   a) Select the Groups and Roles tab.
   b) In the Available Groups and Roles list, select the Management Console: Advanced role. This role is required so that the SAS Forecast Server Plug-in for SAS Management Console and other solution-specific plug-ins are available to the SAS Forecast Server product administrative user.
   c) Click to move the item to the Member of list.
d) Click OK.
4. In SAS Management Console, select the Folders tab.
5. Expand the System and Applications folders.
7. Select the Authorization tab.
8. Select your administrator user (or a group) in the Users and Groups area. **NOTE:** If the user or group is not shown, click Add.
9. Select the Administer permission for the SAS Forecast Server product administrator user, and then click OK.

**Configure the SAS Forecast Server Users**

After creating your operating system accounts for the regular SAS Forecast Server users, you must also add these users to the metadata. You can use SAS Management Console to do this. For information about configuring these users, see “Define Additional Users.”

---

**Create an Environment**

**Important:** You must create at least one environment before you can create a project in SAS Forecast Studio. If you opted to create a default environment during the SAS Forecast Server configuration steps in the SAS Deployment Wizard, you do not need to perform this task in SAS Management Console. However, you must create the corresponding project directory for the environment and then set the appropriate permissions for that directory on the file system. For more information about security settings for environments, see “Environment Permissions.”

You can create multiple environments to organize your projects. You can also create environments specifically to control access to them.

**NOTE:** Each file system location in a workspace server should be used by only one environment system-wide, regardless of the number of environments or middle tiers in the system. In general, the file system location that is specified for the environment and its subdirectories should be reserved for use only by that environment. This restriction is necessary to ensure the integrity of the file system content and to properly coordinate client access.

To create an environment using the SAS Forecast Server Plug-in for SAS Management Console:

1. Open SAS Management Console and log on as the SAS Forecast Server product administrator.
2. In the navigation tree, locate the Application Management node, and then select Forecast Studio. The SAS Analytics Platform server logon dialog box opens. Log on to the SAS Analytics Platform server as the SAS Forecast Server product administrator.
3. Enter your **User name** and **Password**, and then select a **Server**.

4. Right-click on the **Forecast Server** node in the navigation tree, and then select **New Environment**. The Create Environment dialog box opens.

5. Type a name for the new environment.

6. (Optional) Type a description for the environment.

7. Select a workspace server. The first available workspace server is selected by default. You can select a different server using the drop-down list.
   
   **NOTE:** The workspace server that you select must be one other than SASMeta.

8. Type or click **Browse** to specify the **Location** of the content path. This is the root path to the SAS Forecast Server project directory.
   
   **NOTE:** If you have more than one environment, they should not share the same file system location on the same server. Additionally, you should not configure one environment to use a subdirectory within a different environment.

9. Type or click **Browse** to specify the location of the **Reports** folder in the metadata.

10. Click **OK**.

---

**Configure the Root Reports Folder for an Environment**

The reports that you configure in SAS Management Console are displayed in the Reports and Stored Processes dialog box of SAS Forecast Studio. During installation and configuration, you had the option to configure a default environment for the SAS Forecast Server in the SAS Deployment Wizard. However, creating a default environment does not automatically configure its root report folder. If you created a default environment in the SAS Deployment Wizard, you must configure the root report folder for the environment. You can use the SAS Forecast Server Plug-in for SAS Management Console to do this. For more information, see “Configure the Report Metadata Folder for the Environment.” For more information about working with reports, see “Report Administration Tasks.”

---

**Set File System Permissions on Windows**

On a Windows system, you must set file system permissions for all of the SAS Forecast Server users. Additionally, to support the public settings on projects, you must grant full control to the directory tree associated with the environment to all users that are allowed to access the SAS Forecast Server environment.

For more information about environments in the SAS Forecast Server, see “Environment Permissions.”

To set file system permissions on Windows for all users:
1. Open Windows Explorer and select the root content directory used by the SAS Forecast Server environment.

2. Right-click on this directory, and then select Properties.


4. Select the users for the current machine.

5. Enable Full Control for the specified group of users.

6. Click OK.

---

**Preassign Libraries in SAS Management Console**

To enable the SAS Forecast Server to access the input data sets, you must define a SAS library that specifies the data set location. All data sets that exist in the selected libraries are displayed.

For an overview about library security in the SAS Forecast Server, see “Configuring Library Permissions.”

**NOTE:** Library names cannot begin with an underscore character. Libraries using this naming convention are not shown because this naming convention is used by internal SAS libraries.

To enable the SAS Forecast Server to access your data, create the following:

- an input SAS data set that contains the appropriate time series data
- a SAS library that specifies the SAS libref, engine, and path of the input data set

To create an input data set and user-defined library:

1. Create a SAS data set.
   
   To enable the SAS Forecast Server to read a SAS data set, you can create a SAS program that reads your raw data into a SAS data set.

2. Define the library for the SAS Forecast Server input data set.
   
   To enable the SAS Forecast Server to read the input data set, use SAS Management Console to define a library that specifies the SAS libref, engine, and path of the input data set. If no data sets are imported in SAS Management Console, then the libref appears in SAS Forecast Studio but none of the data sets are shown. You can either use the same name for the library and libref or if you use a different name for a library and libref, you must import the data sets in the library manually by using SAS Management Console.

   For example, if the library name in SAS Management Console is *Forecast* but the libref is *fsdata*, then the libref fsdata appears in SAS Forecast Studio but none of the underlying data sets are displayed. To correct this problem, you must either change the library name in SAS Management Console to match the libref or import the tables in SAS Management Console.
You can import the data tables in a newly-created library by right-clicking on the library name in SAS Management Console and then selecting Import Tables.

Use the Data Library Manager plug-in of SAS Management Console to define a library that is preassigned to a server or servers, and specify the location of the input data set.

To specify a library as preassigned for a server or servers:

1. Open SAS Management Console as the SAS Administrator (for example, sasadm), and then connect to a metadata repository.
2. Expand the Data Library Manager node, and then select Libraries.
3. Right-click the library that you want to preassign, and then select Properties.
4. Select the Options tab.
5. Click Advanced Options.
6. Select the Library is preassigned check box. Note that this window is also accessible from the Library Options window of the New Library Wizard when you create a new data library.
7. Ensure that the library is assigned to the correct SAS server(s). The selected library is assigned whenever one of the selected servers starts.
8. Click OK.

3. Create the metadata identity for the SAS Forecast Server product administrator user. For more information, see “Configure the SAS Forecast Server Product Administrator.”

4. Set the metadata permissions on the libraries for the SAS Forecast Server product administrator.

5. Set the metadata permissions on the libraries for the SAS Forecast Server users.

**NOTE:** For more information about security, see “Securing Access to the SAS Forecast Server.”

a) In SAS Management Console, expand the Data Library Manager node, and then select Libraries.

b) Right-click on the library that you want to grant permissions on, and then select Properties.
Configure the SAS Forecast Server and SAS Add-In for Microsoft Office

What Is the SAS Add-In for Microsoft Office?

The SAS Add-In for Microsoft Office extends the functionality of Microsoft Excel, Microsoft Word, and Microsoft PowerPoint by enabling you to access SAS analytics and SAS reporting functionality without any SAS programming experience. The SAS add-in is designed for people who are familiar with these Microsoft Office programs but who might be new to SAS.

When the SAS add-in is installed on a client machine, a SAS menu and the SAS Analysis Tools toolbar are automatically integrated into Excel, Word, and PowerPoint.

The SAS add-in includes many SAS tasks that enable you to perform a variety of analyses. The Forecast Studio Create Project task, the Forecast Studio Open Project task, and the Forecast Studio Submit Overrides task are available in the Analyze Data window.

What Are the SAS Forecast Studio Tasks?

You can use the SAS add-in to run the following SAS Forecast Studio tasks:

- the Forecast Studio Create Project task to create a SAS Forecast Studio project from an Excel or SAS data source
- the Forecast Studio Open Project task to open the results from a selected series in an existing SAS Forecast Studio project
- the Forecast Studio Submit Overrides task to submit overrides for the forecast data in an existing SAS Forecast Studio project

Prerequisites for Using the SAS Forecast Studio Tasks

To use the SAS Forecast Studio tasks in the SAS add-in, you must complete the following:

- install SAS Forecast Server 3.1.
Chapter 6: Post-Installation Tasks

- install SAS Enterprise Guide 4.2 or the SAS Add-In 4.2 for Microsoft Office on each client machine, which is a product in the SAS Enterprise Business Intelligence Server bundle.

**NOTE:** The SAS Forecast Studio tasks were not available in the initial release of SAS Enterprise Guide 4.2 or the SAS Add-In 4.2 for Microsoft Office. You can download these from the Software Downloads page at [http://www.sas.com/download](http://www.sas.com/download). These tasks will also be available in a maintenance release.

- configuration of the SAS Forecast Server to use the SAS Add-In for Microsoft Office

Configuration Instructions

**Option 1: Configure the SAS Add-In for Microsoft Office Using SAS Management Console**

If you chose to do a typical configuration in the SAS Deployment Wizard, then you had the option to automatically configure a server in metadata to grant access to the SAS Forecast Studio Tasks. If you chose not to configure this option, or if you chose to do an express configuration, then you must configure an HTTP server in the SAS Metadata Server using SAS Management Console to grant access to the SAS Forecast Studio Tasks.

To configure the HTTP server in SAS Management Console:

1. Open SAS Management Console and log on as the SAS Administrator (for example, sasadm@saspw).
2. Right-click on **Server Manager**, and then select **New Server**.
3. Select the **Http Server** template, and then click **Next**.
4. Type **HPF** as the name, and then click **Next**.
5. Add a new base path by clicking **New**.
6. Type a forward slash (/) in the **Base Path** field, and then click **OK**.
7. Click **Next**.
8. Provide the host name of the SAS Analytics Platform server and the port number of the embedded Web server. Unless you changed the port value in the SAS Deployment Wizard during the configuration of the SAS Analytics Platform server, the default port value is 6401 for a level 1 configuration. Click **Next**.
9. Click **Finish**.

**Option 2: Reconfigure SAS Forecast Server with the SAS Deployment Wizard**

You can also use the SAS Deployment Manager and the SAS Deployment Wizard to configure the HTTP server in metadata required for access to these tasks.

To reconfigure the SAS Forecast Server to use the SAS Add-In for Microsoft Office:
1. Run the SAS Deployment Manager to unconfigure the SAS Forecast Server. For more information, see “Remove a Configuration with the SAS Deployment Manager.”

2. Run the SAS Deployment Wizard to reconfigure the SAS Forecast Server. Open the SAS Deployment Wizard from your SAS Software Depot. For example on a Windows system, double-click the setup.exe file located in the SAS Software Depot folder.

3. In the SAS Deployment Wizard, do the following:
   a) Select Deployment Task. Select Install SAS software.
   b) Select Deployment Type. Select Perform a Planned Deployment, and then select Configure SAS Software.
   c) Select Configuration Prompting Level. Select Typical to display the basic set of configuration settings.
   d) Select Products to Configure. Click Clear All, and then select SAS Forecast Server Mid-Tier.
   e) SAS Forecast Server: Http Server Configuration. Select Grant access to SAS Forecast Studio tasks to allow access to these tasks by SAS Add-In for Microsoft Office and SAS Enterprise Guide.
   f) Navigate through the remaining windows in the SAS Deployment Wizard, and click Finish.

   **NOTE:** You can use the SAS Forecast Server Plug-in for SAS Management Console to register and unregister user content. For more information about registering and unregistering content, see the Help for the SAS Forecast Server Plug-in for SAS Management Console.

**View the SAS Log**

If you have problems connecting to the SAS server, then turning on the SAS log might help you. You can view the SAS Log in the Microsoft Office application in which you are using the SAS Add-In for Microsoft Office.

To view the SAS log:

1. Select the SAS → Options → Results tab.
2. Check **Show SAS log**.
Chapter 6: Post-Installation Tasks

- Run as a background process on UNIX.
- Broadcast multicast messages.

For more information about these and other tasks, see the Administrator’s Guide for the SAS Analytics Platform at http://support.sas.com/documentation.
Chapter 7
Verify the SAS Forecast Server Installation

Contents

<table>
<thead>
<tr>
<th>Start and Verify the SAS Servers</th>
<th>75</th>
</tr>
</thead>
<tbody>
<tr>
<td>What Are the SAS Servers?</td>
<td>75</td>
</tr>
<tr>
<td>SAS Metadata Server</td>
<td>76</td>
</tr>
<tr>
<td>SAS Workspace Server</td>
<td>77</td>
</tr>
<tr>
<td>SAS Analytics Platform Server</td>
<td>78</td>
</tr>
<tr>
<td>SAS Object Spawner</td>
<td>78</td>
</tr>
<tr>
<td>Verify the SAS Forecast Server Installation</td>
<td>79</td>
</tr>
</tbody>
</table>

Start and Verify the SAS Servers

What Are the SAS Servers?

For more information about the SAS servers, refer to the SAS Intelligence Platform documentation set at http://support.sas.com/documentation/onlinedoc.

Before you start SAS Forecast Studio, you must have the following SAS servers and the SAS Object Spawner running:

- SAS Metadata Server
- SAS Object Spawner
- SAS Workspace Server (started by the SAS Object Spawner)
- SAS Analytics Platform server

The SAS Object Spawner and each server is represented by a directory inside of the SAS configuration directory. For example, you might see a WorkspaceServer directory under the ../SAS/Config/Lev1/SASMeta or ../SAS/Config/Lev1/SASApp directories and an ObjectSpawner directory under the ../SAS/Config/Lev1 directory.

NOTE: Lev1 is a default setting. Your organization might have anywhere from 1 to 10 levels in a configuration.
Each server directory contains scripts that you can use to start the servers. The scripts are named by the server name with an operating system appropriate extension (for example ServerName.bat or ServerName.sh).

To use a script to start the SAS Object Spawner on a Windows system:

1. Navigate to the C:\SAS\Config\Lev1\ObjectSpawner folder.
2. Execute the following command:

   ObjectSpawner.bat start

- On UNIX operating environments, you call these scripts directly to start servers and spawners.
- On Windows operating environments, you can call these scripts directly by using the Windows Start menu. For example, select Start → Programs → SAS → SAS Configuration → Config - Lev<number> → Object Spawner - Start.

---

**SAS Metadata Server**

**Definition**

The SAS Metadata Server controls access to a central repository of metadata, that is shared by all of the applications in the system. This repository contains metadata that represents items such as SAS servers, users, libraries, and data sets. For more information about the SAS Metadata Server, see the SAS Intelligence Platform documentation set at [http://support.sas.com/documentation/onlinedoc](http://support.sas.com/documentation/onlinedoc).

**Verify the SAS Metadata Server Is Running**

**Windows Operating Environment**

If your SAS Metadata Server is running on a Windows machine and you choose to run the server as a windows service, then the server starts automatically when you start the machine. You can use the Services window to stop or restart the service.

To stop or restart the SAS Metadata Server Windows service:

1. Navigate to the Services window by selecting Start → Settings → Control Panel → Administrative Tools → Services.
2. Right-click the server item (for example, SAS[Config-Lev<number>] SASMeta - Metadata Server).
3. Select Start, Stop, or Restart.
If your server is running on a Windows machine and you choose to start the server by using a script, then start the server from the Windows Start menu. Select Programs → SAS → SAS Configuration → Config - Lev<number> → SASMeta - Metadata Server - Start.

**NOTE:** You can start a server by executing a .bat file and passing the start command. The .bat file for the SAS Metadata Server is located in the path-to-config-dir\Lev1\SASMeta\MetadataServer folder.

### UNIX Operating Environment

To start the SAS Metadata Server on UNIX:

1. Log on using the SAS installer account.
2. Change directories to the path-to-config-dir/Lev1/SASMeta/MetadataServer directory.
3. Execute the script in the directory that starts the server.

---

### SAS Workspace Server

**Definition**


**Test the SAS Workspace Server Connection**

To test your connection to the SAS Workspace Server:

1. Start SAS Management Console, and then log on as a SAS Administrator (for example, sasadm).
2. Expand the Server Manager node.
3. Expand the SASMeta node.
4. Expand the SASMeta-Logical Workspace Server node.
5. Select SASMeta-Workspace Server.
6. In the right panel, right-click Connection: Workspace, and then select Test Connection.
7. Enter the SAS Demo User account (for example, sasdemo). A Test Connection Successful message displays.
SAS Analytics Platform Server

Definition

The SAS Analytics Platform server is a remote method invocation (RMI) middle tier server that hosts the SAS Forecast Server. You must install the SAS Forecast Server middle tier on the same machine as the SAS Analytics Platform server. Additionally, you must start the SAS Analytics Platform server to activate the SAS Forecast Server. For information about the SAS Analytics Platform server, see the SAS Analytics Platform server Administrator’s Guide at http://support.sas.com/documentation/onlinedoc.

SAS Object Spawner

Definition

The SAS Object Spawner is a process-spawning service that represents object servers that use the integrated object model (IOM) bridge protocol engine, such as the SAS Workspace Server and the SAS Stored Process Server. The SAS Object Spawner is a daemon on the server that listens for incoming client requests for IOM services. When the daemon receives a request from a new client, it launches an instance of either a SAS Workspace Server or a SAS Stored Process Server to fulfill the request. After the request is fulfilled, and nothing else is in the spawner’s queue, then the spawner returns to its wait state. For more information about the SAS Object Spawner, see the SAS Integration Technologies Administrator’s Guide at http://support.sas.com/documentation/onlinedoc.

Start the SAS Object Spawner, SAS Workspace Server, and SAS Stored Process Server

Windows Operating Environments

If the SAS Object Spawner is running on a Windows machine and you choose to run the servers as services, then the servers start automatically when you start the machine. When the SAS Object Spawner starts, then the SAS Workspace Server and the SAS Stored Process Server start automatically.

To stop or restart the Windows services:

1. Open the Windows Services window by selecting Programs → Settings → Control Panel → Administrative Tools → Services from the Windows Start menu.
2. Right-click the server item (for example, SAS[Config-Lev<number>] Object Spawner).
3. Select Stop or Restart.
If your server is running on a Windows machine and you have chosen to start the servers by using scripts, then you can start the servers from the Windows Start menu. Select Start → Programs → SAS → SAS Configuration → Config - Lev<number> → Object Spawner - Start.

**UNIX Operating Environments**

To start the SAS Object Spawner in a UNIX environment:

1. Log on using the SAS installer account.
2. Change directories to the path-to-config-dir/Lev1/SASMeta/ObjectSpawner directory.
3. Execute the script in the directory that starts the server.

---

**Verify the SAS Forecast Server Installation**

You can verify the successful installation of the SAS Forecast Server by:

- starting SAS Forecast Studio on a Windows machine where you installed the client
- creating a project

To start SAS Forecast Studio and create a new project:

1. From the Windows Start menu, select Programs → SAS → SAS Forecast Studio → SAS Forecast Studio 3.1.
2. In the Log On dialog box, type your user name and password, and specify a server with a fully qualified server-name:port-number name.
3. Click Log On.  
   **NOTE:** For more information about the different methods used to start SAS Forecast Studio, see Chapter 8, “Start SAS Forecast Studio.”
4. To create a new project when you open SAS Forecast Studio, click New in the Projects dialog box. Alternatively, if you close the Projects dialog box, you can select File → New Project from the main menu.
5. Specify a name for the project such as Test_Project, and then click Next.
6. In the New Project wizard, select a library that contains a data set that you want to forecast. For example, expand the SASHELP library.
7. Select the PRICEDATA data set, and then click Next.
8. Select the classifier variables. For example, select PRODUCT and PRODUCTNAME, and then click to move the variable to the Classifier variables selected list. Click Next.
9. Specify the **Time ID** variable and its properties. For example, select **DATE** for the **Time ID** variable. Keep the remaining default settings, and then click **Next**.

10. Assign the **Dependent** role to the **SALE** variable. Select the **SALE** variable, and then select **Dependent** in the **Role** column. Click **Next**.

11. Keep the default values specified to prepare the data for each forecast, and then click **Next**.

12. Keep the default values specified for the optional project settings, and then click **Next**.

13. Click **Finish** to produce the forecast.

Once you create the project and forecast the series, your installation is complete and verified.
Chapter 8
Start SAS Forecast Studio

Contents

<table>
<thead>
<tr>
<th>Required Servers</th>
<th>81</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start the SAS Analytics Platform Server</td>
<td>82</td>
</tr>
<tr>
<td>Start SAS Forecast Studio</td>
<td>82</td>
</tr>
<tr>
<td>Configure the SAS Forecast Server Clients to Use a Customized Port for Multicast</td>
<td>83</td>
</tr>
<tr>
<td>Using Java Web Start</td>
<td>84</td>
</tr>
<tr>
<td>Starting SAS Forecast Studio with Options</td>
<td>85</td>
</tr>
<tr>
<td>Specify the Number of Observations to Use to Detect the Time Interval</td>
<td>85</td>
</tr>
<tr>
<td>Specify the Sample Size for Validating BY Variable Values and Formats</td>
<td>85</td>
</tr>
</tbody>
</table>

Required Servers

Before starting SAS Forecast Studio, you must start the servers listed below in the order that they are listed.

1. The SAS Metadata Server
2. The SAS Object Spawner
3. The SAS Analytics Platform server

When you start the SAS Analytics Platform server, it automatically starts the SAS Forecast Server middle tier. Since the SAS Forecast Studio relies on the SAS Forecast Server middle tier, you must start the SAS Analytics Platform server before you start SAS Forecast Studio. If the SAS Analytics Platform server is not running as a Windows service, then the SAS Forecast Server middle tier starts automatically when you start the SAS Analytics Platform server.
Start the SAS Analytics Platform Server

Windows Environment

If you did not configure the SAS Analytics Platform server to run as a Windows service, then you can start it manually using the Windows shortcut or the .bat file.

To start the SAS Analytics Platform server on the middle tier server in a Windows environment:

Select Programs → SAS → SAS Configuration → Config-Lev<num> → Analytics Platform Server - Start From the Windows Start menu.

The SAS Analytics Platform server is ready to receive clients when the message “SAS Analytics Platform service - started” displays at the bottom of the screen.

Alternatively, you can start the SAS Analytics Platform server by executing a .bat file. At a DOS prompt, navigate to the SAS configuration directory. For example, navigate to the C:\SAS\Config\Lev1\AnalyticsPlatform folder, and type the following command:

AnalyticsPlatform.bat start

UNIX Environment

To start the SAS Analytics Platform server on the middle tier server in a UNIX environment:

1. Open a terminal session and have an X server running.

2. Navigate to the SAS Analytics Platform server configuration directory. For example, ./SAS/Config/Lev1/AnalyticsPlatform.

3. Execute the following command:

./AnalyticsPlatform.sh

The server is ready to receive clients when the message “SAS Analytics Platform service - started” displays at the bottom of the screen.

Start SAS Forecast Studio

SAS Forecast Studio runs only on the Windows operating system. You can start SAS Forecast Studio directly on the system where it is installed, or you can start it using Java Web Start. For more
Configure the SAS Forecast Server Clients to Use a Customized Port for Multicast

By default, the discovery feature for the SAS Analytics Platform server searches for the SAS Analytics Platform servers that use the multicast settings for a level-1 deployment. To simplify deployment, it is recommended that you install all SAS Analytics Platform servers at this level to avoid the need for customization. If you have used a different configuration level, or if you customized the multicast port setting, then you must also modify the SAS Forecast Server client applications to include those customized settings in the search.

---

To start SAS Forecast Studio on the system where it is installed:


2. Enter your User name and Password.
   - **User name**: The format for the user name is `username@domain` or `domain\username`.
   - **Remember my password**: If you would like the user name and password values to persist whenever you start SAS Forecast Studio, then select **Remember my password**. Note that the user name and password are saved if the policy configured for the SAS Metadata Server allows for externally saving a user’s credentials.
   - **Server**: The server value represents the name of the server that is running the SAS Analytics Platform server. The SAS Analytics Platform server starts an RMI Registry used by SAS Forecast Studio to locate the SAS Analytics Platform server at the port indicated in the server address. For example, the default port value is 6411 for a level 1 configuration. If you do not specify a default port value, 6411 is used. Additionally, typing `hostname` in this field automatically uses the default port value.

   **NOTE**: For more information about port values, see the *Administrator’s Guide for the SAS Analytics Platform Server* at [http://support.sas.com/documentation](http://support.sas.com/documentation).

3. Click **Search for Servers** to populate the drop-down list. When the search is complete, click the Server drop-down arrow for the list of valid servers that you can choose.

   **NOTE**: This search will only locate servers that were configured during deployment to respond to multicast discovery requests. For more information about server configuration, see the *Administrator’s Guide for the SAS Analytics Platform Server* at [http://support.sas.com/documentation](http://support.sas.com/documentation). By default, this search will also only locate servers using the recommended level 1 multicast settings. However, clients can be customized to search using other settings. For more information about how to perform this customization, see Configure the SAS Forecast Server Clients to Use a Customized Port for Multicast.

4. Click **Log On** to start SAS Forecast Studio.
You can modify the .ini files used by the SAS Forecast Server clients to define the sas.apcore.logon.netaid.multicast.servers system property where the Netaid Discovery Server that is used by the SAS Analytics Platform server is listening for requests. Defining this property overrides the port that is used by the discovery feature. Note that you cannot customize the server address. The SAS Analytics Platform server always uses 239.192.65.80.

To configure the SAS Forecast Server clients to use a customized port:

1. Open the forecaststdo.ini file in a text editor. For example, in a default Windows installation, this file is located in the C:\Program Files\SAS\SASForecastStudio\3.1 directory. This file is used by SAS Forecast Studio.

2. Open the sasmc.ini file in a text editor. For example, in a default Windows installation, this file is located in the C:\Program Files\SAS\SASManagementConsole\9.2 directory. This file is used by the SAS Forecast Server Plug-in for SAS Management Console.

3. In each of the .ini files, type a new JavaArgs_ entry, where  is the number of the next argument in the list. Increment the argument number accordingly. For example, type the following:

   `JavaArgs_14=-Dsas.apcore.logon.netaid.multicast.servers=239.192.65.80:6452`

To specify more than one port, separate the multicast group addresses and ports with a comma. To avoid errors in the line processing, ensure that all information appears on a single line that contains no spaces or tabs. For example, the following setting would find all servers that are configured to respond to discovery requests on either port 6452 or 6453:

   `JavaArgs_14=-Dsas.apcore.logon.netaid.multicast.servers=239.192.65.80:6452,239.192.65.80:6453`

### Using Java Web Start


You can use Java Web Start in one of two ways:

- **Launch SAS Forecast Studio from the SAS Analytics Platform server Status Web page.**

  The SAS Analytics Platform server has a status and configuration Web page that is installed on the SAS Forecast Server middle tier. The SAS Analytics Platform server contains an HTTP server, which is used to deliver the Web pages that contain links to Java Web Start at http://your-server-name:6401.

  **NOTE:** The port value that is documented in this section reflects a default level-1 configuration (6401) for the SAS Analytics Platform server. If you installed the SAS Analytics Platform server using a different port, then you must specify the port number that you used.
From the **Welcome** page, select the **Configuration** tab to view the SAS Analytics Platform server configuration details and any other applications configured on the server. To launch a configured application, click **Launch** from the Applications tab.

- Launch SAS Forecast Studio from a direct link to the SAS Forecast Server Java Web Start.

  You can launch SAS Forecast Studio from http://your-server-name:6401/Forecasting/main.jnlp.


For information about Java Web Start and SAS applications, see the *SAS Analytics Platform server Administrator’s Guide* at [http://support.sas.com/documentation](http://support.sas.com/documentation).

For information about troubleshooting SAS Forecast Studio and Java Web Start, see Chapter 13, “Troubleshooting SAS Forecast Server.”

---

### Starting SAS Forecast Studio with Options

#### Specify the Number of Observations to Use to Detect the Time Interval

You can specify the number of observations from the input data set that SAS Forecast Studio uses to detect the time interval. By default, SAS Forecast Studio uses 10,000 observations to detect the time interval. Usually, a few distinct time ID values are needed to detect the interval. However, data sets with many repeated values of the time ID variable sometimes require a larger sample to get enough distinct values. Increasing the number of observations might improve time interval detection when you are using data sets that contain many repeated values. Values of 100,000 and larger could cause noticeably slower performance when you are creating a new project.

To configure SAS Forecast Studio to use a customized time interval value:

1. Open the forecaststdo.ini file in a text editor. For example, in a default Windows installation, this file is located in the C:\Program Files\SAS\SASForecastStudio\3.1 directory.
2. In the .ini file, type a new `JavaArgs_n` entry, where `n` is the number of the next argument in the list. Increment the argument number accordingly. For example, type the following:

   `JavaArgs_14=-Dcom.sas.analytics.forecasting.interval_sample=50000`

#### Specify the Sample Size for Validating BY Variable Values and Formats

When you start SAS Forecast Studio, you can choose an option that specifies a default value to use for checking the validity of BY variable values and formats. This option applies when you use the new project wizard to save a project’s code without running it.
The default value for the sample size is 50000. When you specify a value \( n \) for this property, then the first \( n \) observations of the data set are used to check for the following:

- Is any numeric BY variable continuous-valued?
- Does any BY variable have a format that maps more than one raw value to the same formatted value?

If the answer to either question is yes, then an appropriate error dialog displays, and the project is not created or saved.

To configure SAS Forecast Studio to use a sample size other than 50000 to validate BY variable values and formats:

1. Open the forecaststdo.ini file in a text editor. For example, in a default Windows installation, this file is located in the C:\Program Files\SAS\SASForecastStudio\3.1 directory.

2. In the .ini file, type a new JavaArgs\_n entry, where \( n \) is the number of the next argument in the list. Increment the argument number accordingly. For example, type the following:

   \[
   \text{JavaArgs}_{14} = -D\text{com.sas.analytics.forecasting.by\_validation\_sample}=75000
   \]
Part IV

Administration and Troubleshooting
Chapter 9
Security Administration Tasks

Contents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabling Users to Access the SAS Forecast Server</td>
<td>89</td>
</tr>
<tr>
<td>Authentication versus Authorization</td>
<td>89</td>
</tr>
<tr>
<td>Initial Authentication</td>
<td>90</td>
</tr>
<tr>
<td>Initial Users</td>
<td>90</td>
</tr>
<tr>
<td>Define Additional Users</td>
<td>91</td>
</tr>
<tr>
<td>Configure a Product Administrator in the SAS Forecast Server</td>
<td>92</td>
</tr>
<tr>
<td>Understanding the Trusted Metadata User</td>
<td>92</td>
</tr>
<tr>
<td>Project Owners</td>
<td>93</td>
</tr>
<tr>
<td>Securing Access to the SAS Forecast Server</td>
<td>94</td>
</tr>
<tr>
<td>Security Layers</td>
<td>94</td>
</tr>
<tr>
<td>Notes Regarding Permissions</td>
<td>94</td>
</tr>
<tr>
<td>Environment Permissions</td>
<td>95</td>
</tr>
<tr>
<td>Project Permissions</td>
<td>97</td>
</tr>
<tr>
<td>Group Sharing Options for Projects</td>
<td>98</td>
</tr>
<tr>
<td>Configuring Library Permissions</td>
<td>99</td>
</tr>
<tr>
<td>Table Permissions</td>
<td>100</td>
</tr>
<tr>
<td>Configure Column Permissions</td>
<td>101</td>
</tr>
<tr>
<td>Configuring Report Permissions</td>
<td>101</td>
</tr>
</tbody>
</table>

Enabling Users to Access the SAS Forecast Server

Authentication versus Authorization

Before learning about authorizations within the SAS Forecast Server, you first need to understand the difference between user authentication and user authorization.

- User authentication is an identity verification process that attempts to determine whether users are who they say they are.
Chapter 9: Security Administration Tasks

- User authorization is the process of determining which authenticated users have which permissions for which resources. User authorization happens after user authentication.

For more information about the SAS security scheme, see the security section of the SAS Intelligence Platform documentation at http://support.sas.com/documentation.

---

### Initial Authentication

Initial authentication is the verification of your identity based on information that you provide when you log on to the SAS Forecast Server. Initial authentication requires that you have an account with the authentication provider. The provider verifies the user name and password that you use to log on. The account with the authentication provider can be any of the following:

- a local user account in the operating system of the computer on which the authenticating server is running
- a network user account that provides access to the operating system of the computer on which the authenticating server is running
- a user account with any authentication provider that your Web application server uses (for applications that are configured to use Web authentication)

After the user name and password are verified by the appropriate authentication provider, the proof-of-identity is complete. None of the user information that is stored in the metadata repository is used to prove your identity. The SAS Metadata Server uses your metadata identity for the following reasons:

- To provide authorization decisions and credential management, the SAS Metadata Server needs to know who you are.
- The SAS Forecast Server has an additional requirement beyond proof-of-identity: the user must have a metadata identity.

To discover your metadata identity, the SAS Metadata Server examines the user IDs that are stored in the metadata repository. Passwords that are stored in the metadata repository are not examined at any point during initial authentication.

---

### Initial Users

After you install and configure the SAS Intelligence Platform, the SAS Analytics Platform server, and the SAS Forecast Server, standard user and group definitions are added. Figure 9.1 shows these users and groups as they appear in the User Manager plug-in of SAS Management Console.
Define Additional Users

If you want to create a new user for SAS Forecast Studio, then you must define the user ID on the authentication provider and then associate it with a metadata identity by using the User Manager plug-in. You use the same process to define additional user groups.

To define a new user or group:

1. Start SAS Management Console, and connect to a metadata repository as an administrator (for example, sasadm).

2. In the navigation tree, right-click User Manager and select New → User (or Group if you are defining a new group of users). The Properties dialog box opens.

For more information about how to define users and groups in SAS Management Console, see the SAS Management Console documentation at [http://support.sas.com/documentation](http://support.sas.com/documentation).

3. Associate this metadata identity with a specific account that is valid on the metadata server. By default, the SAS Metadata Server uses the operating system’s host-based authentication. The SAS Metadata Server requires a user ID and password that is valid on the host operating system of the SAS Metadata Server.

To associate a metadata identity with a user ID:
a) In the New User wizard, select the **Accounts** tab and then click **New**.
b) In the dialog box, enter the user ID that you plan to use to log on to the SAS Metadata Server.

**NOTE:** A password is not required.

For more information about planning and defining new users and groups, see the security section of the SAS Intelligence Platform documentation at [http://support.sas.com/documentation](http://support.sas.com/documentation).

---

### Configure a Product Administrator in the SAS Forecast Server

A product administrator in the SAS Forecast Server can modify any project or environment setting. Additionally, product administrators can use the SAS Forecast Server Plug-in for SAS Management Console to perform special administrative actions that are not available in SAS Forecast Studio. This user must be authenticated by the metadata server’s host.

For information about configuring a SAS Forecast Server product administrator, see “**Configure the SAS Forecast Server Product Administrator**.”

---

### Understanding the Trusted Metadata User

#### What Is the Trusted Metadata User?

Since the application often needs access to data beyond that allowed for the current user, the product uses an internal SAS Metadata Server connection that is assumed to be unrestricted with respect to what the product needs to access. The SAS Forecast Server uses the trusted metadata user that is called the SAS Trusted User (sastrust@saspw) for this access. During deployment, this user is granted permissions to the `/System/Applications/SAS Forecast Server` metadata folder.

In addition to enabling more functionality in the product, this connection is often used to perform updates to metadata to reduce the risk of accidental corruption of the metadata.

If you create other metadata folders outside of the `/System/Applications/SAS Forecast Server` metadata folder, you must also grant the SAS Trusted User permissions on these folders. This requirement most often arises when you create a folder to manage the report metadata objects.

#### Configure User Permissions for the SAS Trusted User

To grant the SAS Trusted User permissions outside of the `/System/Applications/SAS Forecast Server` metadata folder:
1. Open SAS Management Console, and log on as the SAS Administrator (for example, sasadm@saspw).

2. Select the Folders tab.

3. Locate the metadata folder that you created outside of the /System/Applications/SAS Forecast Server metadata folder. For example, you might create a Reports metadata folder under /Shared Data/Forecast Server 3.1 to organize reports that you use in the product.

4. Right-click on the folder, and then select Properties. For example, right-click on the /Shared Data/Forecast Server 3.1 metadata folder. The Properties dialog box opens.

5. Select the Authorization tab.

6. In the Users and Groups area, click Add. The Add Users and Groups dialog box opens.

7. In the Available Identities list, double-click on the SAS Trusted User. The SAS Trusted User is added to the Selected Identities list. Click OK.

8. In the Users and Groups area, select SAS Trusted User.

9. Grant the ReadMetadata, WriteMetadata, WriteMemberMetadata, CheckinMetadata, and Administer permissions for the SAS Trusted User, and then click OK.

NOTE: Depending on your site’s security requirements, you might want to add the SAS Trusted User to the SAS Administrators group. This action makes all of the metadata accessible from the trusted account. However, such open security might not be desirable at some sites.

---

**Project Owners**

**What Is a Project Owner?**

The user who creates a project in SAS Forecast Studio is the de facto administrator for that project. Such users are referred to as project owners. Project owners have access to special actions that include the ability to change project-sharing settings and the ability to delete the project. You can transfer project ownership to other users by using either the SAS Forecast Server Plug-in for SAS Management Console or the FSSETOWN macro. A project can have only one owner.

**How to Change Project Ownership**

To change project ownership using the SAS Forecast Server Plug-in for SAS Management Console:

1. Open SAS Management Console, and log on as the SAS Administrator (for example, sasadm@saspw).
2. Select the **Forecast Server** node on the **Plug-ins** tab.

3. If you are not already logged on to the SAS Analytics Platform server, the Log On dialog box opens. Log on to the SAS Analytics Platform server as a product administrator.

4. Expand the environment node that contains the project of interest.

5. Expand the **Projects** node.

6. Right-click on the desired project, and then select **Properties**. The Project Properties dialog box opens.

7. Type the new user name in the **Owner** text box, and then click **OK**.

For more information about changing project ownership using the FSSETOWN macro, see the section “**FSSETOWN Macro: Assign the Owner of a Project**.”

**NOTE:** You can also use the Access Settings batch operation to set the same owner on multiple projects. This feature is available in the SAS Forecast Server Plug-in for SAS Management Console. Right-click on the environment node, and select **Batch Operations** → **Access Settings**. For more information, see the Help for the SAS Forecast Server Plug-in for SAS Management Console.

---

**Securing Access to the SAS Forecast Server**

**Security Layers**

Security settings in the SAS Forecast Server are implemented in three layers:

- Metadata - enforced by the SAS Metadata Server
- Application - enforced by the product
- File System - enforced by the operating system

Typically, permissions are checked in the order listed. For example, metadata permissions are applied first while file system permissions are checked last.

**Notes Regarding Permissions**
File System Permissions

It is recommended that you use the metadata and application layers when you define your security strategy. Typically, file system permissions are not checked before an operation is attempted in the product.

**NOTE:** Securing content only through the use of file system permissions is not recommended.

WriteMetadata Permissions

The metadata security in the SAS Forecast Server is limited to controlling the visibility of content by using the ReadMetadata permission. However, the WriteMetadata permission is automatically checked by the SAS Metadata Server when a client attempts to update the state of a metadata object. The product cannot prevent this check as it is built into the SAS Intelligence Platform framework. Using the WriteMetadata permission is not a recommended method for limiting a user’s access level to the content.

**WARNING:** Securing metadata content as read-only through the use of the WriteMetadata permission can corrupt the content by preventing necessary updates. The SAS Forecast Server does not support read-only access to content.

What Permissions Can You Control by Using Metadata?

To secure access to metadata objects that represent the SAS Forecast Server data, you can grant or deny permissions to individuals or groups by using the **Authorization** tab in SAS Management Console for the following metadata objects:

- environments
- projects
- libraries
- tables that are registered to libraries
- columns in registered tables
- reports

Environment Permissions

What Are Environments?

An environment enables you to group projects together into workspaces. It is defined by the following basic attributes:
Chapter 9: Security Administration Tasks

- logical name
- host workspace server
- content path on the server

An environment defines each of the following:

- a container for projects
- a workspace for users
- a partition of a workspace server

An environment is implemented as a metadata folder, metadata object, and directory structure (in the server’s file system). Only metadata and file system permissions apply to these structures. To support the group-sharing policy on projects, you should configure the directory tree that is associated with the environment full control to all users that are allowed to access the environment. Note that this configuration relies on the metadata settings to secure the environment.

In addition, setting the ReadMetadata permission at the environment level grants or denies user permissions to see the projects and reports associated with that environment. When a user logs on to SAS Forecast Studio, environments to which a user does not have access do not appear as options. Therefore, the environment’s content is not readable.

**NOTE:** Each file system location in a workspace server should be used by only one environment system-wide, regardless of the number of environments or middle tiers in the system. In general, the file system location that is specified for the environment and its subdirectories should be reserved for that environment only. This restriction ensures the integrity of the file system content and to properly coordinate accesses by clients.

You can create and configure environments in SAS Management Console by using the SAS Forecast Server Plug-in for SAS Management Console. For more information, see “Create an Environment.” You can also create environments by using the FSNEWENV macro. For more information, see “FSNEWENV Macro: Create a New SAS Forecast Server Environment.”

For more information about the environment operations provided in SAS Management Console, see the Help for the SAS Forecast Server Plug-in for SAS Management Console.

**Configure Environment Permissions**

To configure environment metadata-object permissions:

1. In the file system, grant full control on the environment directory tree to all environment users or user groups. For easier management, a user group is recommended.

2. Open SAS Management Console, and log on as the SAS Administrator (for example, sasadm@saspw).
3. Select the **Folders** tab.

4. Expand the **System, Applications, SAS Forecast Server, SAS Forecast Server 3.1, and Environments** folders.

5. Right-click on one of your environment folders and then select **Properties**. The environment Properties dialog box opens.

6. Select the **Authorization** tab.

7. Select your user (or a group of users) in the **Users and Groups** area.  
   **NOTE:** If the user or group is not shown, click **Add**.

8. Set the **ReadMetadata** permission for your user or group and then click **OK**.

---

**Project Permissions**

**About Project Permissions**

Projects are similar to environments in physical structure, with file content being nested within the associated environment’s directory structure. No additional effort is required for file system security beyond what is needed for the environment.

If desired, you can set the ReadMetadata permission on each project object to control that project’s visibility to users.

**Configure Project Permissions**

To configure project metadata object permissions:

1. Open SAS Management Console, and log on as the SAS Administrator (for example, sasadm).

2. Select the **Folders** tab.

3. Expand the **System, Applications, SAS Forecast Server, SAS Forecast Server 3.1, and Environments** folders.

4. Select one of your environment folders.

5. Right-click on a project, and then select **Properties**. The project Properties dialog box opens.

6. Select the **Authorization** tab.

7. Select your user (or a group of users) in the **Users and Groups** area.  
   **NOTE:** If the user or group is not shown, you can add it by clicking **Add**.

8. Set the **ReadMetadata** permission for your user or group, and then click **OK**.
Group Sharing Options for Projects

About Group Sharing

The ReadMetadata permission controls the project’s visibility to users. In addition to the ReadMetadata permission that you can set for a project, you can configure a project to use a group-sharing policy. If you do not specify the group sharing policy, then only the user who created the project can open it. Enabling project sharing means that all users that can access the environment can view and edit the project. You can configure this permission when creating a project in SAS Forecast Studio or by updating the project properties.

**NOTE:** You can modify this setting only for projects created with the current version of the application. You can use the update batch operation to update multiple projects to use the current version. In the SAS Forecast Server Plug-in for SAS Management Console, right-click on the environment node, and select **Batch Operations → Update.** You can perform an update for single projects. For more information about the update operations, see the Help for the SAS Forecast Server Plug-in for SAS Management Console.

Configure Group-Sharing Permissions for a Project

To enable group sharing for a project in the SAS Forecast Server Plug-in for SAS Management Console:

1. Open SAS Management Console, and log on as the SAS Administrator (for example, sasadm@saspw).
2. Expand the **Forecast Server** and an environment node.
3. Right-click on a project and then select **Properties.** The project Properties dialog box opens.
4. Select **Allow others to view and edit this project,** and then click **OK.**

To enable group sharing when creating a new project in SAS Forecast Studio:

1. Open SAS Forecast Studio.
2. Click **New** in the Projects dialog box.
3. In the first screen of the New Project wizard, select **Allow others to view and edit this project.**
4. Proceed with the remaining steps in the wizard to create the new project.

To change project group-sharing permissions in SAS Forecast Studio:

1. Open SAS Forecast Studio.
2. Open the project.
4. Select Allow others to view and edit this project, and then click OK.

---

**Configuring Library Permissions**

**About Preassigned and Manually Registered Libraries**

Both preassigned and manually registered metadata libraries are supported by the product. By default, preassigned libraries expose all of the library contents. However, libraries that you manually register in SAS Management Console require that you explicitly grant access. In both types of libraries, when you need to grant access to a specific data set or variable in a data set for the library, you must register the library in SAS Management Console first.

**The ReadMetadata Permission and Permissions Checking**

Whenever the product needs to perform a permissions check on a variable object, data set object, or a folder object, the SAS Forecast Server checks the permissions hierarchically. If the object cannot be found, then the product instead uses the parent object for the permissions check. If that object cannot be found, then its parent object is used, and so on. The ReadMetadata permission can effectively hide metadata objects from the user. For permissions to work as expected, the user must have the ReadMetadata permission granted on the metadata object so that the product can check those permissions. The product assumes the following parent structure when checking permissions:

1. SAS Workspace Server object (top)
2. folder object
3. table object
4. column object (bottom)

**NOTE:** Permission checks are performed only for elements that are already visible to the user.

**Permissions for Library Objects**

In most cases, you register several data sets in a library. These permissions do the following:

- **ReadMetadata** - controls the visibility of the library anywhere in the client. This permission is enforced by the SAS Forecast Server middle tier.
- **Read** - controls the user’s ability to read the contents of a library. This permission is enforced by the SAS Forecast Server middle tier.
- Write - controls the user’s ability to write to a library. This permission is enforced by the client.

**Configure Library Object Permissions**

To configure permissions for a library object:

1. Open SAS Management Console, and log on as the SAS Administrator (for example, sasadm).
2. Expand the **Data library manager** and **Libraries** nodes.
3. Right-click on the library object that you want to grant permissions for, and then select **Properties**.
4. Select the **Authorization** tab.
5. Select your user (or a group of users) in the **Users and Groups** area.
   **NOTE:** If the user or group is not shown, click **Add**.
6. Select the **Read**, **ReadMetadata**, and **Write** permissions for your user or group, and then click **OK**.

When you register more data sets in the library, the user or group that you configured automatically has access to them.

**NOTE:** A manually registered library is not available in the product unless the user has the Read permission assigned to that library. Preassigned libraries will still appear under these conditions, but they will appear empty.

---

**Table Permissions**

**About Table Permissions**

Manually registered table objects are associated with physical data sets. When you manually register a table, you can grant the Read and Write permissions on the table object for your user or a group of users. These permissions will override those of the library object. These permissions do the following:

- Read - controls the user’s ability to select and use the associated data set in the client.
- Write - controls the user’s ability to modify the associated data set in the client.
Configure Table Permissions

To grant permissions to a table in a registered library:

1. Right-click on the table, and then select Properties. The Properties dialog box opens.
2. Select the Authorization tab.
3. Select your user (or a group of users) in the Users and Groups area.
   
   **NOTE:** If the user or group is not shown, click Add.
4. Grant the Read and Write permissions for your user or group and then click OK.

Configure Column Permissions

In some cases, you might want your user to have access to a data set; however, you might not want the user to see certain variables in the data set. When you deny the Read permission on a column object in a manually registered table, the user cannot select or use the associated variable in the client.

To restrict a user from using a specific variables in a data set:

1. Right-click the table, and then select Properties.
2. Select the Columns tab.
3. Right-click on the column object that you wish to hide and then select Authorization. The Authorization dialog box opens for the selected variable.
4. Select your user (or a group of users) in the Users and Groups area.
   
   **NOTE:** If the user or group is not shown, click Add.
5. Deny the Read permission for your user or group, and then click OK.
6. Click OK to save the changes.

Configuring Report Permissions

Reports are implemented as stored process objects in metadata. The associated source code files for the stored processes reside in the file system on the SAS Workspace Server. Minimal security is applied to reports. Users that can see the report in the client can generally do anything that the product supports. Users can see and use reports when the ReadMetadata permission is granted on the associated stored process metadata object. For more information about configuring report permissions, see “Setting Permissions for Reports.” For more information about configuring reports for use in SAS Forecast Studio see “Report Administration Tasks.”
Chapter 10
Report Administration Tasks

Contents

What Is a Stored Process? 103
What Is a Report? 104
Enabling Reports in the SAS Forecast Server 104
   Create a Report Metadata Folder 104
   Configure the Report Metadata Folder for the Environment 105
   Setting Permissions for Reports 105
Using the Sample Reports 106
   What Are Sample Reports? 106
   Deploy the Sample Reports 106
   Remove the Sample Reports 107
   Delete Unused Metadata Folders in the Reports Tree 107
Using Reports in SAS Forecast Studio 107
   About Managing Reports 107
   Access the Reports in SAS Forecast Studio 110
   Generate a Report 111
   About the Output Format and Style of Reports 111
   Control the Output Format and Style of Custom Reports 111
Registering Custom Reports 112
   Requirements for Registering a Report 112
   Preregistration Tasks 112
   Register the Report with SAS Management Console 113
   Report Execution Constraints 114
Creating Custom Reports 115
   Report Parameters 115
   Using Special Features in Reports 128
   Required Macro Calls 129
   Keywords Used in Reports 129

What Is a Stored Process?

A stored process is a SAS program that is stored centrally on a server. A client application can then execute the program, and can receive and process the results. Stored processes enable you
to maintain and manage code centrally, give you better control over changes, enhance security and application integrity, and ensure that every client executes the latest version of code that is available.

Stored processes are like other SAS programs, except that they have an additional feature that enables you to customize the program’s execution. This feature enables the invoking application to supply parameters at the time that the stored process is invoked. For example, if you have a stored process that analyzes monthly sales data, you could create a MONTH variable in the stored process. At execution time, you would supply the parameter MONTH=MAY to analyze May sales data. For more information about how to create a stored process and to invoke it in a client application, see the SAS 9.2 Stored Processes: Developer’s Guide at http://support.sas.com/documentation.

Stored processes consist of two distinct parts: the SAS code and the stored process definition that resides on a metadata server.

What Is a Report?

The SAS Forecast Server supports access to project information through special stored processes, generally called reports. Reports provide a mechanism for you to extend the capabilities of the product so that you can perform site-specific custom operations. A report is written in the SAS programming language. It encapsulates custom logic and when it is executed, it receives information about the run-time state in SAS Forecast Studio. This information enables the report to know what the user is looking at, and consequently what data to use during its operation.

Enabling Reports in the SAS Forecast Server

Create a Report Metadata Folder

At a minimum, you must create one report metadata folder and configure your environment to use this metadata folder location. The report folder that you specify for your environment is mirrored in the Reports and Stored Processes dialog box in SAS Forecast Studio.

To create a report metadata folder:

1. Open SAS Management Console and connect to a metadata repository as an administrator (for example, sasadm@saspw).
2. Select the Folders tab.
3. Right-click a folder, and select New Folder.
4. Type a name for the new folder.
5. Type an optional description for the new folder, and then click **Finish**.

---

**Configure the Report Metadata Folder for the Environment**

Reports are managed for each environment. Each environment independently indicates the metadata folder (for example, SAS Folders) that is the root of its reports tree.

Before you use any reports in SAS Forecast Studio, you must let the environment know where your reports metadata folder is located. You can configure this in the environment’s properties dialog box.

**NOTE:** You must grant full control to all environment users in the file system and control visibility to the environment using the ReadMetadata permission on the environment metadata object. Without this permission granted, the reports do not display in SAS Forecast Studio. For more information, see “Environment Permissions.”

To configure the report metadata folder for an environment:

1. In SAS Management Console, select the **Plug-ins** tab and expand the **Forecast Server** node.
2. If you are not already logged on to the SAS Analytics Platform server, the Log On dialog box opens. Log on to the SAS Analytics Platform server.
3. Right-click on the desired environment node, and then select **Properties**. The Properties dialog box opens.
   **NOTE:** For more information about the environment Properties dialog box, see the Help for the SAS Forecast Server Plug-in for SAS Management Console.
4. In the **Reports folder** field, type the path to your reports metadata folder, or click **Browse**.
5. Click **OK**.

---

**Setting Permissions for Reports**

**Configure Additional User Permissions on the Report Metadata Folder**

Reports are implemented as stored process objects in metadata. The associated source code files for the stored processes reside in the file system on the SAS Workspace Server. Minimal security is applied to reports. Users that can see the report in the client can do anything that the product supports with it. The ReadMetadata permission is required for a user to see the report in SAS Forecast Studio. Without this permission granted, the product does not display the report in the Reports and Stored Processes dialog box that makes the report available to the user.

**NOTE:** Permissions that you assign at the root folder level propagate to the root folder’s subfolders.
To grant permissions to the report metadata folder:

1. In the SAS Management Console Folders tab, right-click your root reports folder, and then select Properties. The Properties dialog box opens.
2. Select the Authorization tab.
3. Select your user (or a group of users) in the Users and Groups area.
   **NOTE:** If the user or group is not shown, click Add.
4. Grant the ReadMetadata permissions for your user or group, and then click OK.

**Grant User Permissions to the SAS Trusted User**

You must grant the SAS Trusted User full metadata permissions (ReadMetadata, WriteMetadata, WriteMemberMetadata) on all reports folders. For more information, see “Understanding the Trusted Metadata User.”

**Using the Sample Reports**

**What Are Sample Reports?**

Sample reports are shipped with the product. The reports are not available for use in the Reports and Stored Processes dialog box until you deploy them using the SAS Forecast Server Plug-in for SAS Management Console. For a list and description of the sample reports, see the SAS Forecast Server User’s Guide.

**Deploy the Sample Reports**

To deploy the sample reports:

1. Create a metadata folder to store your report objects. For more information, see “Create a Report Metadata Folder.”
2. Grant all permissions on the folder to the SAS trusted user. For more information, see “Grant User Permissions to the SAS Trusted User.”
3. Configure the user permissions on the report folder. For more information, see “Configure Additional User Permissions on the Report Metadata Folder.”
4. Designate a root report folder for the environment. For more information, see “Configure the Report Metadata Folder for the Environment.”
5. Select the SAS Management Console Plug-ins tab.
6. Expand the Forecast Studio node. If necessary, log on to the SAS Analytics Platform server.
7. Expand the environment node where you want to deploy the sample reports.
8. Right-click the Reports node, and select Deploy Samples.

Remove the Sample Reports

To remove all sample reports in the current environment’s report tree:

1. Select the SAS Management Console Plug-ins tab.
2. Expand the Forecast Studio node. If necessary, log on to the SAS Analytics Platform server.
3. Expand the environment node where you want to remove the sample reports.
4. Right-click the Reports node, and select Remove Samples.

Delete Unused Metadata Folders in the Reports Tree

To remove all unused (empty) metadata folders in the current environment’s report tree:

1. Select the SAS Management Console Plug-ins tab.
2. Expand the Forecast Studio node. If necessary, log on to the SAS Analytics Platform server.
3. Expand the environment node where you want to remove any unused report metadata folders.
4. Right-click the Reports node, and select Prune.

NOTE: The Reports node does not appear under an environment node until the report tree is configured. For more information, see “Configure the Report Metadata Folder for the Environment.”

Using Reports in SAS Forecast Studio

About Managing Reports

Reports are managed for each environment. Each environment independently indicates the metadata folder (for example, SAS Folders) that is the root of its reports tree.
For example, suppose that you configure your environment to use the `/Shared Data/Forecasting Reports/Dev Reports` metadata folder as shown in Figure 10.1.

**Figure 10.1** Configuring the Environment’s Root Report Metadata Folder

Additionally, suppose that you create the **My Report** stored process metadata object at the metadata folder location `/Shared Data/Forecasting Reports/Dev Reports/Examples` as shown in Figure 10.2.
In this example, My Report displays under the Reports/Examples node in the Reports and Stored Processes dialog box as shown in Figure 10.3.

Note that the Reports node at the top of the hierarchy represents the root folder that was configured in the metadata. Note also that the root report metadata folder path that was configured for the environment is not explicitly identified in the Reports and Stored Processes dialog box.

Accordingly, before you register a report for use in SAS Forecast Studio, you must let the environment know where your reports metadata folder is located. You can configure the location for the reports metadata folder in the environment’s properties dialog box. For more information, see “Configure the Report Metadata Folder for the Environment.”

NOTE: You must grant full control to all environment users in the file system and control visibility
to the environment by using the ReadMetadata permission on the environment metadata object. Without this permission granted, the reports do not display in SAS Forecast Studio. For more information, see “Configure Environment Permissions.”

Access the Reports in SAS Forecast Studio

You can access and execute reports when you have a project open in SAS Forecast Studio by selecting Tools → Reports and Stored Processes. Figure 10.4 shows an example of the Reports and Stored Processes dialog box in SAS Forecast Studio.

Figure 10.4 SAS Forecast Studio Reports and Stored Processes Dialog Box

The reports shown in SAS Forecast Studio are filtered based on the ReadMetadata permission, use of the FS_REPORT keyword, and the execution SAS Workspace Server. For more information about permission settings for reports, see “Configure Additional User Permissions on the Report Metadata Folder.” You can use reports only with projects that reside on the same SAS Workspace Server. For more information about report keywords, see “Keywords Used in Reports.”

When you execute a report from within SAS Forecast Studio, the data and forecasts from the current project are passed to the stored process. For more information about the macro variables that are passed to the stored process, see “Predefined Macro Variables to Use with Stored Processes.”
Generate a Report

For more information about generating reports, see “Generating a Report” in the *SAS Forecast Server User’s Guide*.

About the Output Format and Style of Reports

You can select the output format and style by using controls that are provided in the Reports and Stored Processes dialog box in SAS Forecast Studio.

The output control is based on the ODS component in Base SAS. For more information about ODS, see the *SAS Output Delivery System: User’s Guide* for Base SAS at [http://support.sas.com/documentation](http://support.sas.com/documentation).

The local operating system’s configuration determines which application opens the report results based on the extension of the generated output file. For example, the RTF output setting produces a file with an .rtf extension. If you have registered RTF files to open with Microsoft Word in your operating system, then Microsoft Word automatically launches to show the report output whenever the RTF output format is selected. If a file extension is not registered with the operating system, then the report does not automatically open.

Control the Output Format and Style of Custom Reports

To control the output format and style of a report:

1. Start SAS Forecast Studio, and then open a project.
2. Select **Tools → Reports and Stored Processes**. The Reports and Stored Processes dialog box opens.
3. Select a report.
4. Select a format and style.
   
   **NOTE:** You can manually type other values in the **Format** and **Style** fields. These fields are populated with the most frequently used options.
5. Click **Run**.

**NOTE:** Because format control is available in the Reports and Stored Processes dialog box, the Excel sample reports from previous releases are no longer provided. You can specify to output any report in XLS format without the need for special versions of the report code.
Registering Custom Reports

Requirements for Registering a Report

For information about the basic processes and terminology that are related to using stored processes in the SAS BI Server, see the SAS 9.2 Stored Processes: Developer’s Guide at http://support.sas.com/documentation.

NOTE: Before you alter any existing stored processes, it is recommended that you make a copy of the stored process metadata object and its associated source code file.

Before you register a report, at a minimum you must do the following using SAS Management Console:

1. Create a metadata folder to store your report objects. For more information, see “Create a Report Metadata Folder.”
2. Write the code for the report. For more information, see “Creating Custom Reports.”
3. Set permissions on the report metadata folder so that users can access it in SAS Forecast Studio. For more information, see “Setting Permissions for Reports.”
4. Configure your environment to use the reports metadata folder. For more information, see “Configure the Report Metadata Folder for the Environment.”
5. Create a stored process metadata object. For more information, see “Register the Report with SAS Management Console.”

Preregistration Tasks

The following tasks enable you to gather the information that you need to register a report using SAS Management Console. For more information, see “Register the Report with SAS Management Console.”

To prepare for report registration:

1. Locate the source code for the report in the server file system and its source filename. For example, suppose that you want to display a new report in SAS Forecast Studio that you have saved as example.sas in the C:\MyStoredProcesses directory in your file system. The source repository location is C:\MyStoredProcesses, and the source filename is example.sas. Note that this file system location must be on the same physical machine that hosts the corresponding project files for the SAS Forecast Server. This ensures that the project data is accessible to the stored process when it executes.
2. Plan the organization of your report hierarchy. If you want to display the report under its own folder group in the Reports and Stored Processes dialog box in SAS Forecast Studio, then you can create this hierarchy in the metadata using SAS Management Console. The Reports node in the dialog box corresponds to the reports root folder that you configured for that environment in SAS Management Console. The expandable nodes in the dialog box correspond to subfolders that you create under the root folder. For example, you can specify that a My Reports folder displays in the Reports and Stored Processes dialog box under the Reports tree by creating a subfolder with that name within the root folder. Figure 10.5 shows how such a custom folder structure would appear.

Figure 10.5 Example Report Hierarchy

For more information about creating metadata folders, see the documentation for SAS Management Console at http://support.sas.com/documentation.

3. Select a name for the report. The report name that you specify in SAS Management Console is the metadata object name. This report name displays in the Reports and Stored Processes dialog box in SAS Forecast Studio. For example, if you name the report My Example Report in SAS Management Console, then the Reports and Stored Processes dialog box displays the name, My Example Report. Figure 10.6 shows an example folder structure that uses the My Reports subfolder that contains the My Example Report.

Figure 10.6 Report Hierarchy with an Example Report

Register the Report with SAS Management Console

To complete the definition of a custom report for use in the SAS Forecast Server, you must register the report (stored process) by creating a stored process metadata object.
To register the report in SAS Management Console:

1. Open SAS Management Console and connect to a metadata repository as an administrator (for example, sasadm).

2. Select the Folders tab.

3. Select your reports folder. In this example, we used the Shared Data and the Reports folders.

4. Right-click the My Reports folder, and then select New Stored Process.

5. Type the name of your SAS program, My Example Report, and an optional description.

6. In the Keywords section, click Add. The Add Keyword dialog box opens.

7. Type FS_REPORT, and then click OK. Click Next.

   **NOTE:** For more information about keywords, see “Keywords Used in Reports.”

8. Set the SAS server option to the SAS Workspace Server that hosts the project files.

   **NOTE:** It is important that the execution server for the stored process is set to the SAS Workspace Server that hosts the projects that use this report. It is equally important that the .sas source file for the stored process is located in the file system of this same server.

9. Select the directory where you saved your SAS code (in this example, C:\MyStoredProcesses) as the Source code repository. If your directory does not appear in the list of options, complete these steps:

   a) Click Manage.
   
   b) Click Add.
   
   c) Enter C:\MyStoredProcesses as the location and an optional description.
   
   d) Click OK.
   
   e) Click OK again.

10. Complete the remaining fields by entering the name of your SAS program, example.sas, as the source file, and then selecting Package as the output type. Click Next.

11. Click Finish in the Parameters panel.

   **NOTE:** Defining parameters is beyond the scope of this example. For more information about how to create a stored process, see the SAS 9.2 Stored Processes: Developer’s Guide at http://support.sas.com/documentation.

---

**Report Execution Constraints**

While working with custom reports in the SAS Forecast Server, note these constraints:

- The SAS Forecast Server does not currently support the execution of reports using a SAS Stored Process Server.
• Each metadata object is configured to use a specific execution server. When you use multiple SAS Workspace Servers to host projects, you might need to create one metadata object per SAS Workspace Server. Note that you must also copy the source file for the stored process to the file system of each SAS Workspace Server so each metadata object can refer to the source file that is located in its file system.

• The Reports and Stored Processes dialog box in SAS Forecast Studio only lists reports that use the same SAS Workspace Server as the current project. Reports present in metadata but not shown in this dialog box are either not visible to the user (for example, the ReadMetadata permission is not granted), missing the FS_REPORT keyword, or configured to use a different server.

Creating Custom Reports

Report Parameters

Types of Report Parameters

The reports have access to the following types of parameters:

- normal
- dynamic
- internal

What Is a Normal Report Parameter?

A normal report parameter is a stored process parameter that is completely defined in the metadata. Parameters indicating the title to use for the output or a boolean value setting are considered normal parameters. These parameters are created through the usual interfaces for defining stored process parameters, (for example, those provided by SAS Management Console). Beyond avoiding the use of names listed in Table 10.1, there are no constraints on the number or form of these parameters.

What Is a Dynamic Report Parameter?

A dynamic report parameter is one for which you select from options that are provided by the product at run time. Because the options depend on the run-time state, they cannot be defined in the metadata ahead of time. For example, a parameter that allows you to select an independent variable from the current project is a dynamic parameter.
Dynamic parameters require special support from the product to generate the list of available options. They are not extensible. To find dynamic parameters in a report, the product checks for a special prefix in a Text parameter name that matches one of those given in Table 10.1. For more information about how the prefix is located, see “How Are Dynamic Parameters Recognized?” If a match is found, then the corresponding options list is generated and assigned to the parameter before the parameter values are displayed. If a match is not found, then the product assumes that the parameter is a normal parameter and uses it as is.

### Table 10.1 Dynamic Parameter Prefixes

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Elements in Options List</th>
</tr>
</thead>
<tbody>
<tr>
<td>FS_BYVAR</td>
<td>All project BY variables</td>
</tr>
<tr>
<td>FS_CURRENT_BYVAR</td>
<td>BY variables in the selected hierarchy level</td>
</tr>
<tr>
<td>FS_DEPVAR</td>
<td>All project dependent variables</td>
</tr>
<tr>
<td>FS_INDVAR</td>
<td>All project independent variables</td>
</tr>
<tr>
<td>FS_REPORTVAR</td>
<td>All project reporting variables</td>
</tr>
<tr>
<td>FS_EVENT</td>
<td>All project events</td>
</tr>
<tr>
<td>FS_FITSTAT</td>
<td>Statistics of fit</td>
</tr>
<tr>
<td>FS_MODELSTAT</td>
<td>All model statistics</td>
</tr>
<tr>
<td>FS_LIBRARY</td>
<td>Libraries allowing read access</td>
</tr>
<tr>
<td>FS_WLIBRARY</td>
<td>Libraries allowing write access</td>
</tr>
<tr>
<td>FS_OLAPSCHEMA</td>
<td>All OLAP schemas currently defined in metadata</td>
</tr>
</tbody>
</table>

### How Are Dynamic Parameters Recognized?

When locating dynamic parameters, the product does the following:

1. Prefix matching allows multiple variables to use the same dynamic list. For example, FS_INDVAR1 and FS_INDVAR2 both match against FS_INDVAR. Therefore, an independent variable options list would be provided.

2. For efficiency, only prefixes generated by truncating the name at non-letter characters are considered for prefix matching. As such, you should not follow the prefixes shown in Table 10.1 with a letter when selecting a parameter name. For example, FS_INDVAR1S does match against the prefix FS_INDVAR because the name breaks on the letter S. However, the prefixes FS_INDVAR, FS_INDVAR_LIST, and FS_INDVAR1 all match against the FS_INDVAR prefix.

3. If a required parameter has an empty options list, the product detects this and does not execute the report. This prevents the issue of a prompt that cannot be satisfied. For example, you cannot use a required parameter named FS_INDVAR with a project that does not contain independent variables.
What Is an Internal Report Parameter?

To assist you with creating stored processes, the product provides internal parameters, also called predefined macro variables. The internal parameters are automatically defined and populated by the product and do not appear in the metadata definition of the report. These parameters are used to pass state information and instructions to the stored process environment. In particular, they convey information about the project and the location in the hierarchy that you are currently viewing.

**NOTE:** To ensure correct behavior, user-defined parameters should not use the same names as internal parameters. The naming convention used for the sample reports, and generally recommended, is to prefix metadata parameters with FS_. This prevents name collisions since all internal parameters have the HPF_ prefix.

The predefined macro variables that the product uses are grouped into the following categories:

- control macro variables, see Table 10.2
  
  **NOTE:** Direct use of these variables is not recommended. They are automatically or indirectly used through provided macros.

- metadata macro variables, see Table 10.3
  
  **NOTE:** Direct use of these variables is not recommended. They are automatically or indirectly used through provided macros.

- basic project macro variables, see Table 10.4

- data macro variables, see Table 10.5

- diagnose macro variables, see Table 10.6

- model selection macro variables, see Table 10.7

- forecast macro variables, see Table 10.8

- reconciliation macro variables, see Table 10.9

- active series macro variables, see Table 10.10

With the exception of the active series variables, you can use all the other project macro variables outside of the product in SAS programs and stored processes by including the HPF_INCLUDE variable.

The active series macro variables differ from the others in that they depend on the node of the tree (in the forecasting hierarchy) that is currently selected by the user.

By default, the maximum length for a macro variable is 4,096. However, if the number of variables (BY, dependent, independent, reporting, and so on) is very large, you can increase the maximum length for the macro variable to 65,534 by using the MVARSIZE= system option.

**NOTE:** In the following tables that describe the macro variables, the variable names that end with # indicate a sequenced variable. Unless otherwise stated, you can assume that sequencing begins with 1 for these variables. For levels, indexing starts at the top level.
Control Macro Variables

The variables listed in Table 10.2 are used for basic session control.

### Table 10.2 Control Macro Variables

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>HPF_READ_ONLY</td>
<td>Project access Read Only flag</td>
<td>Boolean</td>
</tr>
<tr>
<td></td>
<td>By default, stored processes have Read Only access with respect to the project libraries. This macro variable changes this access to Write. For example, the following SAS code assigns project library names with Read Only access:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>%include &quot;HPF_INCLUDE&quot;;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For example, the following SAS code assigns project library names with Write access:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>%let HPF_READ_ONLY = 0; %include &quot;HPF_INCLUDE&quot;;</td>
<td></td>
</tr>
<tr>
<td>HPF_ODSDEST</td>
<td>Used inside a stored process to control the output destination. By default, HPF_ODSDEST is set to HTML, which means that the output is in HTML format.</td>
<td>ODS destinations</td>
</tr>
<tr>
<td>HPF_ODSSTYLE</td>
<td>Used inside a stored process to control the output style.</td>
<td>ODS styles</td>
</tr>
<tr>
<td>HPF_MULTISELECT_VAR_COUNT</td>
<td>Used to specify the number of multi-value metadata parameters passed to the report.</td>
<td>Positive integer</td>
</tr>
<tr>
<td>HPF_MULTISELECT_VAR#</td>
<td>Used to specify the base name of each multi-value metadata parameter.</td>
<td>Multi-value metadata parameter name</td>
</tr>
</tbody>
</table>

etadata Macro Variables

The variables listed in Table 10.3 describe the metadata resources that are used by the SAS Forecast Server.

### Table 10.3 Metadata Macro Variables

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>HPF_METADATA_HOST</td>
<td>Metadata server host name</td>
<td>Host name</td>
</tr>
<tr>
<td>HPF_METADATA_PORT</td>
<td>Metadata server port number</td>
<td>Port number</td>
</tr>
<tr>
<td>HPF_METADATA_REPNAME</td>
<td>Metadata repository name</td>
<td>Repository name</td>
</tr>
</tbody>
</table>
Table 10.3  Metadata Macro Variables (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>HPF_META_LIBNAME_COUNT</td>
<td>Number of manually assigned metadata libraries</td>
<td>Positive integer</td>
</tr>
<tr>
<td>HPF_META_LIBNAME#</td>
<td>Libname of each manually assigned library</td>
<td>Libname library names</td>
</tr>
<tr>
<td>HPF_META_LIBID#</td>
<td>FQID of the metadata object that defines each manually assigned library</td>
<td>Metadata FQID value</td>
</tr>
<tr>
<td>HPF_META_LIBACCESS#</td>
<td>Access level of each manually assigned library</td>
<td>Positive integer</td>
</tr>
</tbody>
</table>

Basic Project Macro Variables

The variables listed in Table 10.4 describe the basic characteristics for the active project.

Table 10.4  Basic Project Macro Variables

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>HPF_PROJECT</td>
<td>The project name.</td>
<td>SAS name</td>
</tr>
<tr>
<td>HPF_DESC</td>
<td>The project description.</td>
<td>SAS label</td>
</tr>
<tr>
<td>HPF_PROJECT_SERVER</td>
<td>The logical name of the host SAS Workspace Server.</td>
<td>Host name</td>
</tr>
<tr>
<td>HPF_DEFAULT_LOCATION</td>
<td>The base file system path to the environment directory.</td>
<td>File system path</td>
</tr>
<tr>
<td>HPF_PROJECT_LOCATION</td>
<td>File system path to the project directory.</td>
<td>System path</td>
</tr>
<tr>
<td>HPF_INCLUDE</td>
<td>The file system path to the project include file.</td>
<td>System filename</td>
</tr>
<tr>
<td></td>
<td>This macro variable specifies the system path and filename that contains the SAS code to assign the SAS libraries and catalogs that are associated with the project. By default, all libraries and catalogs are assigned with Read Only access (ACCESS=READONLY). For example, the following SAS code assigns project library names with Read Only access: %include &quot;&amp;HPF_INCLUDE&quot;;</td>
<td></td>
</tr>
<tr>
<td>HPF_EVENTS</td>
<td>Space-delimited list of all event names.</td>
<td>SAS name</td>
</tr>
<tr>
<td></td>
<td>For example, the following SAS code assigns project library names with Read and Write access: %let HPF_READ_ONLY = 0; %include &quot;&amp;HPF_INCLUDE&quot;;</td>
<td></td>
</tr>
</tbody>
</table>
Table 10.4  Basic Project Macro Variables (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>HPF_NUM_EVENTS</td>
<td>Number of events defined in the project.</td>
<td>Positive integer</td>
</tr>
<tr>
<td>HPF_EVENT_#</td>
<td>The name of individual event elements.</td>
<td>SAS name</td>
</tr>
</tbody>
</table>

Data Hierarchy and Settings Macro Variables

The variables listed in Table 10.5 describe the data settings for the active project.

Table 10.5  Data Hierarchy and Settings Macro Variables

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>HPF_INPUT_LIBNAME</td>
<td>SAS library reference where the source data for the input data set was obtained.</td>
<td>SAS name</td>
</tr>
<tr>
<td>HPF_INPUT_DATASET</td>
<td>Data set from where the source data was obtained.</td>
<td>SAS name</td>
</tr>
<tr>
<td>HPF_NUM_BYVARS</td>
<td>Number of BY variables. If there are no BY variables, HPF_NUM_BYVARS is set to zero.</td>
<td>Positive integer</td>
</tr>
<tr>
<td>HPF_BYVAR#</td>
<td>Individual BY variable names listed in the nth position of the ordered list of BY variables (HPF_BYVARS). The first BY variable name is stored in HPF_BYVAR1, the second in HPF_BYVAR2, and the last is stored in HPF_BYVAR&amp;HPF_NUM_BYVARS. If there are no BY variables (&amp;HPF_NUM_BYVARS is zero), these macro variables are not defined.</td>
<td>SAS name</td>
</tr>
<tr>
<td>HPF_NUM_DEPVARS</td>
<td>Number of dependent variables. There is always at least one dependent variable.</td>
<td>Positive integer</td>
</tr>
<tr>
<td>HPF_DEPVARS</td>
<td>Space-delimited list of all dependent variable names. The order of the dependent variable names is the same as specified in the project.</td>
<td>List of SAS names separated by a single space</td>
</tr>
</tbody>
</table>
### Table 10.5  Data Hierarchy and Settings Macro Variables (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>HPF_DEPVAR#</td>
<td>Individual dependent variable names listed in the ( n^{th} ) position of the ordered list of dependent variables (HPF_DEPVARS). The first dependent variable name is stored in HPF_DEPVAR1, the second in HPF_DEPVAR2, and the last is stored in HPF_DEPVAR&amp;HPF_NUM_DEPVARS. Since there is always at least one dependent variable associated with a project, HPF_DEPVAR1 is always defined.</td>
<td>SAS name</td>
</tr>
<tr>
<td>HPF_NUM_INDEPVARS</td>
<td>Number of independent variables. If there are no independent variables, HPF_NUM_INDEPVARS is set to zero.</td>
<td>Positive integer</td>
</tr>
<tr>
<td>HPF_INDEPVARS</td>
<td>Space-delimited list of all independent variable names. The order of the independent variable names is the same as specified in the project. The macro variable is always defined; but if there are no independent variables, HPF_INDEPVARS is set to NULL.</td>
<td>List of SAS names separated by a single space</td>
</tr>
<tr>
<td>HPF_INDEPVAR#</td>
<td>Individual independent variable names listed in the ( n^{th} ) position of the ordered list of independent variables (HPF_INDEPVARS). The first independent variable name is stored in HPF_INDEPVAR1, the second in HPF_INDEPVAR2, and the last is stored in HPF_INDEPVAR&amp;HPF_NUM_INDEPVARS. If there are no independent variables (&amp;HPF_NUM_INDEPVARS is zero), these macro variables are not defined.</td>
<td>SAS name</td>
</tr>
<tr>
<td>HPF_NUM_REPORTVARS</td>
<td>Number of reporting variables. If there are no reporting variables, then HPF_NUM_REPORTVARS is set to zero.</td>
<td>Positive integer</td>
</tr>
<tr>
<td>HPFREPORTVARS</td>
<td>Space-delimited list of all reporting variable names. The order of the reporting variable names is the same order as specified in the project. The macro variable is always defined; but if there are no reporting variables, then HPF_REPORTVARS is set to NULL.</td>
<td>List of SAS names separated by a single space</td>
</tr>
</tbody>
</table>
Table 10.5  Data Hierarchy and Settings Macro Variables (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>HPF_REPORTVAR#</td>
<td>Individual report variable names listed in the $n^{th}$ position of the ordered list of report variables (HPF_REPORTVAR). The first report variable name is stored in HPF_REPORTVAR1, the second in HPF_REPORTVAR2, and the last is stored in HPF_REPORTVAR&amp;HPF_NUM_REPORTVARS. If there are no reporting variables (&amp;HPF_NUM_REPORTVARS is zero), then these macro variables are not defined.</td>
<td>SAS name</td>
</tr>
<tr>
<td>HPF_TIMEID</td>
<td>Time ID variable name.</td>
<td>SAS name</td>
</tr>
<tr>
<td>HPF_TIMEID_FORMAT</td>
<td>SAS format of the time ID variable.</td>
<td>SAS format name</td>
</tr>
<tr>
<td>HPF_SEASONALITY</td>
<td>Integer length of the seasonal cycle. A seasonality of 1 implies no seasonality.</td>
<td>Positive integer</td>
</tr>
<tr>
<td>HPF_INTERVAL</td>
<td>Interval of the time ID variable, for example, MONTH.</td>
<td>SAS time interval</td>
</tr>
<tr>
<td>HPF_DATASTART</td>
<td>Start date/datetime/time value of the project input data set (&amp;HPF_LIBNAME.&amp;HPF_DATASET).</td>
<td>SAS date/datetime/time value</td>
</tr>
<tr>
<td>HPF_DATAEND</td>
<td>End date/datetime/time value of the project input data set (&amp;HPF_LIBNAME..&amp;HPF_DATASET).</td>
<td>SAS date/datetime/time value</td>
</tr>
<tr>
<td>HPF_SETMISSING</td>
<td>Controls the interpretation of missing values.</td>
<td></td>
</tr>
<tr>
<td>HPF_TRIMMISS</td>
<td>Controls whether missing values are trimmed.</td>
<td></td>
</tr>
<tr>
<td>HPF_ZEROMISS</td>
<td>Controls the interpretation of zero values.</td>
<td></td>
</tr>
<tr>
<td>HPF_NUM_LEVELS</td>
<td>Number of levels in the hierarchy. The levels of the hierarchy are numbered from 1 (the top of the hierarchy) to &amp;HPF_NUM_LEVELS (the leaves of the hierarchy). If there is no hierarchy, then the number of levels is 1.</td>
<td>Positive integer</td>
</tr>
</tbody>
</table>
### Table 10.5  Data Hierarchy and Settings Macro Variables (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>HPF_LEVEL_BYVARS#</td>
<td>Space-delimited list of BY variable names associated with the ( n^{th} ) level, where ( n ) ranges from 1 to &amp;HPF_NUM_LEVELS. The variables names are separated by a single space. The BY variables at level 1 (the top) are stored in HPF_LEVEL_BYVARS1, the BY variables for the lowest level (the leaves) are stored in HPF_LEVEL_BYVARS&amp;HPF_NUM_LEVELS.</td>
<td>SAS name</td>
</tr>
</tbody>
</table>
| HPF_LEVEL_DATAWHERE#     | Input data filtering WHERE clause for the \( n^{th} \) level, where \( n \) ranges from 1 to \&HPF_NUM_LEVELS. These WHERE clauses can be used to subset the input data sets for each level in the hierarchy to obtain information about the currently selected node. The WHERE clause at level 1 (the top) is stored in HPF_LEVEL_DATAWHERE1, the WHERE clause at the lowest level (the leaves) is stored in HPF_LEVEL_DATAWHERE\&HPF_NUM_LEVELS. **Note:** You must unquote this macro variable. For example,  
%unquote (&&HPF_CURRENT_DATAWHERE\&n); | SAS WHERE clause       |
### Table 10.5  Data Hierarchy and Settings Macro Variables (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>HPF_LEVEL_OUTWHERE#</td>
<td>Output data filtering WHERE clause for the $n^{th}$ level where $n$ ranges from 1 to &amp;HPF_NUM_LEVELS. These WHERE clauses can be used to subset the input data sets for each level in the hierarchy to obtain information about the currently selected node. The WHERE clause at level 1 (the top) is stored in HPF_LEVEL_OUTWHERE1, the WHERE clause at the lowest level (the leaves) is stored in HPF_LEVEL_OUTWHERE&amp;HPF_NUM_LEVELS. <strong>NOTE:</strong> You must unquote this macro variable. For example, <code>%unquote (&amp;HPF_LEVEL_OUTWHERE&amp;n);</code></td>
<td>SAS WHERE clause</td>
</tr>
<tr>
<td>HPF_LEVEL_LIBNAME#</td>
<td>SAS library reference for the $n^{th}$ level, where $n$ ranges from 1 to &amp;HPF_NUM_LEVELS. The library reference at level 1 (the top) is stored in HPF_LEVEL_LIBNAME1, the library reference at the lowest level (the leaves) is stored in HPF_LEVEL_LIBNAME&amp;HPF_NUM_LEVELS.</td>
<td>SAS LIBNAME</td>
</tr>
<tr>
<td>HPF_LEVEL_NSERIES#</td>
<td>Number of series associated with the $n^{th}$ level, where $n$ ranges from 1 to &amp;HPF_NUM_LEVELS. The number of series at level 1 (the top) is stored in HPF_LEVEL_NSERIES1, the number of series at the lowest level (the leaves) is stored in HPF_LEVEL_NSERIES&amp;HPF_NUM_LEVELS.</td>
<td>Positive integer</td>
</tr>
</tbody>
</table>

### Diagnose Macro Variables

The variables listed in Table 10.6 describe the current diagnose settings for the active project.

### Table 10.6  Diagnose Macro Variables

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>HPF_DIAGNOSE_INTERMITTENT</td>
<td>Intermittency threshold values for diagnose tests.</td>
<td>Positive number</td>
</tr>
</tbody>
</table>
Table 10.6  Diagnose Macro Variables (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>HPF_DIAGNOSE_SEASONTEST</td>
<td>Seasonality significance level for diagnose tests.</td>
<td>p-value</td>
</tr>
</tbody>
</table>

Model Selection Macro Variables

The variables listed in Table 10.7 describe the current model selection settings for the active project.

Table 10.7  Model Selection Macro Variables

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>HPF_SELECT_CRITERION</td>
<td>Statistic of fit to use for model selection.</td>
<td></td>
</tr>
<tr>
<td>HPF_SELECT_HOLDOUT</td>
<td>Absolute number of observations to holdout for selection. Zero implies that the model fit is used for selection.</td>
<td></td>
</tr>
<tr>
<td>HPF_SELECT_HOLDOUTPCT</td>
<td>Percentage of observations to holdout for selection.</td>
<td>Positive integer</td>
</tr>
<tr>
<td>HPF_SELECT_MINOBS_NON_MEAN</td>
<td>Minimum number of observations to require for a non-mean model.</td>
<td>Positive integer</td>
</tr>
<tr>
<td>HPF_SELECT_MINOBS_TREND</td>
<td>Minimum number of observations to require for a trend model.</td>
<td>Positive integer</td>
</tr>
</tbody>
</table>

Forecast Macro Variables

The variables listed in Table 10.8 describe the current forecasting settings for the active project.

Table 10.8  Forecast Macro Variables

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>HPF_LEAD</td>
<td>Integer number of time periods to forecast the length of the forecast horizon or lead.</td>
<td>Positive integer</td>
</tr>
<tr>
<td>HPF_FORECAST_ALPHA</td>
<td>Confidence level size.</td>
<td>p-value</td>
</tr>
<tr>
<td>HPF_BACK</td>
<td>Integer number of time periods to ignore when forecasting.</td>
<td>Positive integer</td>
</tr>
</tbody>
</table>

Reconciliation Macro Variables

The variables listed in Table 10.9 describe the current reconciliation settings for the active project.

Table 10.9  Reconciliation Macro Variables

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table 10.9 Reconciliation Macro Variables (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>HPF_RECONCILE_LEVEL</td>
<td>Index of the reconciliation level.</td>
<td>Positive integer</td>
</tr>
<tr>
<td></td>
<td>The reconciliation level index ranges from 1 to &amp;HPF_NUM_LEVELS, depending on the level of reconciliation.</td>
<td></td>
</tr>
<tr>
<td>HPF_RECONCILE_BYVAR</td>
<td>BY variable associated with the level used for reconciliation.</td>
<td>SAS name</td>
</tr>
<tr>
<td>HPF_RECONCILE_METHOD</td>
<td>Reconciliation method</td>
<td>SAS name</td>
</tr>
<tr>
<td>HPF_LEVEL_RECONCILE_DATASET#</td>
<td>The reconciled forecast data set for each level.</td>
<td></td>
</tr>
<tr>
<td>HPF_LEVEL_RECONCILE_STATISTICS#</td>
<td>The reconciled statistics data set for each level.</td>
<td></td>
</tr>
<tr>
<td>HPF_LEVEL_RECONCILE_SUMMARY#</td>
<td>The reconciled summary dataset for each level.</td>
<td></td>
</tr>
</tbody>
</table>

Active Series Macro Variables

The variables listed in Table 10.10 describe the series currently in focus in the active project.

Table 10.10 Active Series Macro Variables

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>HPF_CURRENT_LEVEL</td>
<td>The level index number associated with the current level. The current level number ranges from 1 to &amp;HPF_NUM_LEVELS, depending on the currently selected level of the hierarchy.</td>
<td>Positive integer</td>
</tr>
<tr>
<td>HPF_CURRENT_LIBNAME</td>
<td>The SAS library reference associated with the currently-selected level of the hierarchy.</td>
<td>SAS LIBNAME</td>
</tr>
<tr>
<td>HPF_CURRENT_LEVEL_START</td>
<td>Start date/datetime/time value of the current level. The starting time ID value of the input data set for the currently selected level of the hierarchy.</td>
<td>SAS date/datetime/time value</td>
</tr>
<tr>
<td>HPF_CURRENT_LEVEL_END</td>
<td>End date/datetime/time value of the current level. The ending time ID value of the input data set for the currently selected level of the hierarchy.</td>
<td>SAS date/datetime/time value</td>
</tr>
<tr>
<td>HPF_CURRENT_LEVEL_NSERIES</td>
<td>Number of series (or nodes) associated with the currently selected level of the hierarchy.</td>
<td>Positive integer</td>
</tr>
<tr>
<td>HPF_CURRENT_SERIESSTART</td>
<td>Start date/datetime/time value of the current node. The starting time ID value of the series for the currently selected node of the hierarchy.</td>
<td>SAS date/datetime/time value</td>
</tr>
</tbody>
</table>
Table 10.10  Active Series Macro Variables (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>HPF_CURRENT_SERIESEND</td>
<td>End date/datetime/time value of the current node. The ending time ID value of the series for the currently selected node of the hierarchy.</td>
<td>SAS date/datetime/time value</td>
</tr>
<tr>
<td>HPF_CURRENT_DATAWHERE</td>
<td>Input data WHERE clause for the currently selected node. This WHERE clause can be used to subset the input data set to obtain information about the currently selected node of the hierarchy. **Note:** You must unquote this macro variable. For example, %unquote (&amp;HPF_CURRENT_DATAWHERE);</td>
<td>SAS WHERE clause</td>
</tr>
<tr>
<td>HPF_CURRENT_OUTWHERE</td>
<td>Output data WHERE clause for the currently selected node. This WHERE clause can be used to subset the output data sets to obtain information about the currently selected node. **Note:** You must unquote this macro variable. For example, %unquote (&amp;HPF_CURRENT_OUTWHERE);</td>
<td>SAS WHERE clause</td>
</tr>
<tr>
<td>HPF_NUM_CURRENT_BYVARS</td>
<td>Number of BY variable names for the currently selected level of the hierarchy.</td>
<td>Positive integer</td>
</tr>
<tr>
<td>HPF_CURRENT_BYVARS</td>
<td>Space-delimited list of BY variable names for the currently selected level of the hierarchy. The macro variable is always defined; but if there are no BY variables, HPF_CURRENT_BYVARS is set to NULL.</td>
<td>List of SAS names separated by a single space</td>
</tr>
<tr>
<td>HPF_CURRENT_BYVARS#</td>
<td>Individual BY variable names for the current level.</td>
<td>SAS name</td>
</tr>
<tr>
<td>HPF_CURRENT_DEPVAR</td>
<td>Dependent variable name associated with the currently selected node of the hierarchy. This variable is contained in the list of dependent variables (HPF_DEPVAR).</td>
<td>SAS name</td>
</tr>
<tr>
<td>HPF_CURRENT_HORIZON</td>
<td>Horizon date/datetime/time value of the current node. The time ID value of the start of the multi-step ahead forecast for the currently selected node of the hierarchy.</td>
<td>SAS date/datetime/time value</td>
</tr>
</tbody>
</table>
Using Special Features in Reports

Special Report Features Demonstrated with Sample Reports

You can reference sample reports that are shipped with the product to understand how to use dynamic parameters, multi-value parameters, and manually assigned metadata libraries.

The sample reports provided for these demonstrations are as follows:

**Using Dynamic Parameters**
This example shows all of the special parameter names that you can use with dynamic lists and demonstrates how to configure these parameters.

**Using Metadata Libraries**
This example shows how to use assigned metadata libraries easily using the %HPF_LoadMetadataLibraries macro call.

**Working with List Variables**
This example shows how list variables are passed to programs. Additionally, it demonstrates how to reformat these variables automatically for compatibility with the format used by the previous release.

**NOTE:** You must deploy the sample reports before they are available for use in SAS Forecast Studio. For information about deploying the sample reports, see “Using the Sample Reports.”

About Manually Assigned Metadata Libraries

The product supports manually assigned metadata libraries in your custom reports. Information about the manually assigned libraries is visible to the product through the HPF_META_LIB... internal variables.

View the Using Metadata Libraries sample report to explore how to use these variables in your custom reports. For more information about this and other reports, see “Special Report Features Demonstrated with Sample Reports.”

For more information about the HPF_META_LIB... internal variables, see Table 10.3.

How to Access the Sample Reports

To access the sample reports that demonstrate these special features:

1. Start SAS Forecast Studio, and then open a project.
2. Select **Tools → Reports and Stored Processes**.
3. In the resulting dialog box, expand the **Reports, Samples, Getting Started**, and **Special Features** nodes.
4. Select one of the sample reports.
5. Click Run.

**Required Macro Calls**

When you create custom reports, the header portion of the report’s source code file must contain macro calls to initialize the HPF stored process support and ODS output as follows:

```
*ProcessBody;
/
/!*- initialize the HPF stored process support -*/
/!*- initialize the ODS output -*/
%hpfstp();
/
%HPF_InitODSOutput();
%stpbeg;
```

**Keywords Used in Reports**

When you register a report object in SAS Management Console for use with the product, you must use the FS_REPORT keyword to distinguish the report object from other stored processes. Additionally, the sample reports provided with the product use the FS_SAMPLE keyword to distinguish the sample reports provided with the product from custom user reports. For more information about registering a report, see “Register the Report with SAS Management Console.” For more information about migrating custom reports from the previous release, see “Migrating Reports.”

To specify a keyword for the report metadata object:

1. In SAS Management Console, right-click on your report metadata object, and then select Properties. The Properties dialog box opens.

2. In the Keywords section, click Add. The Add Keyword dialog box opens.

3. Type FS_REPORT, and then click OK.
Chapter 11
Miscellaneous Administration Tasks

Contents

<table>
<thead>
<tr>
<th>Use a Customized Format in the SAS Forecast Server</th>
<th>131</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove a Configuration with the SAS Deployment Manager</td>
<td>132</td>
</tr>
<tr>
<td>Stop the SAS Servers</td>
<td>133</td>
</tr>
<tr>
<td>SAS Analytics Platform Server</td>
<td>133</td>
</tr>
<tr>
<td>SAS Object Spawner</td>
<td>134</td>
</tr>
<tr>
<td>SAS Metadata Server</td>
<td>134</td>
</tr>
<tr>
<td>Change the Default RMI Port for the SAS Analytics Platform Server</td>
<td>135</td>
</tr>
</tbody>
</table>

Use a Customized Format in the SAS Forecast Server

To use a customized format that you defined with the data set in SAS and in the SAS Forecast Server, you must make the user-written format accessible to the SAS Workspace Server. You can configure using one of the following methods:

- Store the user-written format in the default formats catalog location, for example:
  `<config-dir>/Lev1/SASApp/SASEnvironment/SASFormats`

- Modify the SAS configuration file to search for your customized format in its own library and the default formats library.

To use a customized format:

1. Verify that the format matches the data values. For example, the following format statement must contain line names with a capitalized L (Line1, Line2, and so on).
   ```
   value $ line
   Line1='Product Line1'
   Line2='Product Line2'
   Line3='Product Line3'
   Line4='Product Line4'
   Line5='Product Line5';
   ```

2. You must store the format in a persistent format library that is accessible to SAS. This requires that you use the `LIBRARY=` option with the `PROC FORMAT` statement.
To store the format in the default location, write the following SAS code:

```sas
libname library
<config-dir>/Lev1/SASApp/SASEnvironment/SASFormats;
proc format library=library;
```

To store the user-defined formats in the \texttt{C:\myfmts} location on the SAS server, write the following SAS code:

```sas
libname library "c:\myfmts";
proc format library=library;
```

The catalog name used in this library defaults to formats.

3. You must defined the format library for the SAS Workspace Server session that is used by the SAS Forecast Server. If the customized format is stored in the default location, then no further modifications are required. If the customized format is in a different location, then you must configure SAS to search that library in addition to the default library.

To search a different format library, edit the configuration file found in the following default location:

- **Windows:**
  ```
  <config-dir>/Lev1/SASApp\sasv9.cfg
  ```

- **UNIX:**
  ```
  <config-dir>/Lev1/SASApp/sasv9.cfg
  ```

Update the sasv9.cfg file to add the library definition and include the library definition in the format-search parameter:

- `set FSFMTS ("c:\myfmts")`
- `fmtsearch (FSFMTS)`

When you restart the SAS Workspace Server, the system resolves references to the customized formats that are stored in the formats catalog in \texttt{C:\myfmts}.

---

**Remove a Configuration with the SAS Deployment Manager**

If you need to reconfigure a product, you must first use the SAS Deployment Manager to remove your existing configuration.

To remove a configuration:
1. Navigate to the **SAS_HOME** directory ..\SASDeploymentManager\9.2 directory. For example, on a Windows system, this is the C:\Program Files\SAS\SASDeploymentManager\9.2 folder.

2. Double-click **config.exe** to launch the SAS Deployment Manager.

3. Select **Remove existing configuration**, and then click **Next**.

4. Select a **Configuration directory**, and then click **Next**.

5. Specify your connection information to the SAS Metadata Server, and then click **Next**.

6. Select the product that you want to unconfigure, and then click **Next**. For example, to unconfigure the SAS Forecast Server, select **Forecast Server 3.1**.

7. (Optional) The SAS Forecast Server stores metadata describing user-defined environments and projects in the SAS Metadata Server. If you are removing a configuration for the SAS Forecast Server, you can also select to unregister the user content. This option removes the SAS Forecast Server metadata when you remove the configuration. In either case, the actual content is not deleted as you remove the configuration, and you can use it to recreate the removed metadata later if desired.

   **NOTE:** You can use the SAS Forecast Server Plug-in for SAS Management Console to register and unregister user content. For more information about registering and unregistering content, see the Help for the SAS Forecast Server Plug-in for SAS Management Console.

8. In the **Summary** screen, click **Start**.

---

**Stop the SAS Servers**

**SAS Analytics Platform Server**

To stop the SAS Analytics Platform server:

**UNIX:**

1. Open a terminal session and have an X server running.

2. Navigate to the SAS Analytics Platform server configuration directory. For example, ..\SAS\Config\Lev1\AnalyticsPlatform.

3. Execute the following command:

   ```sh
   ./AnalyticsPlatform.sh stop
   ```
Chapter 11: Miscellaneous Administration Tasks

Windows:
From the Windows Start menu, select Programs → SAS → SAS Configuration → Config - Lev1 → SAS Analytics Platform server - Stop.

**NOTE:** Config - Lev1 reflects a default installation.

Alternatively, you can stop the SAS Analytics Platform server by executing a .bat file. At a DOS prompt, navigate to the SAS configuration directory. For example, navigate to the C:\SAS\Config\Lev1\AnalyticsPlatform folder, and type the following command:

```
AnalyticsPlatform.bat stop
```

---

### SAS Object Spawner

To stop the SAS Object Spawner:

**UNIX:**

1. Navigate to the Object Spawner’s configuration directory.  
   For example, ../SAS/Config/Lev1/ObjectSpawner
2. Execute the script in the directory that stops the SAS Object Spawner.

**Windows:**
From the Windows Start menu, select Programs → SAS → SAS Configuration → Config - Lev1 → Object Spawner - Stop.

**NOTE:** Config - Lev1 reflects a default installation.

Alternatively, you can stop the SAS Object Spawner by executing a .bat file. You find the .bat file in the following folder:
C:\SAS\Config\Lev1\ObjectSpawner

---

### SAS Metadata Server

To stop the SAS Metadata Server:

**UNIX:**

1. Navigate to the SAS Metadata Server configuration directory.  
   For example, ../SAS/Config/Lev1/SASMeta/MetadataServer
2. Execute the script in the directory that stops the SAS Metadata Server.
Windows:
From the Windows Start menu, select Programs → SAS → SAS Configuration → Config - Lev1 → SASMeta - Metadata Server - Stop.

Alternatively, you can stop the SAS Metadata Server by executing a .bat file. You find the .bat file in the following folder:
C:\SAS\Config\Lev1\SASMeta\MetadataServer

**NOTE:** Config - Lev1 reflects a default installation.

---

**Change the Default RMI Port for the SAS Analytics Platform Server**

The remote method invocation (RMI) port value used by the SAS Analytics Platform server is configured during deployment in the SAS Deployment Wizard. By default, this port value is 6411 for a level 1 configuration. This port value is not customizable specifically for the SAS Forecast Server. The port value applies to all products that use the SAS Analytics Platform server. The ports that are used for the RMI services apply to every RMI service in the JVM.

To reconfigure the SAS Analytics Platform server and change the RMI port value:

1. Stop the SAS Analytics Platform server. For more information, see “SAS Analytics Platform Server.”

2. Remove the configuration for the SAS Analytics Platform server. For more information, see “Remove a Configuration with the SAS Deployment Manager.”


4. In the SAS Analytics Platform server: Ports window, use the RMI Registry Port field to update the registry port.

5. Complete the remaining steps in the SAS Deployment Wizard to configure the SAS Analytics Platform server.

6. Restart the SAS Analytics Platform server. For more information, see “Start the SAS Analytics Platform Server.”
Chapter 12
The SAS Forecast Server Administrative Macros

Contents

The SAS Forecast Server Macros .................................................. 138
Summary of the SAS Forecast Server Macros ............................... 138
Installation Location of the SAS Macros ...................................... 140
Macro Changes ................................................................. 140
Using Macros to Update Projects .............................................. 141
About Notes and Warnings ..................................................... 141
FSCLEAR Macro: Clears global macro variable project information .... 141
FSCOPY Macro: Copy a Project to a New Location ......................... 142
FSCREATE Macro: Create a New Project in Batch Mode ................. 144
FSDELARC Macro: Delete an Archived Project ............................ 151
FSDELENV Macro: Deletes a Specified Environment ..................... 153
FSDELPJ Macro: Delete an Existing Project ............................... 154
FSEXPPALL Macro: Archive All SAS Forecast Server Projects ......... 155
FSEXPORT Macro: Archive a Single Project ............................... 157
FSGETENV Macro: Retrieve Environment Information .................. 159
FSGETPRJ Macro: Retrieve Project Information ............................ 160
FSGETURP Macro: Generates a List of Unregistered Project Names .... 162
FSIMPALL Macro: Import all Archived Projects ........................... 163
FSIMPORT Macro: Import an Archived Project ............................ 165
FSLOAD Macro: Open a Project and Load Global Macro Variables .... 166
FSMIGALL Macro: Updates all Projects to Current SAS Forecast Server Version ............................................. 167
FSMIGPRJ Macro: Updates a Project to Current SAS Forecast Server Version ............................................. 169
FSMOVE Macro: Move a Project to a Different Location .................. 170
FSNEWENV Macro: Create a New SAS Forecast Server Environment ... 172
FSREGENV Macro: Create a New SAS Forecast Server Environment and Register Projects ................................... 174
FSREGPRJ Macro: Register a Project in Metadata ......................... 175
FSREN Macro: Rename a SAS Forecast Server Project .................. 176
FSRUNPRJ Macro: Open and Run a Project at a Given Stage ............ 178
FSSETOWN Macro: Assign the Owner of a Project ....................... 179
FSSETPUB Macro: Enable Public Access .................................... 181
FSUNREG Macro: Unregister a Project from the SAS Metadata Server . 182
The SAS Forecast Server Macros

Summary of the SAS Forecast Server Macros

A SAS macro is a program that generates SAS statements. The macros enable you to produce and execute complex SAS programs that are time-consuming to write yourself. In addition, the macros enable you to create and manage SAS Forecast Server projects in a batch environment. You can also use the macros to perform routine, repetitive tasks.

The macros provide a SAS language interface to the SAS Forecast Server Java API, much in the same way as the SAS Forecast Studio and the SAS Forecast Server Plug-in for SAS Management Console do. Effectively, the macros are an alternative client to both SAS Forecast Server and the SAS Forecast Server Plug-in for SAS Management Console. In the macros, you can find many of the features that are available to you when creating a project with SAS Forecast Studio. Additionally, the macros enable you to perform administrative functions on a single project or a group of projects. Figure 12.1 shows a schematic representation of how the macros interact with the other components of the SAS Forecast Server.
You can run the macros on any system that has an installation of SAS Foundation. On Windows, the macros reside in an autocall library in `!SASROOT/forecastmva/sasmacro`. On UNIX, they reside in the `SASFoundation/9.2/sasautos` directory.

Table 12.1 shows the macros that you can use with the SAS Forecast Server.

### Table 12.1 The SAS Forecast Server Macros

<table>
<thead>
<tr>
<th>Macro Name</th>
<th>Description</th>
<th>Administrative User Only?</th>
</tr>
</thead>
<tbody>
<tr>
<td>FSCLEAR</td>
<td>Clears project information currently stored in global macro variables.</td>
<td>No</td>
</tr>
<tr>
<td>FSCOPY</td>
<td>Copies a SAS Forecast Server project to a new destination.</td>
<td>No</td>
</tr>
<tr>
<td>FSCREATE</td>
<td>Creates a new SAS Forecast Server project in batch mode.</td>
<td>No</td>
</tr>
<tr>
<td>FSDELARC</td>
<td>Deletes an archived SAS Forecast Server project.</td>
<td>No</td>
</tr>
<tr>
<td>FSDELENV</td>
<td>Deletes an existing SAS Forecast Server environment.</td>
<td>No</td>
</tr>
<tr>
<td>FSDELPRJ</td>
<td>Deletes an existing SAS Forecast Server project.</td>
<td>No</td>
</tr>
<tr>
<td>FSEXPORT</td>
<td>Exports a single SAS Forecast Server project to an archive file.</td>
<td>No</td>
</tr>
<tr>
<td>FSEXPAll</td>
<td>Exports all SAS Forecast Server projects to archive files.</td>
<td>Yes</td>
</tr>
<tr>
<td>FSGETENV</td>
<td>Retrieves the metadata about the SAS Forecast Server environments.</td>
<td>No</td>
</tr>
<tr>
<td>FSGETPRJ</td>
<td>Retrieves the metadata about the SAS Forecast Server projects.</td>
<td>No</td>
</tr>
<tr>
<td>FSGETURP</td>
<td>Creates a log file that lists the names of any unregistered projects in a specified environment.</td>
<td>No</td>
</tr>
<tr>
<td>FSIMPALL</td>
<td>Imports all SAS Forecast Server projects listed in a data set from archived files.</td>
<td>No</td>
</tr>
<tr>
<td>FSIMPORT</td>
<td>Imports a SAS Forecast Server project from an archived file.</td>
<td>No</td>
</tr>
</tbody>
</table>
Table 12.1  The SAS Forecast Server Macros (continued)

<table>
<thead>
<tr>
<th>Macro Name</th>
<th>Description</th>
<th>Administrative User Only?</th>
</tr>
</thead>
<tbody>
<tr>
<td>FSLOAD</td>
<td>Opens an existing SAS Forecast Server project, and loads global macro variables that describe the project.</td>
<td>No</td>
</tr>
<tr>
<td>FSMIGALL</td>
<td>Migrates all existing SAS Forecast Server projects to the current version of SAS Forecast Server.</td>
<td>Yes</td>
</tr>
<tr>
<td>FSMIGPRJ</td>
<td>Migrates an existing SAS Forecast Server project to the current version of SAS Forecast Server.</td>
<td>No</td>
</tr>
<tr>
<td>FSMOVE</td>
<td>Moves a SAS Forecast Server project to a new destination.</td>
<td>No</td>
</tr>
<tr>
<td>FSNEWENV</td>
<td>Creates a new SAS Forecast Server environment.</td>
<td>Yes</td>
</tr>
<tr>
<td>FSREGENV</td>
<td>Registers an existing directory structure as an environment, optionally registering all projects found within.</td>
<td>Yes</td>
</tr>
<tr>
<td>FSREGPRJ</td>
<td>Registers a project in metadata.</td>
<td>Yes</td>
</tr>
<tr>
<td>FSREN</td>
<td>Renames a single SAS Forecast Server project.</td>
<td>No</td>
</tr>
<tr>
<td>FSRUNPRJ</td>
<td>Opens an existing SAS Forecast Server project, and runs the project at a given stage.</td>
<td>No</td>
</tr>
<tr>
<td>FSSETOWN</td>
<td>Assigns the owner of a project.</td>
<td>Yes</td>
</tr>
<tr>
<td>FSSETPUB</td>
<td>Determines whether public access to a SAS Forecast Server project should be enabled.</td>
<td>Yes</td>
</tr>
<tr>
<td>FSUNREG</td>
<td>Unregisters an existing SAS Forecast Server project from the metadata server.</td>
<td>Yes</td>
</tr>
<tr>
<td>FSURGENV</td>
<td>Unregisters an environment.</td>
<td>No</td>
</tr>
</tbody>
</table>

For information about the SAS macro facility, see *SAS Macro Language: Reference* documentation.

**Installation Location of the SAS Macros**

The SAS Macros are automatically installed with the SAS Forecast Server. For example on Windows, the default installation location is the `C:\Program Files\SAS\SASFoundation\9.2\forecastmva\sasmacro` directory.

**Macro Changes**

For information about changes to the macros for this release, see the What’s New section in the *SAS Forecast Server User’s Guide*. 
Using Macros to Update Projects

**NOTE:** Before you can use macros to update projects that you created with SAS Forecast Server 1.4, you must upgrade these projects to SAS Forecast Server 2.1. You cannot go directly from SAS Forecast Server 1.4 to SAS Forecast Server 3.1. Before you upgrade any projects to this release, see “Upgrading from SAS Forecast Server 2.1 to SAS Forecast Server 3.1.”

You can use the FSMIGALL and FSMIGPRJ macros only with projects created with (or upgraded to) SAS Forecast Server 2.1. Projects created with SAS Forecast Server 2.1 are automatically upgraded to the current version when you use any of these macros. You cannot use these macros to upgrade projects created with SAS Forecast Server 1.4 directly to SAS Forecast Server 3.1.

---

### About Notes and Warnings

**Classpath Variable Note**

You do not have to set the classpath variable before using the macros. If you see the following note while executing the macros, you can safely ignore it.

**NOTE:** Could not initialize classpath. Classpath variable is not set.

**log4j Warning**

You do not need to configure the log4j logging service for Java. If you see the following warning while executing the macros, you can safely ignore it.

```log4j
log4j:WARN No appenders could be found for logger (com.sas.services.deployment.RMIConfiguration).
log4j:WARN Please initialize the log4j system properly.
```

---

### FSCLEAR Macro: Clears global macro variable project information

The FSCLEAR macro clears project information currently stored in global macro variables. Use the FSLOAD macro to add global variable project information. For more information, see “FSLOAD.”

**Syntax**

The FSCLEAR macro has the following form:

```plaintext
%FSCLEAR ();
```
Chapter 12: The SAS Forecast Server Administrative Macros

**Required Arguments**

There are no arguments required for this macro.

**Options**

This macro does not use any optional parameters.

**Example**

```plaintext
%fs_clear();
```

---

**FSCOPY Macro: Copy a Project to a New Location**

The FSCOPY macro copies a SAS Forecast Server project to a new destination.

**NOTE:** Both servers must run the same version or higher of SAS Forecast Server.

**Syntax**

The FSCOPY macro has the following form:

```plaintext
%FSCOPY (SOURCEPROJECTNAME=, DESTINATIONPROJECTNAME=, USER=, PASSWORD=, REMOTEARCHIVEFOLDER= SOURCEENVIRONMENT=, DESTINATIONENVIRONMENT= [ , options ]
```

**Required Arguments**

The following arguments must be used with the FSCOPY macro. The required arguments are separated by commas.

- **SOURCEPROJECTNAME= source-project-name**
  specifies the name of the SAS Forecast Server project on the source host. The name must be a valid SAS name.

- **DESTINATIONPROJECTNAME= destination-project-name**
  specifies the name of the SAS Forecast Server project on the destination host. The name must be a valid SAS name.

- **USER= username**
  specifies the user name that you use to log on to SAS Forecast Studio.

- **PASSWORD= password**
  specifies the user’s password that you use to log on to SAS Forecast Studio.
REMOTEARCHIVEFOLDER= directory-name
specifies the directory where the archived projects of the source SAS Workspace Server are to be found on the destination SAS Workspace Server (for example, `\sourceserver\SAS\ForecastStudio\Archives`).

NOTE: USER= must have read/write privileges to the REMOTEARCHIVEFOLDER= folder.

SOURCEENVIRONMENT= environment-name
specifies the name of the SAS Forecast Server environment to be used as source. It is required only if there are multiple environments available to the user.

DESTINATIONENVIRONMENT= environment-name
specifies the name of the SAS Forecast Server environment to be used as destination. It is required only if there are multiple environments available to the user.

Options

The following options can be used with the FSCOPY macro. Options must follow the required arguments and be separated by commas.

ARCHIVEFOLDER= directory-name
specifies the directory to save the archive in. If not specified, the default location is used.

CPORT= YES | TRUE | NO | FALSE
exports data sets and catalogs using CPORT. Needed if the source and destination are running on different operating systems. Possible values are YES | TRUE | NO | FALSE. The default is CPORT=NO.

HOST= host:port
specifies the host and port of the SAS Forecast Server middle tier. The default is localhost:6411.

NOWARN= YES | NO
suppresses errors if the SAS Forecast Server project does not exist. Possible values are YES | NO. The default is NOWARN=NO.

PRINTVERSIONONLY= 0 | 1
When PRINTVERSIONONLY=1, it prints the version to the log and exits.

TMPARCHIVENAME= value
specifies the name of the temporary archived project. The default is _fs_tmp_archive. The name must not match an existing archive.

Example

```sas
%fscopy(sourceprojectname=prdat1,  
destinationprojectname=prdat2,  
user=sasuser,  
password=saspass, ```
remoteArchiveFolder=\sourceserver\SAS\ForecastStudio\Archives,
sourceEnvironment=Default,
destinationEnvironment=Default,
);

Results

The FSCOPY global macro variable indicates whether the FSCOPY macro terminates successfully
or encounters errors:

&FSCOPY = SUCCESS | ERROR

FSCRECREATE Macro: Create a New Project in Batch Mode

The FSCRECREATE macro creates a new SAS Forecast Server project in batch mode.

Syntax

The FSCRECREATE macro has the following form:

%%FSCRECREATE (PROJECTNAME=, USER=, PASSWORD=, DATA=, ID=, VAR= [ , options ] ) ;

Required Arguments

The following arguments must be used with the FSCRECREATE macro. The required arguments are
separated by commas.

PROJECTNAME= project-name
    specifies the name of the SAS Forecast Server project. The name must be a valid SAS name.

USER= username
    specifies the user name that you use to log on to SAS Forecast Studio.

PASSWORD= password
    specifies the user password that you use to log on to SAS Forecast Studio.

DATA= SAS-data-set
    specifies the name of the input SAS data set.

ID= variable
    specifies the time ID variable.

VAR= variable
    specifies the dependent variable(s). Multiple variable names can be specified only if HIER-
ARCHY=NO | FALSE. Multiple variable names are separated by a space.
**Options**

The following options can be used with the FSCREATE macro. Options must follow the required arguments, and are separated by commas.

**ACCUMULATE** =  \texttt{TYPE \{TYPE(var1 \ var2) \ TYPE(var3 \ var4) \ldots\}}

specifies the accumulation option(s) of the dependent, input, and reporting variables. Valid types are the following:

- **NONE**
  specifies that no accumulation occurs; the ID variable values must be equally spaced with respect to the frequency. This is the default option.

- **TOTAL**
  specifies that observations are accumulated based on the total sum of their values.

- **AVERAGE | AVG**
  specifies that observations are accumulated based on the average of their values.

- **MINIMUM | MIN**
  specifies that observations are accumulated based on the minimum of their values.

- **MEDIAN | MED**
  specifies that observations are accumulated based on the median of their values.

- **MAXIMUM | MAX**
  specifies that observations are accumulated based on the maximum of their values.

- **N**
  specifies that observations are accumulated based on the number of nonmissing observations.

- **NMISS**
  specifies that observations are accumulated based on the number of missing observations.

- **NOBS**
  specifies that observations are accumulated based on the number of observations.

- **FIRST**
  specifies that observations are accumulated based on the first of their values.

- **LAST**
  specifies that observations are accumulated based on the last of their values.

- **STDDEV | STD**
  specifies that observations are accumulated based on the standard deviation of their values.

- **CSS**
  specifies that observations are accumulated based on the corrected sum of squares of their values.

- **USS**
  specifies that observations are accumulated based on the uncorrected sum of squares of their values.

Examples: Apply AVG accumulation to all variables: ACCUMULATE=AVG

Apply TOTAL accumulation to all variables except for var1, which will be AVG: ACCUMULATE=TOTAL AVG(var1)
Apply TOTAL accumulation to all variables except for var1 and var2, which is AVG, and var3 which is STD: ACCUMULATE=TOTAL AVG(var1 var2) STD(var3)

Apply the default accumulation for all variables, which is TOTAL.

**ADJUST=** var1(var2 var3) [ /operation=(pre,post)]
Specifies the adjustment option(s) of the dependent variable(s).

Valid pre-adjust and post-adjust values are:

NONE
ADD
SUBTRACT
MULTIPLY
DIVIDE
MIN
MAX

If not specified, the default value for pre-adjust and post-adjust is NONE.

Examples: Adjust sale with price1: adjust=sale(price1)
Adjust sale with price1, and price with price2: adjust=sale(price1) price(price2)
Adjust sale with price1 and price2: adjust=sale(price1 price2)
Adjust sale with price1, setting the pre/post adjust adjust=sale(price1)/operation=(ADD,NONE)

**AGGREGATE=** TYPE [TYPE(var1 var2) TYPE(var3 var4) ...]
specifies the aggregation option(s) of the dependent, input, and reporting variables. Aggregation is only valid if hierarchy=YES. See the ACCUMULATE option for valid values and examples. **NOTE:** For the dependent variable the only valid values are TOTAL | AVERAGE | AVG.

**ALLOWNEGATIVE=** YES | TRUE | NO | FALSE
specifies whether negative forecasts are allowed. The default value is NO.

**ALPHA=** n
specifies the confidence level for the series. The default value is 0.05, which is a 95% confidence level.

**ARIMAX=** YES | TRUE | NO | FALSE
specifies whether ARIMA models should be considered. The default value is YES.

**BACK=** n
specifies the out of sample range (periods from end). The default value is 0.

**BY=** variable
specifies the BY variable(s). Multiple variable names can be specified, separated by a space.
CRITERION= options
specifies the model selection criterion (statistic of fit) to be used to select from several candidate models. The default value is MAPE.

DESCRIPTION= text
specifies the project description.

DETECTOUTLIERS= YES | TRUE | NO | FALSE
specifies whether outliers in the data should be detected when fitting an ARIMA model. The default value is NO.

DISAGGREGATION= PROPORTIONS | EQUALSPLIT
specifies the disaggregation method for reconciliation. The default value is PROPORTIONS.

ENVIRONMENT= environment-name
specifies the name of the SAS Forecast Server environment. The default environment is Default.

ESM= YES | TRUE | NO | FALSE
specifies whether exponential smoothing models (ESM) should be considered. The default value is YES.

ESMONLYATLEVEL= by variable
use to improve performance for large hierarchies. In hierarchical projects, specifies the highest level to fit the ESM models. The argument specified must be the name of a BY VARIABLE. By default, no level is specified for fitting the ESM models.

HIERARCHY= YES | TRUE | NO | FALSE
specifies whether the BY variable(s) should be considered hierarchical. The default value is NO.

HOLDOUT= n | NO | FALSE
specifies the number of periods to be used as the holdout sample for model selection. To disable the holdout, specify NO | FALSE.

HOLDOUTPCT= n | NO | FALSE
specifies the number of periods as a percentage of the series length to be used as the holdout sample for model selection. To disable the HOLDOUTPCT, specify NO | FALSE.

HOST= host:port
specifies the host and port number of the Forecast Server middle tier. The default is localhost:6411.

IDFORMAT= date
specifies the date/time format of the values in the time ID variable.

INPUT= variable
specifies the input (or independent) variable(s). Multiple variable names can be specified, separated by a space.
**INTERMITTENT**= n | NO | FALSE
specifies the sensitivity of the time series intermittent test. The default value is 2. To disable the test, specify NO | FALSE.

**INTERVAL**= interval-measure
specifies the time interval of the time ID variable.

Valid values are the following:
DAY | HOUR | MINUTE | MONTH | QUARTER | SECOND | SEMIMONTH | SEMIYEAR | TEN-DAY | WEEK | WEEKDAY | YEAR

The default value is detected automatically when possible.

**LEAD**= n
specifies the number of periods into the future which multiple step forecasts are made. The default value is 12.

**MAXNUMOUTLIERS**= n
specifies the maximum number of outliers to include in ARIMAX models. The default value is 2.

**MAXPCTOUTLIERS**= n
specifies the maximum number of outliers to include in ARIMAX models as a percentage of the length of the series, not including beginning and ending missing values. The default value is 2. If maxnumoutliers=5 and maxpctoutliers=10, the maximum number of the outliers is 5 or 10% of the series length, whichever is smaller.

**MINOBSTREND**= n
specifies the minimum number of observations needed for a trend model. The default value is 2.

**MINOBSNONMEAN**= n
specifies the minimum number of observations needed for a non-mean model. The default value is 1.

**MINOBSSEASON**= n
specifies that no seasonal model be fit to any series with fewer observations than minobsseason multiplied by the seasonal cycle length. The value must be greater than or equal to 1. The default value is 2.

**MODELSELECTIONLIST**= SAS-data-set
specifies a model selection list that contains models you can use. The default value is SASHELP.HPFDFLT.TSFSSELECT.

**PUBLICACCESS**= YES | TRUE | NO | FALSE
specifies whether the project is available to be opened by other users. The default value is NO.

**RECONCILIATION**= reconciliation-method
specifies the reconciliation direction. The default value is TOPDOWN.
Valid values are the following:

- TOPDOWN | TD
- BOTTOMUP | BU
- MIDDLEOUT(BY-variable) | MO(BY-variable) | NO | FALSE

For MIDDLEOUT reconciliation, the BY variable must be supplied in order to specify the reconciliation level.

Examples:
- Top-down reconciliation: RECONCILIATION=TOPDOWN
- Middle-out reconciliation, starting at regionName: RECONCILIATION=MIDDLEOUT(regionName)

To disable reconciliation, specify NO | FALSE.

**REPORTING=** *variable*

- Specifies the reporting (or auxiliary) variable(s). Multiple variable names can be specified, separated by a space.

**RUN=** *YES | TRUE | NO | FALSE*

- Specifies whether to produce forecasts when the project is created. The default value is YES.

**SEASONALITY=** *n*

- Specifies the length of a season. The default value is detected automatically when possible.

**SEASONTEST=** *n | NO | FALSE*

- Specifies the sensitivity of the seasonality test. The default value is 0.01. To disable the test, specify NO | FALSE.

**SETMISSING=** 0 | MISS | AVG | MIN | MED | MAX | FIRST | LAST | PREV | NEXT

- Specifies the missing value interpretation. The default value is MISS.

**START=** *date*

- Specifies the first date to use in data preparation. The date format is DDMMMYYY and the date/time format is DDMMMYYYY:HH:MM:SS. The default value is the earliest date in the input data set.

**TIMEMULTIPLIER=** *n*

- Specifies the multiplier for the value specified as the interval.

**TIMESHIFT=** *n*

- Specifies the offset for the interval.

**TRANSBOXCOX=** *n*

- Specifies the Box-Cox value if the transformation type (transtype) is BOXCOX. The default is 1.

**TRANSOPT=** *MEAN | MEDIAN*

- Specifies the transformation option. The default is MEAN.

**TRANSTYPE=** *AUTO | LOG | NONE | SQRT | LOGISTIC | BOXCOX*

- Specifies the transformation function type.
TRIMMISS= NONE | LEFT | RIGHT | BOTH
specifies the leading/trailing missing value interpretation. The default value is NONE.

UCM= YES | TRUE | NO | FALSE
specifies whether unobserved component models (UCM) should be considered. The default value is NO.

WEEKENDDAYS= 1 | 2 | 3 | 4 | 5 | 6 | 7
specifies which days are the weekend (or inactive) days in the week. Only valid when the interval=WEEKDAY. The days are specified as numbers (1 through 7) representing the days of the week (Sunday through Saturday).

Examples:
To specify Saturday and Sunday: WEEKENDDAYS=17
To specify Friday and Saturday: WEEKENDDAYS=67

ZEROMISS= NONE | LEFT | RIGHT | BOTH
specifies the leading/trailing zero interpretation. The default value is NONE.

Example

%fscreate (projectname=pdl,
user=sasdemo,
password=Password1,
environment=Default,
data=sashelp.pricedata,
id=date,
by=regionName productLine productName,
hierarchy=YES,
var=sale,
input=price discount,
reporting=price1 price2 price3,
accumulate=TOTAL AVG(price) NONE(price1 price3),
aggregate=NONE total(sale) MIN(price1 price3),
disaggregation=EQUALSPLIT,
reconciliation=NO,
publicaccess=YES,
setmissing=last,
zeromiss=left,
trimmiss=right,
back=1,
start=01Feb1998,
interval=MONTH,
seasonality=12,
idformat=MMYY.,
timemultiplier=1,
timeshift=1,
weekenddays=45,
arimax=YES,
esm=YES,
modelselectionlist=sashelp.hpfdflt.tsfsselect,
detectoutliers=YES,
Results

The FSCREATE global macro variable indicates whether the FSCREATE macro finishes successfully or encounters errors:

\&FSCREATE = SUCCESS | ERROR

In addition, there are a series of global macro variables that are populated after a SAS Forecast Server project is created. These macro variables describe the project, and enable additional SAS code to be written in a generic manner to utilize and explore the data that are contained in a SAS Forecast Server project. These macro variables are available to stored process developers. For more information about the macro variables, see “What Is an Internal Report Parameter?”

FSDELARC Macro: Delete an Archived Project

The FSDELARC macro deletes an archived SAS Forecast Server project.

Syntax

The FSDELARC macro has the following form:

%FSDELARC (PROJECTNAME= , ARCHIVENAME= , USER= , PASSWORD= [ , options ] ) ;

Required Arguments

The following arguments must be used with the FSDELARC macro. The required arguments are separated by commas.

PROJECTNAME= project-name

specifies the name of the SAS Forecast Server project. The name must be a valid SAS name.
ARCHIVENAME= archived-project-name
    specifies the file name of the archive that you want to delete the project from (for example, myarchive.far). If the archive name does not end with .far, then the extension is automatically assumed.

USER= username
    specifies the user name that you use to log on to SAS Forecast Studio.

PASSWORD= password
    specifies the user password that you use to log on to SAS Forecast Studio.

Options

The following options can be used with the FSDELARC macro. Options must follow the required arguments and be separated by commas.

ARCHIVEFOLDER= archive-folder-name
    specifies the directory containing the archive to delete. If not specified, the default location is assumed.

ENVIRONMENT= environment-name
    specifies the name of the SAS Forecast Server environment. The default environment is Default.

HOST= host:port
    specifies the host and port number of the SAS Forecast Server middle tier. The default is localhost:6411.

NOWARN= YES / NO
    specifies whether to suppress errors if the SAS Forecast Server project does not exist. The default is NOWARN=NO.

Example

%fsdelarc(projectname=pdl,
    archivename=ArchPD1.far,
    user=sasuser,
    password=saspass,
    host=localhost:6411,
    nowarn=NO
);}

Results

The FSDELARC global macro variable indicates whether the FSDELARC macro finishes successfully or encounters errors:

&FSDELARC = SUCCESS | ERROR
FSDELENV Macro: Deletes a Specified Environment

The FSDELENV macro deletes an environment. When you delete an environment, the metadata and file system content are deleted.

Syntax

The FSDELENV macro has the following form:

\%FSDELENV (ENVIRONMENT= , USER= , PASSWORD= [options]) ;

Required Arguments

The following arguments must be used with the FSDELENV macro. The required arguments are separated by commas.

ENVIRONMENT= project-name
    specifies the name of the SAS Forecast Server environment. The default environment is Default.

USER= username
    specifies the user name that you use to log on to SAS Forecast Studio.

PASSWORD= password
    specifies the user password that you use to log on to SAS Forecast Studio.

Options

The following options can be used with the FSDELENV macro. Options must follow the required arguments and be separated by commas.

HOST= host:port
    specifies the host and port number of the SAS Forecast Server middle tier. The default is localhost:6411.

Example

\%fsdelenv(enviroment=Default,
            user=sasuser,
            password=saspass,
            host=localhost:6411
        );
Results

The FSDELENV global macro variable indicates whether the FSDELENV macro finishes successfully or encounters errors:

\&FSDELENV = SUCCESS | ERROR

FSDELPRJ Macro: Delete an Existing Project

The FSDELPRJ macro deletes one project and, optionally, the related archives contained in the default archiving folder.

Syntax

The FSDELPRJ macro has the following form:

\%FSDELPRJ (PROJECTNAME= , USER= , PASSWORD= [, options ]);  

Required Arguments

The following arguments must be used with the FSDELPRJ macro. The required arguments are separated by commas.

PROJECTNAME= project-name  
  specifies the name of the SAS Forecast Server project. The name must be a valid SAS name.

USER= username  
  specifies the user name that you use to log on to SAS Forecast Studio.

PASSWORD= password  
  specifies the user password that you use to log on to SAS Forecast Studio.

Options

The following options can be used with the FSDELPRJ macro. Options must follow the required arguments and be separated by commas.

DELETEARCHIVES= YES | NO | TRUE | FALSE  
  specifies whether the project archives in the default archive location are to be deleted. Valid values are YES | NO | TRUE | FALSE. By default all archives are deleted with the project.

HOST= host:port  
  specifies the host and port number of the SAS Forecast Server middle tier. The default is localhost:6411.
ENVIROMENT= environment-name
  specifies the name of the SAS Forecast Server environment. The default environment is Default.

NOWARN= YES / NO
  specifies whether to suppress errors if the SAS Forecast Server project does not exist. The default is NOWARN=NO.

Example

%fsdelprj(projectname=prdat4,
   user=sasuser,
   password=saspass
 ) ;

Results

The FSDELPRJ global macro variable indicates whether the FSDELPRJ macro finishes successfully or encounters errors:

&FSDELPRJ = SUCCESS | ERROR

FSEXPELL Macro: Archive All SAS Forecast Server Projects

The FSEXPELL macro exports all SAS Forecast Server projects to archived files.

Syntax

The FSEXPELL macro has the following form:

  %FSEXPELL (USER=, PASSWORD=, OUT= [ , options ] ) ;

Required Arguments

The following arguments must be used with the FSEXPELL macro. The required arguments are separated by commas.

USER= username
  specifies the administrative user name that you use to log on to SAS Forecast Studio. The user must be a SAS administrator.

PASSWORD= password
  specifies the administrative user password that you use to log on to SAS Forecast Studio.
OUT= SAS-data-set
    specifies the fully qualified name of the data set that contains information about the archived
    projects. The format is library.dataset.

Options

The following options can be used with the FSEXPPALL macro. Options must follow the required
arguments and be separated by commas.

ARCHIVEFOLDER= directory-name
    specifies the directory where the archive is to be saved. If not specified, the archives are saved
to project subfolders in the default location for the environment.

CPORT= YES | TRUE | NO | FALSE
    exports data sets and catalogs using CPORT. Use this argument if you unarchive the project
on a different platform. Possible values are YES | TRUE | NO | FALSE. The default is
CPORT=NO.

ENVIRONMENT= environment-name
    specifies the name of the SAS Forecast Server environment. The default environment is
Default.

HOST= host:port
    specifies the host and port number of the SAS Forecast Server middle tier. The default is
localhost:6411.

NAMESUFFIX= string
    specifies a suffix to the name of the archive. The suffix must make the archive name unique. If
an archive with the same name exists, then archiving fails for that project. The default suffix
is _fs_export.

SUBFOLDERS= YES | TRUE | NO | FALSE
    specifies whether archives are saved in subfolders corresponding to project names. If NO, all
archives are saved in the same location. This option has no effect when the ARCHIVEFOLDER
option is not specified. Possible values are YES | TRUE | NO | FALSE. The default is sub-
Folders=NO.

Example

%fsexpall(out=work.projects,
    user=sasadm,
    password=sasadmpass,
    host=localhost:6411,
    namesuffix=_fs_export31,
    );
The FSEXPORT macro archives a single SAS Forecast Server project to an archive file.

**Syntax**

The FSEXPORT macro has the following form:

```
%FSEXPORT (PROJECTNAME=, ARCHIVENAME=, DESCRIPTION=, USER=, PASSWORD= [ , options ]) ;
```

**Required Arguments**

The following arguments must be used with the FSEXPORT macro. The required arguments are separated by commas.

### Results

The FSEXPALL global macro variable indicates whether the FSEXPALL macro finishes successfully or encounters errors:

```
&FSEXPALL = SUCCESS | ERROR
```

The OUT= option produces a SAS data set that contains the following variables:

- **NAME**: specifies the project name.
- **CREATED**: specifies the date/time when the project is created.
- **MODIFIED**: specifies the date/time when the project is last modified.
- **CREATEDBY**: specifies the user ID who created the project initially.
- **OWNEDBY**: specifies the user ID of the project’s owner.
- **LOCKED**: equals 1 if the project is locked (currently opened by another user).
- **CANOPEN**: equals 1 if the user can open the project.
- **CANDELETE**: equals 1 if the user can delete the project.
- **ISPUBLIC**: equals 1 if the project has public access.
- **ARCHIVENAME**: specifies the name of the exported project’s archive file.
- **ARCHIVEFAIL**: equals 1 if an error was detected during archiving the project.

Additionally, archives for all projects are created in the default archive folder. The name of the archives are the name of the project followed by the NAMESUFFIX= parameter.
Chapter 12: The SAS Forecast Server Administrative Macros

PROJECTNAME= project-name
specifies the name of the SAS Forecast Server project. The name must be a valid SAS name.

ARCHIVENAME= archived-project-name
specifies the file name of the archive that you want to export the project into (for example, myarchive.far). If the archive name does not end with .far, then the extension is automatically assumed. Use the ARCHIVEFOLDER parameter to specify a file path to the archive file.

DESCRIPTION= text
specifies a description to assign to the archive. The description is recorded in the Manifest.fs file within the archive. If a comma is present in the description string, the description must be enclosed in quotes.

USER= username
specifies the user name that you use to log on to SAS Forecast Studio.

PASSWORD= password
specifies the user password that you use to log on to SAS Forecast Studio.

Options

The following options can be used with the FSEXPORT macro. Options must follow the required arguments and be separated by commas.

ARCHIVEFOLDER= directory-name
specifies the directory where the archive is to be saved. If not specified, the default location is used.

HOST= host:port
specifies the host and port number of the SAS Forecast Server middle tier. The default is localhost:6411.

ENVIRONMENT= environment-name
specifies the name of the SAS Forecast Server environment. The default environment is Default.

NOWARN= YES / NO
specifies whether to suppress errors if the SAS Forecast Server project does not exist. The default is NOWARN=NO.

CPORT= YES / TRUE / NO / FALSE
exports data sets and catalogs using CPORT. Use this argument if you unarchive the project on a different platform. Possible values are YES / TRUE / NO / FALSE. The default is CPORT=NO.

Example

```sas
%fsexport( projectname=pdl,
                archivename=ArchPD1.far,
```
FSGETENV Macro: Retrieve Environment Information

The FSGETENV macro retrieves information about the SAS Forecast Server environments.

**NOTE:** Only an administrative user can run this macro.

**Syntax**

The FSGETENV macro has the following form:

```
%FSGETENV (OUT=, USER=, PASSWORD= [ , options ] ) ;
```

**Required Arguments**

The following arguments must be used with the FSGETENV macro. The required arguments are separated by commas.

- **OUT= SAS-data-set**
  - Specifies the name of the data set that contains the program results.

- **USER= username**
  - Specifies the user name that you use to log on to SAS Forecast Studio.

- **PASSWORD= password**
  - Specifies the user password that you use to log on to SAS Forecast Studio.

**Options**

You can use the following options with the FSGETENV macro. Options must follow the required arguments and be separated by commas.

---

**Results**

The global macro variable FSEXPORT indicates whether the FSEXPORT macro finishes successfully or encounters errors:

```
&FSEXPORT = SUCCESS | ERROR
```

Also, an archived project with the ARCHIVENAME= file name is created in the default archive folder.
HOST= host:port
   specifies the host and port number of the SAS Forecast Server middle tier. The default is localhost:6411.

WSSERVER= workspace server-name
   specifies the name of the logical workspace server. The default value is SASApp - Logical Workspace Server.

Example

%fsgetenv(out=work.getprojects,
   user=sasuser,
   password=saspass,
   host=localhost:6411,
   wsserver=SASApp - Logical Workspace Server
);

Results

The FSGETENV global macro indicates whether the FSGETENV macro finishes successfully or encounters errors:

&FSGETENV = SUCCESS | ERROR.

The OUT= option produces a SAS data set that contains the following variables:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NAME</td>
<td>specifies the environment name.</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>specifies the description of the environment.</td>
</tr>
<tr>
<td>CREATED</td>
<td>specifies the datetime value when the environment was created.</td>
</tr>
<tr>
<td>MODIFIED</td>
<td>specifies the datetime value when the environment was last modified.</td>
</tr>
<tr>
<td>HOSTNAME</td>
<td>specifies the name of the workspace server used by the environment.</td>
</tr>
<tr>
<td>REPORTSROOT</td>
<td>specifies the SAS metadata folder where the stored process metadata objects are stored.</td>
</tr>
<tr>
<td>CONTENTPATH</td>
<td>specifies the file system path that is associated with the environment.</td>
</tr>
<tr>
<td>VERSION</td>
<td>specifies the version of the SAS Forecast Server that the environment uses.</td>
</tr>
</tbody>
</table>

FSGETPRJ Macro: Retrieve Project Information

The FSGETPRJ macro retrieves information about the SAS Forecast Server projects.
Syntax

The FSGETPRJ macro has the following form:

\[
%\text{FSGETPRJ} \ ( \text{OUT} = , \text{USER} = , \text{PASSWORD} = [ , \text{options} ] ) ;
\]

Required Arguments

The following arguments must be used with the FSGETPRJ macro. The required arguments are separated by commas.

\text{OUT} = \text{SAS-data-set}

specifies the name of the data set that contains the program results.

\text{USER} = \text{username}

specifies the user name that you use to log on to SAS Forecast Studio.

\text{PASSWORD} = \text{password}

specifies the user password that you use to log on to SAS Forecast Studio.

Options

You can use the following options with the FSGETPRJ macro. Options must follow the required arguments and be separated by commas.

\text{HOST} = \text{host:port}

specifies the host and port number of the SAS Forecast Server middle tier. The default is localhost:6411.

\text{ENVIRONMENT} = \text{environment-name}

specifies the name of the SAS Forecast Server environment. The default environment is Default.

\text{PRINTVERSIONONLY} = 0 / 1

When PRINTVERSIONONLY=1, it prints the version to the log and exits.

Example

\[
%\text{fsgetprj} ( \text{out=work.getprojects},
\text{ user=sasuser,}
\text{ password=saspass}
\ ) ;
\]

Results

The FSGETPRJ global macro indicates whether the FSGETPRJ macro finishes successfully or encounters errors:
&FSGETPRJ = SUCCESS | ERROR.

The OUT= option produces a SAS data set that contains the following variables:

- **NAME**: specifies the project name.
- **CREATED**: specifies the date/time when the project is created.
- **MODIFIED**: specifies the date/time when the project is last modified.
- **CREATEDBY**: specifies the user ID who created the project initially.
- **OWNEDBY**: specifies the user ID of the project’s owner.
- **LOCKED**: equals 1 if the project is locked (currently opened by another user).
- **CANOPEN**: equals 1 if the user can open the project.
- **CANDELETE**: equals 1 if the user can delete the project.
- **ISPUBLIC**: equals 1 if the project has public access.

### FSGETURP Macro: Generates a List of Unregistered Project Names

The FSGETURP macro creates a list of unregistered project names in a specified environment. To register the projects, you can use these project names generated by FSGETURP as input to the FSREGPRJ macro.

#### Syntax

The FSGETURP macro has the following form:

```
%FSGETURP (USER=, PASSWORD=, ENVIRONMENT= [ , options ]) ;
```

#### Required Arguments

The following arguments must be used with the FSGETURP macro. The required arguments are separated by commas.

- **USER= username**: specifies the user name that you use to log on to SAS Forecast Studio.
- **PASSWORD= password**: specifies the user’s password that you use to log on to SAS Forecast Studio.
- **ENVIRONMENT= environment-name**: specifies the name of the SAS Forecast Server environment.
Options

You can use the following options with the FSGETURP macro. Options must follow the required arguments and be separated by commas.

HOST= host:port

specifies the host and port number of the SAS Forecast Server middle tier. The default is localhost:6411.

Example

```sas
%fsgeturp(user=sasadm,
           password=Password1,
           environment=Default,
           host=localhost:6411
           );
```

Results

The FSGETURP global macro variable indicates whether the FSGETURP macro finishes successfully or encounters errors:

\&FSGETURP = SUCCESS | ERROR

FSIMPALL Macro: Import all Archived Projects

The FSIMPALL macro imports all of the SAS Forecast Server archived files listed in the PROJECTDS= data set.

Syntax

The FSIMPALL macro has the following form:

```sas
%FSIMPALL (PROJECTDS=, ARCHIVEFOLDER=, USER=, PASSWORD= [ , options ] ) ;
```

Required Arguments

The following arguments must be used with the FSIMPALL macro. The required arguments are separated by commas.

PROJECTDS= SAS-data-set

specifies the SAS data set containing the list of the SAS Forecast Server projects to import. It can be a fully qualified data set name in the form library.dataset. Typically, the PROJECTDS= data set is created using the OUT= option of the FSEXPALL macro.
The PROJECTDS= data set must be a SAS data set that contains the following variables:

- **NAME** specifies the SAS Forecast Studio project name.
- **ARCHIVENAME** specifies the name of the archive.
- **ARCHIVEFAIL** (optional) equals 1 if an error was detected during archiving. If ARCHIVEFAIL is included, only the archives for which ARCHIVEFAIL=0 are imported.

**ARCHIVEFOLDER=** directory-name
specifies the folder on the SAS Workspace Server containing the archived projects (for example, C:\SAS\ForecastStudio\Archives).

**USER=** username
specifies the user name that you use to log on to SAS Forecast Studio.

**PASSWORD=** password
specifies the user password that you use to log on to SAS Forecast Studio.

**Options**

You can use the following options with the FSIMPALL macro. Options must follow the required arguments and be separated by commas.

- **HOST=** host:port
  specifies the host and port number of the SAS Forecast Server middle tier. The default is localhost:6411.

- **ENVIRONMENT=** environment-name
  specifies the name of the SAS Forecast Server environment. The default environment is Default.

- **NOWARN=** YES | NO
  specifies whether to suppress errors if the SAS Forecast Server project does not exist. The default is NOWARN=NO.

- **SUBFOLDERS=** YES | TRUE | NO | FALSE
  specifies whether archives are stored in subfolders corresponding to project names within the specified archive folder location. If NO, all archives are assumed to be located in the archive folder location. Possible values are YES | TRUE | NO | FALSE. The default is subFolders=NO.

**Example**

```sas
%fsimpall(projectds=work.projects,
          archivefolder=\sourceserver\SAS\ForecastStudio\Archives,
          user=sasdemo,
          password=Password1
       );
```
Results

The FSIMPALL global macro variable indicates whether the FSIMPALL macro finishes successfully or encounters errors:

&FSIMPALL = SUCCESS | ERROR

**NOTE:** FSIMPALL does not migrate 2.1 projects to the current version. However, you can use the FSMIGALL macro to accomplish that. For an example that uses FSIMPALL, see “Separate Middle Tiers Migration of SAS Forecast Server 2.1 Projects to SAS Forecast Server 3.1.”

---

**FSIMPORT Macro: Import an Archived Project**

The FSIMPORT macro imports a SAS Forecast Server archived file.

**Syntax**

The FSIMPORT macro has the following form:

```sas
%FSIMPORT (PROJECTNAME=, ARCHIVEPATH=, USER=, PASSWORD= [ , options ] ) ;
```

**Required Arguments**

The following arguments must be used with the FSIMPORT macro. The required arguments are separated by commas.

- **PROJECTNAME**= *project-name*
  specifies the name of the SAS Forecast Server project. The name must be a valid SAS name.

- **ARCHIVEPATH**= *directory-name*
  specifies the location of the archived project.

- **USER**= *username*
  specifies the user name that you use to log on to SAS Forecast Studio.

- **PASSWORD**= *password*
  specifies the user password that you use to log on to SAS Forecast Studio.

**Options**

You can use the following options with the FSIMPORT macro. Options must follow the required arguments and be separated by commas.

- **HOST**= *host:port*
  specifies the host and port number of the SAS Forecast Server middle tier. The default is localhost:6411.
**ENVIRONMENT=** *environment-name*

specifies the name of the SAS Forecast Server environment. The default environment is Default.

**NOWARN= YES / NO**

specifies whether to suppress errors if the SAS Forecast Server project does not exist. The default is NOWARN=NO.

**Example**

```sas
%fsimport (projectname=prdat2, 
           archivepath=C:\SAS\ForecastStudio\Archives\pd1\ArchPD1.far, 
           user=sasuser, 
           password=saspass 
          );
```

**Results**

The FSIMPORT global macro variable indicates whether the FSIMPORT macro finishes successfully or encounters errors:

&FSIMPORT = SUCCESS | ERROR

---

**FSLOAD Macro: Open a Project and Load Global Macro Variables**

The FSLOAD macro opens an existing SAS Forecast Server project, and loads global macro variables that describe the project.

**Syntax**

The FSLOAD macro has the following form:

```
%FSLOAD (PROJECTNAME=, USER=, PASSWORD= [, options ] );
```

**Required Arguments**

The following arguments must be used with the FSLOAD macro. The required arguments are separated by commas.

**PROJECTNAME=** *project-name*

specifies the name of the SAS Forecast Server project. The name must be a valid SAS name.

**USER=** *username*

specifies the user name that you use to log on to SAS Forecast Studio.
PASSWORD= password
    specifies the user password that you use to log on to SAS Forecast Studio.

Options

You can use the following options with the FSLOAD macro. Options must follow the required arguments and be separated by commas.

HOST= host:port
    specifies the host and port number of the SAS Forecast Server middle tier. The default is localhost:6411.

ENVIRONMENT= environment-name
    specifies the name of the SAS Forecast Server environment. The default environment is Default.

Example

%fsload(projectname=pd1,
    user=sasuser,
    password=saspass
);

Results

The global macro variable FSLOAD indicates whether the FSLOAD macro finishes successfully or encounters errors:

&FSLOAD = SUCCESS | ERROR

In addition, there are a series of global macro variables that are populated after a SAS Forecast Server project is loaded. These macro variables describe the project, and enable additional SAS code to be written in a generic manner in order to use and explore the data that are contained in a SAS Forecast Server project. These macro variables are available to stored process programs. For more information about the macro variables, see “What Is an Internal Report Parameter?”

FSMIGALL Macro: Updates all Projects to Current SAS Forecast Server Version

The FSMIGALL macro updates all registered projects to the current version of SAS Forecast Server.

NOTE: This macro updates only projects created with SAS Forecast Server 2.1. You cannot use this macro to update projects created with SAS Forecast Server 1.4 directly to SAS Forecast Server 3.1. You must first upgrade these projects to use SAS Forecast Server 2.1. For more information about upgrading, see “Upgrading from SAS Forecast Server 2.1 to SAS Forecast Server 3.1.”
Syntax

The FSMIGALL macro has the following form:

```%FSMIGALL (USER=, PASSWORD=, OUT= [, options ] );```

**Required Arguments**

The following arguments must be used with the FSMIGALL macro. The required arguments are separated by commas.

- **USER=** `username`
  specifies the user name that you use to log on to SAS Forecast Studio. The user must be a SAS administrator.

- **PASSWORD=** `password`
  specifies the user password that you use to log on to SAS Forecast Studio.

- **OUT=** `SAS-data-set`
  specifies the fully qualified name of the data set which will contains information regarding the archived projects. The format is library.dataset.

**Options**

You can use the following options with the FSMIGALL macro. Options must follow the required arguments and be separated by commas.

- **HOST=** `host:port`
  specifies the host and port number of the SAS Forecast Server middle tier. The default is localhost:6411.

- **ENVIRONMENT=** `environment-name`
  specifies the name of the SAS Forecast Server environment. The default environment is `Default`.

**Example**

```%fsmigall(user=sasdemo,
    password=Password1,
    out=work.migrated,
);```

**Results**

The global macro variable FSMIGALL indicates whether the FSMIGALL macro finishes successfully or encounters errors:

```
&FSMIGALL = SUCCESS | ERROR
```
FSMIGPRJ Macro: Updates a Project to Current SAS Forecast Server Version

The FSMIGPRJ macro updates an existing SAS Forecast Server project to the current version of SAS Forecast Server.

**Note:** This macro updates only projects created with SAS Forecast Server 2.1. You cannot use this macro to update projects created with SAS Forecast Server 1.4 directly to SAS Forecast Server 3.1. You must first upgrade these projects to use SAS Forecast Server 2.1. For more information about upgrading, see “Upgrading from SAS Forecast Server 2.1 to SAS Forecast Server 3.1.”

**Syntax**

The FSMIGPRJ macro has the following form:

```
%FSMIGPRJ (PROJECTNAME=, USER=, PASSWORD= [ , options ] ) ;
```

**Required Arguments**

The following arguments must be used with the FSMIGPRJ macro. The required arguments are separated by commas.

- `PROJECTNAME=` *project-name*
  specifies the name of the SAS Forecast Server project. The name must be a valid SAS name.

- `USER=` *username*
  specifies the user name that you use to log on to SAS Forecast Studio.

- `PASSWORD=` *password*
  specifies the user password that you use to log on to SAS Forecast Studio.

The `OUT=` option produces a SAS data set that contains the following variables:

- **NAME** specifies the project name.
- **CREATED** specifies the date/time when the project is created.
- **MODIFIED** specifies the date/time when the project is last modified.
- **CREATEDBY** specifies the user ID who created the project initially.
- **OWNEDBY** specifies the user ID of the project’s owner.
- **LOCKED** equals 1 if the project is locked (currently opened by another user).
- **CANOPEN** equals 1 if the user can open the project.
- **CANDELETE** equals 1 if the user can delete the project.
- **ISPUBLIC** equals 1 if the project has public access.
- **ISMIGRATED** equals 1 if the project was successfully migrated.
**Chapter 12: The SAS Forecast Server Administrative Macros**

**Options**

The following options can be used with the FSMIGPRJ macro. Options must follow the required arguments and be separated by commas.

**HOST=** *host:port*

specifies the host and port number of the SAS Forecast Server middle tier. The default is localhost:6411.

**ENVIRONMENT=** *environment-name*

specifies the name of the SAS Forecast Server environment. The default environment is Default.

**Example**

```sas
%fsmigprj(projectname=pdl,
      user=sasuser,
      password=saspass
    );
```

**Results**

The global macro variable FSMIGPRJ indicates whether the FSMIGPRJ macro finishes successfully or encounters errors:

```
&FSMIGPRJ = SUCCESS | ERROR
```

---

**FSMOVE Macro: Move a Project to a Different Location**

The FSMOVE macro moves a SAS Forecast Server project to a new destination.

**Syntax**

The FSMOVE macro has the following form:

```
%FSMOVE (SOURCEPROJECTNAME=, DESTINATIONPROJECTNAME=, USER=, PASSWORD=, ARCHIVEPATH=, REMOTEARCHIVEFOLDER= [ , options ] )
```

**Required Arguments**

The following arguments must be used with the FSMOVE macro. The required arguments are separated by commas.
SOURCEPROJECTNAME= source-project-name
specifies the name of the SAS Forecast Server project on the source host. The name must be a valid SAS name.

DESTINATIONPROJECTNAME= destination-project-name
specifies the name of the SAS Forecast Server project on the destination host. The name must be a valid SAS name.

USER= username
specifies the user name that you use to log on to SAS Forecast Studio.

PASSWORD= password
specifies the user’s password that you use to log on to SAS Forecast Studio.

REMOTEARCHIVEFOLDER= project-name
specifies the folder location of the archived project on the destination SAS Workspace Server. For example, "\\sourceserver\SAS\ForecastStudio\Archives".

SOURCEENVIRONMENT= environment-name
specifies the name of the SAS Forecast Server environment to be used as source. It is required only if there are multiple environments available to the user.

DESTINATIONENVIRONMENT= environment-name
specifies the name of the SAS Forecast Server environment to be used as destination. It is required only if there are multiple environments available to the user.

Options

The following options can be used with the FSMOVE macro. Options must follow the required arguments and be separated by commas.

ARCHIVEFOLDER= directory-name
specifies the directory to save the archive in. If not specified, the default location is used.

CPORT= YES | TRUE | NO | FALSE
exports data sets and catalogs using CPORT. Needed if the source and destination are running on different operating systems. Possible values are YES | TRUE | NO | FALSE. The default is CPORT=NO.

HOST= value
specifies the host and port of the SAS Forecast Server middle tier. The default is localhost:6411.

NOWARN= YES | NO
suppresses errors if the SAS Forecast Server project does not exist. Possible values are YES | NO. The default is NOWARN=NO.

TMPARCHIVENAME= value
specifies the name of the temporary archived project. The default is _fs_tmp_archive. The name must not match an existing archive.
Example

```%
%fsmove(sourceprojectname=prdat1,
   destinationprojectname=prdat2,
   user=sasadm,
   password=saspass,
   remoteArchiveFolder=C:\SAS\ForecastStudio\Archives,
   sourceEnvironment=Default,
   destinationEnvironment=Default,
);%
```

Results

The FSMOVE global macro variable indicates whether the FSMOVE macro finishes successfully or encounters errors:

```
&FSMOVE = SUCCESS | ERROR
```

FSNEWENV Macro: Create a New SAS Forecast Server Environment

The FSNEWENV macro creates a new SAS Forecast Server environment.

**NOTE:** Only an administrative user can run this macro.

Syntax

The FSNEWENV macro has the following form:

```
%FSNEWENV (ENVIRONMENT=, USER=, PASSWORD=, PATH=, REPORTSPATH= [ , options ] );
```

**Required Arguments**

The following arguments must be used with the FSNEWENV macro. The required arguments are separated by commas.

**ENVIRONMENT=** `environment-name`

specifies the name of the new SAS Forecast Server environment.

**USER=** `username`

specifies the user name that you use to log on to SAS Forecast Studio.

**PASSWORD=** `password`

specifies the user password that you use to log on to SAS Forecast Studio.
PATH= file path
specifies the absolute file path to the base content directory on the specified workspace server.

REPORTSPATH= UNIX style path
specifies an absolute path written in UNIX style to the base SAS Folder in metadata (for example, /MyContent/Reports) at which searches for reports will start.

**Options**
You can use the following options with the FSNEWENV macro. Options must follow the required arguments and be separated by commas.

DESC= text
specifies the environment description.

HOST= host:port
specifies the host and port number of the SAS Forecast Server middle tier. The default is localhost:6411.

WSSERVER= workspace server-name
specifies the name of the logical workspace server. The default value is SASAPP - Logical Workspace Server.

**Example**

```sas
%fsnewenv(environment=Default, user=sasuser, password=saspass, desc=A new environment, path=C:\FSEnvironment, reportspath=/MyContent/Reports, host=localhost:6411, wsserver=SASApp - Logical Workspace Server);
```

**Results**
The FSNEWENV global macro indicates whether the FSNEWENV macro finishes successfully or encounters errors:

FSNEWENV = SUCCESS | ERROR
FSREGENV Macro: Create a New SAS Forecast Server Environment and Register Projects

The FSREGENV macro registers an existing directory structure as an environment, optionally registering all projects found within.

**NOTE:** Only an administrative user can run this macro.

**Syntax**

The FSREGENV macro has the following form:

```
%FSREGENV (ENVIRONMENT=, USER=, PASSWORD=, PATH=, REPORTSPATH= [ , options ] ) ;
```

**Required Arguments**

The following arguments must be used with the FSREGENV macro. The required arguments are separated by commas.

- **ENVIRONMENT=**  
  `environment-name`  
  specifies the name of the new SAS Forecast Server environment.

- **USER=**  
  `username`  
  specifies the user name that you use to log on to SAS Forecast Studio.

- **PASSWORD=**  
  `password`  
  specifies the user password that you use to log on to SAS Forecast Studio.

- **PATH=**  
  `file path`  
  specifies the absolute file path to the base content directory on the specified workspace server.

- **REPORTSPATH=**  
  `UNIX style path`  
  specifies an absolute path written in UNIX style to the base SAS Folder in metadata (for example, `/MyContent/Reports`) at which searches for reports will start.

**Options**

You can use the following options with the FSREGENV macro. Options must follow the required arguments and be separated by commas.

- **DESC=**  
  `text`  
  specifies the environment description.

- **HOST=**  
  `host:port`  
  specifies the host and port number of the SAS Forecast Server middle tier. The default is localhost:6411.
**WSSERVER=** workspace server-name  
specifies the name of the logical workspace server. The default value is SASAPP - Logical Workspace Server.

**REGISTERPROJECTS=** YES | TRUE | NO | FALSE  
specifies whether to register in metadata any existing projects in the environment. Possible values are YES | TRUE | NO | FALSE. The default is REGISTERPROJECTS=YES.

### Example

```sas
%fsregenv(environment=Default,  
    user=sasuser,  
    password=saspass,  
    desc=A new environment,  
    path=C:\FSEnvironment,  
    reportspath=/MyContent/Reports,  
    host=localhost:6411,  
    wsserver=SASApp - Logical Workspace Server  
    registerprojects=no  
);  
```

### Results

The FSREGENV global macro indicates whether the FSREGENV macro finishes successfully or encounters errors:  

```
&FSREGENV = SUCCESS | ERROR  
```

---

### FSREGPRJ Macro: Register a Project in Metadata

The FSREGPRJ macro registers project information in metadata.

#### Syntax

The FSREGPRJ macro has the following form:

```
%FSREGPRJ (PROJECTNAME=, PASSWORD= [ , options ] ) ;  
```

#### Required Arguments

The following arguments must be used with the FSREGPRJ macro. The required arguments are separated by commas.

**PROJECTNAME=** project-name  
specifies the name of the SAS Forecast Server project. The name must be a valid SAS name.
**PASSWORD**= password

specifies the user’s password that you use to log on to SAS Forecast Studio.

**Options**

You can use the following options with the FSREGPRJ macro. Options must follow the required arguments and be separated by commas.

**USER**= username

specifies the user name that you use to log on to SAS Forecast Studio. The user must be a SAS administrator. The default is sasadm.

**ENVIRONMENT**= environment-name

specifies the name of the SAS Forecast Server environment. The default environment is Default.

**HOST**= host:port

specifies the host and port number of the SAS Forecast Server middle tier. The default is localhost:6411.

**Example**

```
%fsregprj(projectname=ProjectA,
          user=sasadm,
          password=Password1,
          environment=Default,
          host=localhost:6411
);
```

**Results**

The FSREGPRJ global macro variable indicates whether the FSREGPRJ macro finishes successfully or encounters errors:

`&FSREGPRJ = SUCCESS | ERROR`

---

**FSREN Macro: Rename a SAS Forecast Server Project**

The FSREN macro renames a SAS Forecast Server project.

**Syntax**

The FSREN macro has the following form:

```
%FSREN (PROJECTNAME=, NEWPROJECTNAME=, USER=, PASSWORD= [ , options ]);
```
**FSREN Macro: Rename a SAS Forecast Server Project**

### Required Arguments

The following arguments must be used with the FSREN macro. The required arguments are separated by commas.

- **PROJECTNAME=** *project-name*
  
  specifies the name of the SAS Forecast Server project. The name must be a valid SAS name.

- **NEWPROJECTNAME=** *project-name*
  
  specifies the new name of the SAS Forecast Server project. The name must be a valid SAS name.

- **USER=** *username*
  
  specifies the user name that you use to log on to SAS Forecast Studio.

- **PASSWORD=** *password*
  
  specifies the user password that you use to log on to SAS Forecast Studio.

### Options

You can use the following options with the FSREN macro. Options must follow the required arguments and be separated by commas.

- **HOST=** *host:port*
  
  specifies the host and port number of the SAS Forecast Server middle tier. The default is localhost:6411.

- **ENVIRONMENT=** *environment-name*
  
  specifies the name of the SAS Forecast Server environment. The default environment is Default.

- **NOWARN=** *YES | NO*
  
  specifies whether to suppress errors if the SAS Forecast Server project does not exist. The default is NOWARN=NO.

### Example

```sas
%fsren(projectname=prdat3,
  newprojectname=prdat4,
  user=sasuser,
  password=saspass
);
```

### Results

The FSREN global macro variable indicates whether the FSREN macro finishes successfully or encounters errors:

```
&FSREN = SUCCESS | ERROR
```
FSRUNPRJ Macro: Open and Run a Project at a Given Stage

The FSRUNPRJ macro opens an existing SAS Forecast Server project, and runs the project at a given stage.

Syntax

The FSRUNPRJ macro has the following form:

```
%FSRUNPRJ ( PROJECTNAME=, USER=, PASSWORD=, METHOD=, IMPORTDATA= [ , options ] ) ;
```

Required Arguments

The following arguments must be used with the FSRUNPRJ macro. The required arguments are separated by commas.

```
PROJECTNAME= project-name
```
specifies the name of the SAS Forecast Server project. The name must be a valid SAS name.

```
USER= username
```
specifies the user name that you use to log on to SAS Forecast Studio.

```
PASSWORD= password
```
specifies the user password that you use to log on to SAS Forecast Studio.

```
METHOD= method-name
```
specifies the run method.

Valid values are the following:

CREATE | DESTRUCTIVE-DIAGNOSE | DIAGNOSE | SELECT | FIT | FORECAST | RECONCILE | OVERRIDES | CURRENT

```
IMPORTDATA= YES | TRUE | NO | FALSE
```
specifies whether new data should be imported from the input data set. The default value is NO.

Options

You can use the following options with the FSRUNPRJ macro. Options must follow the required arguments and be separated by commas.

```
HOST= host:port
```
specifies the host and port number of the SAS Forecast Server middle tier. The default is localhost:6411.
**LEAD= n**

specifies the number of periods into the future which multi-step forecasts are made. The default value is 12.

**ENVIRONMENT= environment-name**

specifies the name of the SAS Forecast Server environment. The default environment is Default.

**RETAINCHOOSE= YES | TRUE | NO | FALSE**

clears any user-specified model selections and resets the series to automatic model selection. Valid values are YES | TRUE | NO | FALSE. The default value is YES.

**Example**

```sas
%fsrunprj(projectname=pd1,
    user=sasuser,
    password=saspass,
    host=localhost:6411,
    method=FORECAST,
    importdata=NO,
    retainchoose=YES
);
```

**Results**

The FSRUNPRJ global macro variable indicates whether the FSRUNPRJ macro finishes successfully or encounters errors:

```
&FSRUNPRJ = SUCCESS | WARNING | ERROR
```

**NOTE:** A warning message displays if there are override conflicts or reconciliation failures.

In addition, there are a series of global macro variables that are populated after a SAS Forecast Server project is loaded. These macro variables describe the project, and enable additional SAS code to be written in a generic manner to use and explore the data that are contained in a SAS Forecast Server project. These macro variables are available to stored process programs. For more information about the macro variables, see “What Is an Internal Report Parameter?”

---

**FSSETOWN Macro: Assign the Owner of a Project**

The FSSETOWN macro assigns the owner to a SAS Forecast Server project.

**NOTE:** Only an administrative user can run this macro.
Chapter 12: The SAS Forecast Server Administrative Macros

Syntax

The FSSETOWN macro has the following form:

%FSSETOWN (PROJECT=, OWNER=, USER=, PASSWORD= [ , options ] ) ;

Required Arguments

The following arguments must be used with the FSSETOWN macro. The required arguments are separated by commas.

**PROJECT= project-name**

specifies the name of the SAS Forecast Server project. The name must be a valid SAS name.

**OWNER= username**

specifies the user name to be assigned ownership of the SAS Forecast Server project.

This parameter value is derived from a user’s logon ID as follows:

1. The last occurrence of the @ character is searched for. If it is found, all characters, including and after the @ character are removed. This step handles a format, such as username@domain.
2. If the \ character is not found, the first occurrence of the \ or / characters are searched for. If either character is found, all characters preceding and including the \ or / characters are removed. This step handles formats, such as domain\username and domain/username.
3. All non-letter and digit characters in the remaining string are converted to the underscore character.

**NOTE:** For most users, this value is the logon ID without the domain.

**USER= username**

specifies the user name that you use to log on to SAS Forecast Studio.

**PASSWORD= password**

specifies the user password that you use to log on to SAS Forecast Studio.

Options

You can use the following options with the FSSETOWN macro. Options must follow the required arguments and be separated by commas.

**ENVIRONMENT= environment-name**

specifies the name of the SAS Forecast Server environment. The default environment is Default.

**HOST= host:port**

specifies the host and port number of the SAS Forecast Server middle tier. The default is localhost:6411.
Example

```fortran
%fssetown(project=Project3,
owner=sastrust,
user=sasadm,
password=sasadmpass,
environment=Default
);
```

Results

The FSSETOWN global macro variable indicates whether the FSSETOWN macro finishes successfully or encounters errors:

```
&FSSETOWN = SUCCESS | ERROR
```

FSSETPUB Macro: Enable Public Access

The FSSETPUB macro enables public access to a SAS Forecast Server project.

**NOTE:** Only an administrative user can run this macro.

Syntax

The FSSETPUB macro has the following form:

```
%FSSETPUB (PROJECT=, ISPUBLIC=, USER=, PASSWORD= [ , options ] ) ;
```

**Required Arguments**

The following arguments must be used with the FSSETPUB macro. The required arguments are separated by commas.

**PROJECT=**  
*project-name*  
specifies the name of the SAS Forecast Server project. The name must be a valid SAS name.

**ISPUBLIC=**  
*TRUE | FALSE | YES | NO*  
specifies if the project should have public access.

**USER=**  
*username*  
specifies the user name that you use to log on to SAS Forecast Studio.

**PASSWORD=**  
*password*  
specifies the user password that you use to log on to SAS Forecast Studio.
**Options**

The following options can be used with the FSSETPUB macro. Options must follow the required arguments and be separated by commas.

**HOST= host:port**
- specifies the host and port number of the SAS Forecast Server middle tier. The default is localhost:6411.

**ENVIRONMENT= environment-name**
- specifies the name of the SAS Forecast Server environment. The default environment is Default.

**Example**

```sas
%fssetpub(project=Project3,
   ispublic=YES,
   user=sasadm,
   password=sasadmpass,
   environment=Default
 );
```

**Results**

The FSSETPUB global macro variable indicates whether the FSSETPUB macro finishes successfully or encounters errors:

```
&FSSETPUB = SUCCESS | ERROR
```

**NOTE:** If the FSSETPUB macro is used on a project created with an older version of SAS Forecast Server, then the project is converted to the current version.

---

**FSUNREG Macro: Unregister a Project from the SAS Metadata Server**

The FSUNREG macro unregisters an existing SAS Forecast Server project from the metadata server. The project files will not be deleted from the disk. If needed, you can register the project again from the project files.

**NOTE:** Only an administrative user can run this macro.

**Syntax**

The FSUNREG macro has the following form:

```sas
%FSUNREG (PROJECTNAME=, PASSWORD= [ , options ] ) ;
```
**Required Arguments**

The following arguments must be used with the FSUNREG macro. The required arguments are separated by commas.

**PROJECTNAME=** *project-name*

specifies the name of the SAS Forecast Server project. The name must be a valid SAS name.

**PASSWORD=** *password*

specifies the user password that you use to log on to SAS Forecast Studio.

**Options**

The following options can be used with the FSUNREG macro. Options must follow the required arguments and be separated by commas.

**USER=** *username*

specifies the user name that you use to log on to SAS Forecast Studio. The user must be a SAS administrator.

**HOST=** *host:port*

specifies the host and port number of the SAS Forecast Server middle tier. The default is localhost:6411.

**ENVIRONMENT=** *environment-name*

specifies the name of the SAS Forecast Server environment. The default environment is Default.

**Example**

```sas
%fsunreg(projectname=prdat2, 
    user=sasadm, 
    password=sasadmpass
); 
```

**Results**

The FSUNREG global macro variable indicates whether the FSUNREG macro finishes successfully or encounters errors:

`&FSUNREG = SUCCESS | ERROR`

---

**FSURGENV Macro: Unregister an Environment**

The FSURGENV macro unregisters a SAS Forecast Server environment. Unregistering an environment removes the existing SAS Forecast Server projects and environment from the metadata server.
without deleting the project files from the disk. You can use the `FSREGENV` macro to create an environment and register its projects.

**Syntax**

The FSURGENV macro has the following form:

```%FSURGENV (ENVIRONMENT=, USER=, PASSWORD= [ , options ] ) ;```

**Required Arguments**

The following arguments must be used with the FSURGENV macro. The required arguments are separated by commas.

- **ENVIRONMENT=** `environment-name`
  - specifies the name of the SAS Forecast Server environment. The default environment is Default.

- **USER=** `username`
  - specifies the user name that you use to log on to SAS Forecast Studio.

- **PASSWORD=** `password`
  - specifies the user’s password that you use to log on to SAS Forecast Studio.

**Options**

You can use the following options with the FSURGENV macro. Options must follow the required arguments and be separated by commas.

- **HOST=** `host:port`
  - specifies the host and port of the SAS Forecast Server middle tier. The default is localhost:6411.

- **WSSERVER=** `workspace server-name`
  - specifies the name of the logical workspace server. The default value is SASApp - Logical Workspace Server.

**Example**

```%fsurgenv (environment=Default, 
   user=sasadm, 
   password=Password1, 
   host=localhost:6411, 
   wsserver=SASApp - Logical Workspace Server 
) ;```
Results

The FSURGENV global macro indicates whether the FSURGENV macro finishes successfully or encounters errors:

&FSURGENV = SUCCESS | ERROR

Examples: Forecast Server Batch Macros

Separate Middle Tiers Migration of SAS Forecast Server 2.1 Projects to SAS Forecast Server 3.1

This example explains how to batch update projects created with SAS Forecast Server 2.1 to a SAS Forecast Server 3.1 middle tier host installation on a separate machine. This example assumes the following:

- Both middle tier hosts are running Microsoft Windows.
- All SAS products are installed in their default installation folders.
- The name of the machine hosting the SAS Forecast Server 2.1 middle tier is fs21.
- The name of the machine hosting the SAS Forecast Server 3.1 middle tier is fs31.
- The project archive folder on fs21 is C:\SAS\ForecastStudio\Archives.
- The project archive folder is accessible on fs31 using the \fs21\SAS\ForecastStudio\Archives path.
- The SAS administrator user ID is sasadm on both machines.
- The SAS administrator password is sasadmpass on both machines.

To migrate the SAS Forecast Server 2.1 projects:

1. If you have not done so, install the SAS Forecast Server macros on the SAS Forecast Server 2.1 middle tier. The macros are automatically installed on the SAS Forecast Server 3.1 middle tier. For more information about installing these macros for version 2.1, see the SAS Forecast Server 2.1 Administrator’s Guide.

2. Archive the projects on fs21:
   a) Open SAS in Display Manager mode on fs21.
   b) Define the library where the OUT= data set is written. Both hosts must have access to the library. This example uses the Archive folder on fs21.
libname migrate 'C:\SAS\ForecastStudio\Archives\';

c) Submit the following SAS code to execute the FSEXPELL macro and export (archive) all projects:

```sas
%fsexpall(out=migrate.projects,
user=sasadm,
password=sasadmpass,
host=localhost:5099,
namesuffix=_fs_export21
);
```

Use the NAMESUFFIX= parameter to make the archive names unique. If an archive with the same name exists, then the archiving process fails for that project.

d) To verify that the projects were archived successfully, open the migrate.projects data set and review the ARCHIVEFAIL variable. ARCHIVEFAIL equals 0 if the project was successfully archived. For more information about the FSEXPELL global macro variables, see “FSEXPELL - Results.”

3. Import all projects to fs31:

a) Open SAS in Display Manager mode on fs31.
b) Define the library that contains the PROJECTDS= data set.

```sas
libname migrate '\fs21\SAS\ForecastStudio\Archives\';
```
c) Run the FSIMPALL macro to import all projects. This macro creates the project data folders and registers the projects with the SAS Metadata Server.

```sas
%fsimpall(projectds=migrate.projects,
archivefolder=\fs21\SAS\ForecastStudio\Archives,
user=sasadm,
password=sasadmpass,
host=localhost:6411,
environment=default
);
```

**NOTE:** The localhost port value reflects the port assigned in a default installation for the SAS Analytics Platform server.

d) Migrate all projects to the current version using the FSMIGALL macro:

```sas
%fsmigall(out=work.migration,
user=sasadm,
password=sasadmpass
);
```

As an alternative to FSMIGALL, you can use the FSMIGPRJ macro to migrate single projects. For more information, see “FSMIGPRJ.” If a project has not been migrated, then SAS Forecast Studio prompts you to do so the first time that the project is opened.
**NOTE:** You can also migrate single projects or migrate projects in batch using the SAS Forecast Server Plug-in for SAS Management Console.

e) To verify that all of the projects were successfully migrated, open the work.migration data set and review the ISMIGRATED variable. ISMIGRATED equals 1 if the project was successfully migrated.

---

### In-place Migration of SAS Forecast Server 2.1 Projects to SAS Forecast Server 3.1

If you have upgraded the SAS Forecast Server middle tier on the current machine to SAS Forecast Server 3.1, you can use the FSMIGALL macro to migrate all of the projects registered in the SAS Metadata Server.

**NOTE:** Before following this example, you must create an environment and configure it to point to the old project location. You can use the SAS Forecast Server Plug-in for SAS Management Console to create and configure the environment. For more information, see the Help for the SAS Forecast Server Plug-in for SAS Management Console in SAS Management Console.

Alternatively, you can use the FSMIGPRJ macro to migrate single projects. For more information, see “FSMIGPRJ.” If a project has not been migrated, then SAS Forecast Studio prompts you to do so the first time that the project is opened.

**NOTE:** You can also migrate single projects or migrate projects in batch using the SAS Forecast Server Plug-in for SAS Management Console.

To migrate all projects using FSMIGALL:

1. Open SAS in Display Manager mode on the SAS server machine where the macros are installed.

2. Submit the following SAS code:

    ```sas
    %fsmigall(out=work.migration, 
      user=sasadm, 
      password=sasadmpass, 
      environment=Default, 
      host=localhost:6411 
    );
    ```

3. To verify that all of the projects were successfully migrated, open the work.migration data set and review the ISMIGRATED variable. ISMIGRATED equals 1 if the project was successfully migrated.

For more information about the FSMIGALL macro, see “FSMIGALL.”
Create a SAS Forecast Server Project

In this example, the FSCREATE macro is used to create a SAS Forecast Server project.

The SASHELP.PRICEDATA data set is used to create a hierarchical project. The hierarchy of the project is defined by the following variables:

- regionName
- productLine
- productName

This example also uses the following variables to create the project:

- date is the time ID variable.
- sale is used to model the total sale as a function of the price variable and the discount variable.
- price1-price3 are used as the reporting variables.

The project is reconciled in a middle-out fashion starting from the productLine level, and the disaggregation method is “equal split of the difference”.

You can accept the default values for all other project creation options.

**NOTE:** You can use the sasdemo user ID to create the project. However, the project must have public access so that other users can open it and modify it.

To create a project using the FSCREATE macro:

1. Open SAS in Display Manager mode on the SAS server machine where the macros are installed.
2. Run the macro for creating a project by submitting the following SAS code:

   ```sas
   %fscreate(projectname=mypricedataprj, 
   user=sasdemo, 
   password=Password1, 
   environment=Default, 
   data=sashelp.pricedata, 
   id=date, 
   by=regionName productLine productName, 
   hierarchy=YES, 
   var=sale, 
   input=price discount, 
   reporting=price1 price2 price3, 
   aggregate=NONE total(sale), 
   disaggregation=EQUALSPLIT, 
   reconciliation=BOTTOMUP, 
   publicaccess=YES 
   );
   ```
Archive a SAS Forecast Server Project

This example exports a SAS Forecast Server project to an archive file using the FSEXPORT macro. This example assumes the following:

- **pd1** is the project’s name.
- **ArchPD1** is the archive’s name.
- **Project pd1** is the archive’s description.
- There is only one SAS Forecast Server environment.
- The middle tier server is your local machine so the `ENVIRONMENT=` and `HOST=` parameters are not specified.

To archive a project using the FSEXPORT macro:

1. Open SAS in Display Manager mode on a SAS server machine.
2. Submit the following SAS code:

   ```sas
   %fsexport(projectname=pd1, archivename=ArchPD1, description=Project pd1, user=sasuser, password=saspass, archivefolder=C:\SAS\ForecastServer\Archives, environment=default );
   ```

For information about the arguments used in the FSEXPORT macro, see “FSEXPORT.”
Chapter 13
Troubleshooting SAS Forecast Server

Contents

Gathering Information ............................................. 191
Overview ............................................................ 191
Operating System Environmental and Configuration Information ..... 192
Problem Description ............................................. 193
Sample Test Data ..................................................... 193
Log Files ............................................................. 193
Java Stack Traces and Screen Shots ................................ 193
Cannot Log On to SAS Forecast Studio .......................... 194
Cannot Launch SAS Forecast Studio from the SAS Analytics Platform server Web Page ..................................... 194
Cannot Access Libraries from a Newly-Added SAS Workspace Server .... 195
Cannot Access a SAS Library from SAS Forecast Server ............. 195
Incorrect Version of SAS Installed for the SAS Forecast Server .......... 196
Java Version Missing for Java Web Start .......................... 197
SAS Forecast Server System Performance Tuning ..................... 197
SAS Forecast Server Plug-in for SAS Management Console Troubleshooting .... 198
Custom Reports Do Not Display in SAS Forecast Studio ............. 198
SAS Forecast Server Plug-in for SAS Management Console is Not Available 198
Environment Access .................................................. 199

Gathering Information

Overview

When you are troubleshooting unexpected application behavior, it is important to isolate and describe the problem and the context in which it occurs. The following are the general classes of information that can expedite resolution of a technical problem:

- operating system environmental and configuration information
• detailed problem description
• log files
• other files or screen shots
• sample test data

Use Table 13.1 to help gather information. Providing this information helps SAS Technical Support reproduce and fix your problem.

Table 13.1  Information Gathering Checklist

<table>
<thead>
<tr>
<th>Task</th>
<th>Done</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details of your operating environment. For more information, see “Operating System Environmental and Configuration Information.”</td>
<td>[ ]</td>
</tr>
<tr>
<td>Detailed description of the problem (including what it takes to reproduce it). For more information, see “Problem Description.”</td>
<td>[ ]</td>
</tr>
<tr>
<td>Sample data that would help to reproduce the problem. For more information, see “Sample Test Data.”</td>
<td>[ ]</td>
</tr>
<tr>
<td>Obtain log files. For more information, see “Log files.”</td>
<td>[ ]</td>
</tr>
<tr>
<td>Full Java stack trace from the error page. For more information, see “Java Stack Traces and Screen Shots.”</td>
<td>[ ]</td>
</tr>
</tbody>
</table>

Operating System Environmental and Configuration Information

If you request help from SAS Technical Support, then providing the following information about your installation can result in faster resolution of the problem:

• a copy of the SAS Forecast Server configuration files:
  Windows: <config-dir>\AnalyticsPlatform\apps\Forecasting\app.config
  UNIX: <config-dir>/AnalyticsPlatform/apps/Forecasting/app.config

• hardware platform, operating environment (including SAS version and SAS service pack/patch level), amount of physical memory, and number of processors

• JDK version
• JRE version

• the SAS Forecast Server version number and patch level
• server language and locale

**NOTE:** You must provide the preceding information only once, unless it has changed from previous reports.
Problem Description

Provide a scenario description that includes as much information as possible. Include a description of the general task that you are trying to accomplish, your role and permissions, and what has happened during the SAS session. Provide details such as the following:

- Are you working with new data or updating existing data?
- How easy is the problem to reproduce?
- What browser and version are you using?
- Is the problem locale-specific? If so, which locales are having problems?

Sample Test Data

If possible, capture the information entered that caused the problem. In certain situations, SAS Technical Support might request your data load files so that they can better replicate your operating environment.

Log Files

If you have problems connecting to the SAS server, then turning on the SAS log might help you. You can view the SAS Log in the Microsoft Office application in which you are using the SAS Add-In for Microsoft Office.

To view the SAS log:

1. Select the SAS → Options → Results tab.
2. Check Show SAS log.

Java Stack Traces and Screen Shots

When SAS Forecast Server catches and logs problems, it routes you to an application error page. The error page captures detailed exception information that you can send to SAS Technical Support. **NOTE:** It is helpful to send the complete full text of the Java stack trace surfaced on the application error page. SAS Technical Support prefers that you do not send a screen shot of this information because often the screen shots do not include the full text of the trace.
Additionally, it is helpful to send screen shots of the application error page or the sequence of pages that precede the error. If possible, capture the screen shots and send them with the Java stack traces to SAS Technical Support.

---

### Cannot Log On to SAS Forecast Studio

**Problem:**
If you cannot log on to SAS Forecast Studio, then there might be a problem with the SAS Analytics Platform server.

**Error:**
You can get multiple errors when attempting to log on to SAS Forecast Studio. You can encounter the following types of log on states:

- No new user can log on to SAS Forecast Studio.
- You could log on to SAS Forecast Studio yesterday, but you cannot log on today.
- Some users can log on to SAS Forecast Studio, but other users cannot log on.

**Solution:**
Because the SAS Analytics Platform server starts the SAS Forecast Server middle tier, you should review the SAS Analytics Platform server documentation for possible remedies. To access the SAS Analytics Platform server Administrator’s Guide, see [http://support.sas.com/documentation/onlinedoc](http://support.sas.com/documentation/onlinedoc).

---

### Cannot Launch SAS Forecast Studio from the SAS Analytics Platform server Web Page

**Problem:**
After you click **Launch** on the SAS Analytics Platform server Web page, SAS Forecast Studio does not launch. Instead, an XML file appears in the Internet Explorer window.

**Error Message:**
The following errors are observed in the SAS Analytics Platform server Server window:

```
```
- File sas.sg.dataimpl.jar not found.

- File sas.graph.j2d.jar not found.

Solution:
If an XML file appears in your browser, then the Java Web Start feature is not available on your
client machine because the required JRE version is not installed on the client machine. You receive
a warning that the required JRE version is not installed, and you are asked to specify the location
of the required JRE version. You must install the required version of JRE on the client machine for
the SAS Forecast Server Java Web Start to launch.

For more information about the SAS Forecast Server system requirements, see Chapter 3, “System
Requirements for the SAS Forecast Server.”

For more information about Java Web Start, see http://java.sun.com/products/javawebstart.

---

Cannot Access Libraries from a Newly-Added SAS Workspace Server

Problem:
You added another SAS Workspace Server, and you cannot access the libraries from it.

Error Message:
The message “Errors were found in the report” appears, and no report is generated.

Solution:
You must set the execution server for the stored process metadata object to the SAS Workspace
Server that hosts the projects that use this report. It is equally important that the .sas source file
for the stored process is located in the file system of this same server. For more information, see
“Registering Custom Reports.”

---

Cannot Access a SAS Library from SAS Forecast Server

Problem:
From within the SAS Forecast Server, your SAS library is not listed as a possible selection for you
to access the data set that you want as input for your project.

Solution:
To enable the SAS Forecast Server to read the input data set, use SAS Management Console to
define a library that specifies the SAS libref, engine, and path of the input data set. Use the Data
Library Manager Plug-in of SAS Management Console to define a library that is preassigned to a server or servers, and specify the location of the input data set. To specify a library as preassigned for a server or servers, perform the following steps:

1. Open SAS Management Console, and log on as the SAS Administrator (for example, sasadm) to and connect to a metadata repository.
2. Expand the Data Library Manager node, and expand Libraries.
3. Right-click the library that you want to preassign, and select Properties.
4. Click the Options tab.
5. Click Advanced Options.
6. Select the Library is preassigned check box. This window is accessible from the Library Options window of the New Library Wizard when you create a new data library.
7. Ensure that the library is assigned to the correct SAS server(s). The selected library is assigned whenever one of the selected servers starts.
8. Click OK.

Incorrect Version of SAS Installed for the SAS Forecast Server

Problem:
The versions of SAS and SAS Forecast Server installed on your system are not compatible. The SAS Forecast Server executes a syntax check on the SAS High-Performance Forecasting software. If the syntax check fails, indicating that the feature being checked is not present, then SAS Forecast Studio shows the following error message and closes.

Error Message:
Forecast Studio requires a minimum of SAS version-number. Please close Forecast Studio and contact your system administrator.

Solution:
If you receive the preceding error message, then contact your SAS representative to inquire about updating your version of SAS.

The client and middle tier are installed under 3.1 folders, where 3.1 represents the version number of the product. For example on a Windows system:
SAS Forecast Server: SAS_HOME\SASForecastServer\3.1
SAS Forecast Studio: SAS_HOME\SASForecastStudio\3.1

In releases prior to version 3.1, the middle tier did not have such a directory structure.

To identify the version number of the middle tier prior to version 3.1:
1. Navigate to the default configuration folder:
   \SAS_HOME\SASAPCore\apps\Forecasting

2. Open the `app.config` file with a text editor.

The following text shows the version number of the SAS Forecast Server middle tier in the `app.config` file:

```
application.version=2.1
```

---

**Java Version Missing for Java Web Start**

**Problem:**
Java Web Start does not work because the required version of JRE is not installed on the client tier.

**Error:**
You get a message indicating that the required Java version 1.5.0_12 could not be found. The message is something like “Missing version field in response from server when accessing resource . . .” This is most likely due to the proxy settings for Web Start. Start the Java Control Panel, and try changing the proxy settings to **Use Browser** or **Direct Connection**.

**Solution:**
You must have JRE 1.5.0_12 installed on the client machine. You need to either install the required JRE version or configure the Java Web Start to use the required version.

JRE 1.5.0_12 is used as the Java Web Start run-time version, which does not need to be the same version as Web Start itself. If you use different JRE versions, then you must configure Web Start to include the JRE 1.5.0_12 version. This can be done by using the Java Control Panel.

To download the JRE, see [http://supportexp.unx.sas.com/resources/thirdpartysupport/v92](http://supportexp.unx.sas.com/resources/thirdpartysupport/v92).

---

**SAS Forecast Server System Performance Tuning**

For scalability issues, slow system performance, or failures caused by memory settings, you can change the default settings for SAS Forecast Studio, the SAS Analytics Platform server, and Java Web Start in the following tiers:

- SAS Forecast Studio client tier
- SAS Analytics Platform server middle tier
- SAS server tier
To improve performance:

1. Change the `Xmx` value to 1g (1024m) from the default setting of 512m in the `.ini` files.

2. Increase the JVM memory for the server, middle tier, and client to `-Xmx1g` by adding this option to the command line for Java.

The Windows configuration files are at the following locations:

- **Client (SAS Forecast Studio):**
  
  `SAS_HOME\SASForecastStudio\3.1\forecaststdo.ini`

- **Middle tier (SAS Analytics Platform server):**
  
  `<config_dir>\AnalyticsPlatform\AnalyticsPlatform.bat`
  
  `<config_dir>\AnalyticsPlatform\apps\Forecasting\lib\sas.forecasting.war`  
  
  (web.xml file)

- **JRE variables**
  
  `SAS_HOME\wrapper.conf`

For more information about changing your system settings to improve system performance, see the section about best practices for configuring the middle tier in the *Web Application Administration Guide* of the SAS Intelligence Platform documentation set at [http://support.sas.com/documentation/onlinedoc](http://support.sas.com/documentation/onlinedoc).

---

**SAS Forecast Server Plug-in for SAS Management Console Troubleshooting**

**Custom Reports Do Not Display in SAS Forecast Studio**

When you register your custom reports as stored process objects, you must include the `FS_REPORT` keyword. SAS Forecast Studio does not display reports unless this keyword is added to the stored process object. For more information about registering a report, see “Register the Report with SAS Management Console.” For more information about the report keywords, see “Keywords Used in Reports.”

**SAS Forecast Server Plug-in for SAS Management Console is Not Available**

If you log on to SAS Management Console and the SAS Forecast Server Plug-in for SAS Management Console does not display under the **Application Management** node, then you must configure
the user to have the **Management Console: Advanced** role. This role is required so that the SAS Forecast Server Plug-in for SAS Management Console and other solution-specific plug-ins are available to the SAS Forecast Server product administrative user.

For more information, see “Configure the SAS Forecast Server Product Administrator.”

---

**Environment Access**

When you perform maintenance actions on environments (copy, move, delete, and so on), exclusive access to the environment is typically required for the duration of the action. During this time, the environment and all projects within it are inaccessible to users. Similarly, if the environment or one of its projects is already in use when the action is attempted, then the action fails. Therefore, it is recommended that you coordinate with users and establish times during which you can perform environment maintenance.
Part V

Glossary
Glossary

accumulation
either of two processes that are used to convert a time series. (1) Accumulation converts a
time series that has no fixed interval into a time series that does have a fixed interval (such
as hourly or monthly). (2) Accumulation converts a time series that has a fixed interval into
a time series with a lower frequency time interval (such as hourly into daily). Accumulation
combines data within the same time interval into a summary value for that time period.

ACF plot
See autocorrelation function plot.

aggregation
the process of combining more than one time series to form a single series. Aggregation
combines data within the same time interval. For example, you can aggregate data into a
total or average.

aggregation statistic
the mathematical operation used to combine forecasts across levels in the hierarchy. The
reconciliation method that you choose determines the levels where the aggregation statistic
is used. See also reconciliation method.

autocorrelation
the correlation between observations at different lags in a time series. Autocorrelation coef-
ficient values range from -1 to +1. When the autocorrelation coefficient value at a given lag
is positive, the observations that are separated by that lag tend to move together.

autocorrelation function plot
a plot of the autocorrelation coefficients across different values of time lags. This plot enables
you to determine whether seasonality exists in the time series. Short form: ACF plot.

bottom-up method of reconciliation
a reconciliation method that uses the forecasts at the lowest level of the hierarchy to adjust
forecasts for the higher levels in the hierarchy. See also middle-out method of reconciliation,
reconciliation method, and top-down method of reconciliation.

confidence limits
the upper and lower values of a (usually 95%) confidence interval. In repeated sampling,
approximately (1-alpha) 100% of the resulting intervals would contain the true value of the
parameter that the interval estimates (where alpha is the confidence level associated with the
interval).

disaggregation method
a method that specifies how the forecasts in the lower level of the hierarchy are reconciled
when the reconciliation method is top-down or middle-out. The disaggregation method can
reconcile the forecasts in either of the following ways: (1) by using the proportion that each
lower-level forecast contributes to the higher-level forecast; or (2) by splitting equally the
difference between the higher-level forecast and the lower-level forecasts. See also middle-
out method of reconciliation and top-down method of reconciliation.
dummy variable
a numeric variable with a value of either 1 or 0. Dummy variables are used to indicate whether or not unusual events occur. The variable takes the value of 1 during the event and 0 otherwise.

event
an incident that disrupts the normal flow of any process that generates the time series. Examples of events are holidays, retail promotions, and natural disasters.

event repository
a storage location that contains information about calendar events and includes a brief description of each event.

forecast
a numerical prediction of a future value for a time series.

holdout sample
the number of periods of the most recent data that should be excluded from the parameter estimation. The holdout sample can be used to evaluate the forecasting performance of a candidate model.

horizon
the number of periods into the future for which predictions are made.

IACF plot
See inverse autocorrelation function plot.

inverse autocorrelation
the autocorrelation of an autoregressive model remodeled as a moving average model.

inverse autocorrelation function plot
a plot of the inverse autocorrelation coefficients across different values of time lags. This plot is useful for detecting over-differencing in the model. Short form: IACF plot.

level shift
a persistent change in the magnitude of a time series curve.

locked override
a user-supplied value for a forecast that is honored when the hierarchy is reconciled. The final forecast value for that level is the value that you specified for the locked override. Locked overrides can generate override conflicts. See also unlocked override.

middle-out method of reconciliation
a reconciliation method that combines the bottom-up method above the reconciliation level and the top-down method below the reconciliation level. When a hierarchy has more than one middle level, you need to specify which of those levels to use as the reconciliation level. The forecasts at the reconciliation level are used to generate forecasts for both the higher and lower levels. See also bottom-up method of reconciliation, reconciliation method, and top-down method of reconciliation.

model selection criterion
the statistic of fit that is used for forecast model selection.
model selection list
   a list of candidate model specifications. You can choose which model specification is best suited to forecast a particular time series.

override conflict
   a condition that occurs when the value of one locked override is incompatible with the value of another locked override in the same branch of the hierarchy. Override conflicts that are not resolved prior to reconciliation can result in unreconciled nodes. See also unreconciled node.

PACF plot
   See partial autocorrelation function plot.

partial autocorrelation
   the internal correlation between observations in a time series that causes the effect of all intervening lags to be removed.

partial autocorrelation function plot
   a plot of the partial autocorrelation coefficients across different values of time lags. This plot is useful for identifying the order of an autoregressive model. Short form: PACF.

performance statistic
   a statistic of fit that is used to determine how well a forecasting process is predicting the future. See also statistic of fit.

project hierarchy
   the order of the variables that you have assigned to the BY variables role. An example of a hierarchy is Region > Product Category > Product Line.

pulse
   a temporary change in the magnitude of a time series curve. The magnitude returns to the former level immediately after the change.

ramp
   a persistent change in the trend or slope of a time series curve.

reconciliation method
   the method that specifies the level in the hierarchy where the process of reconciliation starts. The following reconciliation methods are available: bottom-up method, middle-out method, and top-down method.

report
   output that is generated by running custom SAS code against the data in your project.

residual
   the difference between an observed data value and its predicted value.

seasonal adjustment
   the process of removing seasonality from time series data.

seasonality
   a regular change in time series data values that occurs at the same point in each time cycle.

selection criterion
   a statistical value that is used to evaluate how well a forecasting model \(x + y = z\) performs by comparing the actual data to the predictions. See also statistic of fit.
statistic of fit
a statistical value that is used to evaluate how well a forecasting model fits the historical series by comparing the actual data to the predicted values.

time series data
timestamped data collected over time at a particular frequency. Some examples of time series data are Web visits per hour, sales per month, and calls per day.

top-down method of reconciliation
a reconciliation method that uses the forecasts at the highest level of the hierarchy to adjust the forecasts for the lower levels. See also bottom-up method of reconciliation, middle-out method of reconciliation, and reconciliation method.

transactional data
timestamped data collected over time at no particular frequency. Some examples of transactional data are point-of-sale data, inventory data, call center data, and trading data.

unlocked override
a user-supplied value for a forecast that acts as a guideline for the final forecast value. The final forecast for the level reflects the value of the unlocked override, but the final forecast and the unlocked override are often not identical. Because these overrides can be overridden when the hierarchy is reconciled, unlocked overrides do not generate override conflicts. See also locked override.

unreconciled node
a node in the hierarchy that cannot be reconciled. A node can be unreconciled if (1) the final forecast of an upper level is not equal to the aggregate of the final forecasts of the lower levels; or (2) a final forecast violates the limits that are implied by a locked override in one of the lower levels in the same branch of the hierarchy.

white noise
a series of random fluctuations in the values of a data series. A white noise model has only a mean or constant parameter. A series is described as white noise if its spectral density function is constant.
## Subject Index

**SAS Analytics Platform server**
- starting, 82

**SAS Forecast Studio**
- starting, 81

**SAS Forecast Server Plug-in for SAS**
- Management Console is not available troubleshooting, 198

**about**
- post-installation tasks, 61

**about reports**
- reports, 104

**about stored processes**
- reports, 103

**accessibility features**, 8

**accessing in SAS Forecast Studio**
- reports, 110

**accessing reports**
- troubleshooting, 198

**active series macro variables**
- reports, 126

**additional workspace server**
- troubleshooting, 195

**administration**
- changing default port, 135
- customizing formats, 131
- product administrative user, 92
- remove configuration, 132
- SAS Deployment Manager, 132
- security, 94
- stop SAS Analytics Platform server, 133
- stop SAS Metadata Server, 134
- stop SAS Object Spawner, 134
- stop servers, 133
- tasks, 131
- user access, 89

**administrative user account recommendations**
- post-installation tasks, 63
- pre-installation tasks, 53

**architecture**
- diagram, 15
- overview, 15

**basic project macro variables**
- reports, 119

**basic user permissions**
- reports, 105

**changing default port**
- administration, 135
- checklist
  - upgrading installation tasks, 35
- clear global macros
  - FSCLEAR macro, 141
- component
  - client tier components, 18
  - starting, 82
  - clients with customized multicast port settings
    - starting, 83
- components
  - client tier, 18
  - middle tier, 17, 18
  - SAS Intelligence Platform, 16
- configuration
  - file locations, 51
- configure SAS Add-In for Microsoft Office
  - post-installation tasks, 71
- constraints
  - reports, 114
- control macro variables
  - reports, 118
- control output style
  - reports, 111
- copying a project
  - FSCOPY macro, 142
- create environment
  - post-installation tasks, 67
- create report metadata folder
  - reports, 104
- create report metadata object
  - reports, 113
- create user accounts
  - post-installation tasks, 63
- creating a project
  - FSCREATE macro, 144
- custom reports
  - reports, 115
- customizing formats
  - administration, 131

**data flow**
- diagram, 26

**data hierarchy and settings macro variables**
- reports, 120

**data requirements**
- data flow, 26
- data set variables, 27
input data, 27
deleting an archived project
FSDELARC macro, 151
diagnose macro variables
reports, 124
dynamic report parameters
reports, 115
environment access
troubleshooting, 199
environment report metadata folder
reports, 105
file locations
configuration, 51
installation, 51
forecast macro variables
reports, 125
FSCLEAR macro
clear global macros, 141
SAS macros, 141
FSCOPY macro
copying a project, 142
SAS macros, 142
FSCREATE macro
creating a project, 144
SAS macros, 144
FSDELARC macro
deleting an archived project, 151
SAS macros, 151
FSDELENV macro
SAS macros, 153
FSDELPRJ macro
SAS macros, 154
FSEXPALL macro
SAS macros, 155
FSEXPORT macro
SAS macros, 157
FSGETENV macro
SAS macros, 159
FSGETPRJ macro
SAS macros, 160
FSGETURP macro
SAS macros, 162
FSIMPALL macro
SAS macros, 163
FSIMPORT macro
SAS macros, 165
FSLOAD macro
SAS macros, 166
FSMIGALL macro
SAS macros, 167
FSMIGPRJ macro
SAS macros, 169
FSMOVE macro
SAS macros, 170
FSNEWENV macro
SAS macros, 172
FSREGENV macro
SAS macros, 174
FSREGPRJ macro
SAS macros, 175
FSREN macro
SAS macros, 176
FSRUNPRJ macro
SAS macros, 178
FSSETOWN macro
SAS macros, 179
FSSET PUB macro
SAS macros, 180
FSUNREG macro
SAS macros, 181
FSURGENV macro
SAS macros, 183
gathering information
troubleshooting, 191
hardware requirements
hard disk, 23
RAM, 24
High-Performance Forecasting
procedures, 6
hot fixes
online documentation, 62
install SAS Forecast Server
installation, 49
installation
SAS Forecast Studio client, 58
file locations, 51
how to, 52
install SAS Forecast Server, 49
overview, 49
software index overview, 58
Installation Location
macros, 140
integration
SAS Analytics Platform, 18
SAS Intelligence Platform, 18
internal report parameters
reports, 117
Java Web Start
JRE, 197
starting, 84
troubleshooting, 194
JRE
troubleshooting, 197
keywords
reports, 129

log on
troubleshooting, 194

manually assigned libraries
reports, 128
metadata macro variables
reports, 118
metadata server
definition, 76
running, 76

middle tier
components, 18
post-installation tasks, 73

migration
when to begin, 36

model selection macro variables
reports, 125

normal report parameters
reports, 115

object spawner
definition, 78
starting, 78

online documentation
hot fixes, 62
post-installation tasks, 61

parameters
reports, 115
post-installation tasks
about, 61
administrative user account
recommendations, 63
configure SAS Add-In for Microsoft Office, 71
create environment, 67
create user accounts, 63
hot fixes, 62
middle tier, 73
online documentation, 61
preassign libraries, 69
problem alert notices, 62
product administrative user, 66
server tier, 62
UNIX create user group, 63
Windows file permissions, 68

pre-installation tasks
administrative user account
recommendations, 53
product administrative user account, 53
UNIX create user group, 53

preassign libraries
post-installation tasks, 69

preregistration tasks
reports, 112

product administrative user
administration, 92
post-installation tasks, 66
product administrative user account
pre-installation tasks, 53

reconciliation macro variables
reports, 125
registering
reports, 112
remove configuration
administration, 132
report administration
tasks, 103
reports
about reports, 104
about stored processes, 103
accessing in SAS Forecast Studio, 110
active series macro variables, 126
basic project macro variables, 119
basic user permissions, 105
constraints, 114
diagnose macro variables, 124
dynamic report parameters, 115
environment report metadata folder, 105
forecast macro variables, 125
internal report parameters, 117
keywords, 129
manually assigned libraries, 128
metadata macro variables, 118
model selection macro variables, 125
normal report parameters, 115
parameters, 115
preregistration tasks, 112
reconciliation macro variables, 125
registering, 112
required macro calls, 129
sample reports, 106
special report features, 128
trusted user access, 106
using reports, 107

required macro calls
reports, 129
required skills
  SAS Forecast Server, 9

sample reports
  reports, 106

SAS Analytics Platform
  definition, 78
  integration, 18

SAS Deployment Manager
  administration, 132

SAS Forecast Server
  definition, 4
  importance, 3
  required skills, 9
  upgrading installation tasks, 35
  verifying installation, 79

SAS Forecast Server components
  components, 17

SAS Forecast Studio
  benefits, 8
  documentation, 11
  related software, 12

SAS Intelligence Platform
  components, 16
  integration, 18

SAS library access
  troubleshooting, 195

SAS macros
  FSCLEAR macro, 141
  FSCOPY macro, 142
  FSCREATE macro, 144
  FSDELARC macro, 151
  FSDELENV macro, 153
  FSDELPRJ macro, 154
  FSEXPALL macro, 155
  FSEXPORT macro, 157
  FSGETENV macro, 159
  FSGETPRJ macro, 160
  FSGETURP macro, 162
  FSIMPALL macro, 163
  FSIMPORT macro, 165
  FSLOAD macro, 166
  FSMIGALL macro, 167
  FSMIGPRJ macro, 169
  FSMOVE macro, 170
  FSNEWENV macro, 172
  FSREGENV macro, 174
  FSREGPRJ macro, 175
  FSR macro, 176
  FSRUNPRJ macro, 178
  FSSETOWN macro, 179
  FSSETPUB macro, 181
  FSUNREG macro, 182
  FSURGENV macro, 183
  macros, 138

SAS servers
  metadata server, 76
  object spawner, 78
  SAS Analytics Platform, 78
  starting, 75
  workspace server, 77

SAS version
  troubleshooting, 196

schedule the migration, 36

security
  administration, 94
  file system permissions, 95
  layers, 94
  WriteMetadata, 95

security administration
  tasks, 89

server tier
  post-installation tasks, 62

servers
  required, 81

software requirements
  SAS software, 25
  SAS software (optional), 25
  third-party software, 25

special report features
  reports, 128

starting
  SAS Analytics Platform server, 82
  SAS Forecast Studio, 81
  client tier, 82
  clients with customized multicast port settings, 83
  Java Web Start, 84
  SAS servers, 75

describe
  SAS Forecast Server Plug-in for SAS Management Console is not available, 198

accessing reports, 198

additional workspace server, 195
environment access, 199
gathering information, 191
Java Web Start, 194
JRE, 197
log on, 194
SAS library access, 195
SAS version, 196
system performance, 197
trusted user access
reports, 106

UNIX create user group
post-installation tasks, 63
pre-installation tasks, 53

Upgrading
macros, 141
upgrading installation tasks
checklist, 35
SAS Forecast Server, 35

user access
administration, 89
using reports
reports, 107

verifying installation
SAS Forecast Server, 79

Windows file permissions
post-installation tasks, 68
workspace server
definition, 77
testing connection, 77
Syntax Index

ACCUMULATE= option
FSCREATE macro, 145

ADJUST= option
FSCREATE macro, 146

AGGREGATE= option
FSCREATE macro, 146

ALLOWNEGATIVE= option
FSCREATE macro, 146

ALPHA= option
FSCREATE macro, 146

ARCHIVEFOLDER= argument
FSCOPY macro, 143
FSDELARC macro, 152
FSIMPALL macro, 164
FSMOVE macro, 171

ARCHIVEFOLDER= option
FSEXPALL macro, 156
FSEXPORT macro, 158

ARCHIVENAME= argument
FSDELARC macro, 152
FSEXPORT macro, 158

ARCHIVEPATH= argument
FSIMPORT macro, 165

ARIMAX= option
FSCREATE macro, 146

BACK= option
FSCREATE macro, 146

BY= option
FSCREATE macro, 146

CPORT= argument
FSCOPY macro, 143
FSMOVE macro, 171

CPORT= option
FSEXPALL macro, 156
FSEXPORT macro, 158

CRITERION= option
FSCREATE macro, 147

DATA= argument
FSCOPY macro, 144

DELETEARCHIVES= option
FSDELPRJ macro, 154

DESC= option
FSNEWENV macro, 173
FSREGENV macro, 174

DESCRIPTION= option
FSCREATE macro, 147

DESTINATIONENVIRONMENT= option
FSCOPY macro, 143, 171

DESTINATIONPROJECTNAME= argument
FSCOPY macro, 142
FSMOVE macro, 171

DETECTOUTLIERS= option
FSCREATE macro, 147

DISAGGREGATION= option
FSCREATE macro, 147

ENVIROMENT= option
FSEXPORT macro, 158
FSGETPRJ macro, 161

ENVIRONMENT= argument
FSDELENV macro, 153
FSGETURP macro, 162
FSNEWENV macro, 172
FSREGENV macro, 174

ENVIRONMENT= option
FSCREATE macro, 147
FSDELARC macro, 152
FSDELPRJ macro, 155
FSEXPALL macro, 156
FSIMPALL macro, 164
FSIMPORT macro, 166
FSLOAD macro, 167
FSMIGALL macro, 168
FSMIGPRJ macro, 170
FSREGPRJ macro, 176
FSREN macro, 177
FSRUNPRJ macro, 179
FSSETOWN macro, 180
FSSETUPUB macro, 182
FSUNREG macro, 183
FSURGENV macro, 184

ESM= option
FSCREATE macro, 147

ESMONLYATLEVEL= option
FSCREATE macro, 147

FSCLEAR macro, 141
FSCLEAR macro example, 142
FSCOPY macro, 142
FSCOPY macro example, 143
output, 144
FSCREATE macro, 144
FSDELARC macro, 151
FSDELENV macro, 153
FSDELPJ macro, 154
FSEXPALL macro, 155
FSEXPORT macro, 157
FSGETENV macro, 159
FSGETPJ macro, 161
FSGETURP macro, 162
FSIMPALL macro, 163
FSIMPORT macro, 165
FSLOAD macro, 166
FSMIGALL macro, 168
FSMIGPJ macro, 169
FSMOVE macro, 170
FSNEWENV macro, 172
FSREGENV macro, 174
FSRFGPJ macro, 175
FSREN macro, 176
FSRUNPJ macro, 178
FSSETOWN macro, 180
FSSETUPJB macro, 181
FSUNREG macro, 182
FSURGENV macro, 184

HIERARCHY= option
FSCREATE macro, 147
HOLDOUT= option
FSCREATE macro, 147
HOLDOUTPCT= option
FSCREATE macro, 147
HOST= option
FSCOPY macro, 143
FSCREATE macro, 147
FSDELARC macro, 152
FSDELENV macro, 153
FSDELPJ macro, 154
FSEXPALL macro, 156
FSEXPORT macro, 158
FSGETENV macro, 160
FSGETPJ macro, 161
FSGETURP macro, 163
FSIMPALL macro, 164
FSIMPORT macro, 165
FSLOAD macro, 167
FSMIGALL macro, 168
FSMIGPJ macro, 170
FSMOVE macro, 171
FSNEWENV macro, 173
FSREGENV macro, 174
FSRFGPJ macro, 176
FSREN macro, 177
FSRUNPJ macro, 178
FSSETOWN macro, 180
FSSETUPJB macro, 182
FSUNREG macro, 183
FSURGENV macro, 184

ID= argument
FSCOPY macro, 144
IDFORMAT= option
FSCREATE macro, 147
IMPORTDATA= argument
FSRUNPJ macro, 178
INPUT= option
FSCREATE macro, 147
INTERMITTENT= option
FSCREATE macro, 148
INTERVAL= option
FSCREATE macro, 147
ISPUBLIC= argument
FSSETUPJB macro, 181

LEAD= option
FSCREATE macro, 148
FSRUNPJ macro, 179
MAXNUMOUTLIERS= option
FSCREATE macro, 148
MAXPCTOUTLIERS= option
FSCREATE macro, 148
METHOD= argument
FSRUNPJ macro, 178
MINOBSNONMEAN= option
Syntax Index ♦ 215

FSCREATE macro, 148
MINOBSSEASON= option
FSCREATE macro, 148
MINOBTREND= option
FSCREATE macro, 148
MODELSELECTIONLIST= option
FSCREATE macro, 148
NAMESUFFIX= option
FSEX PALL macro, 156
NEWPROJECTNAME= argument
FSREN macro, 177
NOWARN= option
FSCOPY macro, 143
FSDELARC macro, 152
FSDELPRJ macro, 155
FSEXPORT macro, 158
FSIMPALL macro, 164
FSIMPORT macro, 166
FSMOVE macro, 171
FSREN macro, 177
OUT= argument
FSEX PALL macro, 156
FSGETENV macro, 159
FSGETPRJ macro, 161
FSMIGALL macro, 168
OWNER= argument
FSSETOWN macro, 180
PASSWORD= argument
FSCOPY macro, 142, 144
FSDELARC macro, 152
FSDELENV macro, 153
FSDELP RJ macro, 154
FSEX PALL macro, 155
FSEXPORT macro, 158
FSGETENV macro, 159
FSGETPRJ macro, 161
FSGETURP macro, 162
FSIMPALL macro, 164
FSIMPORT macro, 165
FSLOAD macro, 167
FSMIGALL macro, 168
FSMIGPRJ macro, 169
FSMOVE macro, 171
FSNEWENV macro, 172
FSREGENV macro, 174
FSREGPRJ macro, 176
FSREN macro, 177
FSRUNPRJ macro, 178
FSUNREG macro, 183
PUBLICACCESS= option
FSCREATE macro, 148
RECONCILIATION= option
FSCREATE macro, 148
REGISTERPROJECTS= option
FSREGENV macro, 175
REMOTEARCHIVEFOLDER= argument
FSCOPY macro, 143
FSMOVE macro, 171
REPORTING= option
FSCREATE macro, 149
REPORTSPATH= argument
FSNEWENV macro, 173
FSREGENV macro, 174
RETAINCHOOSE= option
FSRUNPRJ macro, 179
RUN= option
FSCREATE macro, 149
SEASONALITY= option
FSCREATE macro, 149
SEASONTEST= option
FSCREATE macro, 149
SETMISSING= option
FSCREATE macro, 149
SOURCEENVIRONMENT= option
FSCOPY macro, 143, 171
SOURCEPROJECTNAME= argument
FSCOPY macro, 142
FSMOVE macro, 171
START= option
FSCREATE macro, 149
SUBFOLDERS= option
FSEXPPALL macro, 156
FSIMPALL macro, 164
TIMEMULTIPLIER= option
FSCREATE macro, 149
TIMESHIFT= option
FSCREATE macro, 149
TMPARCHIVENAME= option
FSCOPY macro, 143
FSMOVE macro, 171
TRANSBOXCOX= option
FSCREATE macro, 149
TRANSOPT= option
FSCREATE macro, 149
TRANSTYPE= option
FSCREATE macro, 149
TRIMMISS= option
FSCREATE macro, 150
UCM= option
FSCREATE macro, 150
USER= argument
FSCOPY macro, 142, 144
FSDELARC macro, 152
FSDELENV macro, 153
FSDELPJ macro, 154
FSEXPPALL macro, 155
FSEXPORT macro, 158
FSGETENV macro, 159
FSGETPRJ macro, 161
FSGETURP macro, 162
FSIMPALL macro, 164
FSIMPORT macro, 165
FSLOAD macro, 166
FSMIGALL macro, 168
FSMIGPRJ macro, 169
FSMOVE macro, 171
FSNEWENV macro, 172
FSREGENV macro, 174
FSREN macro, 177
FSRUNPRJ macro, 178
FSSETOWN macro, 180
FSSETUPB macro, 181
FSURGENV macro, 184
USER= option
FSREGPRJ macro, 176
FSUNREG macro, 183
VAR= argument
FSCOPY macro, 144
WEEKENDDAYS= option
FSCREATE macro, 150
WSSERVER= option
FSGETENV macro, 160
FSNEWENV macro, 173
FSREGENV macro, 175
FSURGENV macro, 184
ZEROMISS= option
FSCREATE macro, 150
Your Turn

We welcome your feedback.

- If you have comments about this book, please send them to yourturn@sas.com. Include the full title and page numbers (if applicable).

- If you have comments about the software, please send them to suggest@sas.com.
Whether you are new to the work force or an experienced professional, you need to distinguish yourself in this rapidly changing and competitive job market. SAS® Publishing provides you with a wide range of resources to help you set yourself apart. Visit us online at support.sas.com/bookstore.

**SAS® Press**

Need to learn the basics? Struggling with a programming problem? You’ll find the expert answers that you need in example-rich books from SAS Press. Written by experienced SAS professionals from around the world, SAS Press books deliver real-world insights on a broad range of topics for all skill levels.

**SAS® Documentation**

To successfully implement applications using SAS software, companies in every industry and on every continent all turn to the one source for accurate, timely, and reliable information: SAS documentation. We currently produce the following types of reference documentation to improve your work experience:

- Online help that is built into the software.
- Tutorials that are integrated into the product.
- Reference documentation delivered in HTML and PDF – free on the Web.
- Hard-copy books.

**SAS® Publishing News**

Subscribe to SAS Publishing News to receive up-to-date information about all new SAS titles, author podcasts, and new Web site features via e-mail. Complete instructions on how to subscribe, as well as access to past issues, are available at our Web site.